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Conventions and Features Used in This Book
This book uses special text and design conventions to help you find the information you 
need more easily.

Text Conventions
Convention Meaning

Abbreviated com-
mands for navigat-
ing the ribbon 

For your convenience, this book uses abbreviated commands. For 
example, “Click Home, Insert, Insert Cells” means that you should 
click the Home tab on the ribbon, then click the Insert button, and 
finally click the Insert Cells command.

Boldface type Boldface indicates text that you type.
Initial Capital 
Letters

The first letters of the names of tabs, dialog boxes, dialog box ele-
ments, and commands are capitalized. Example: the Save As dialog 
box. 

Italicized type Italicized type indicates new terms. 
Plus sign (+) in text Keyboard shortcuts are indicated by a plus sign (+) separating key 

names. For example, Ctrl+Alt+Delete means that you press the Ctrl, 
Alt, and Delete keys at the same time.

Design Conventions

INSIDE OUT  �This Statement Illustrates an Example of an “Inside Out” 
Heading

These are the book’s signature tips. In these tips, you get the straight scoop on what’s 
going on with the software—inside information about why a feature works the way it 
does. You’ll also find handy workarounds to deal with software problems. 

Sidebar
Sidebars provide helpful hints, timesaving tricks, or alternative procedures related to 
the task being discussed. 
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TROUBLESHOOTING
This statement illustrates an example of a “Troubleshooting” problem 
statement.

Look for these sidebars to find solutions to common problems you might encounter. 
Troubleshooting sidebars appear next to related information in the chapters. You can 
also use “Index to Troubleshooting Topics” at the back of the book to look up problems 
by topic. 

Cross-references point you to locations in the book that offer additional information about 
the topic being discussed.

CAUTION!
Cautions identify potential problems that you should look out for when you’re com-
pleting a task or that you must address before you can complete a task.

Note
Notes offer additional information related to the task being discussed.
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CHAPTER 6

Working with Graphics and Pictures

E ffective communication of ideas often requires much more than verbal skills. With 
Office 2010, you can easily add pictures and other types of graphics that make your 
documents more visually appealing while at the same time supplanting the prover-

bial thousand words.

We begin our exploration of the picture-handling capabilities of Office, naturally, with a 
picture. Figure 6-1 shows the Insert tab on the ribbon in PowerPoint. The Insert tabs in 
Word, Excel, and Outlook (and, to a lesser degree, OneNote) are quite similar, and this tab 
is the starting point in each program for adding graphics and pictures to a document.

Figure 6-1  The Insert tab for each Office program has a few program-specific options (such 
as Photo Album in this example from PowerPoint), but most options are found in all Office 
programs.

In this chapter, we describe how to insert and modify each of the following types of graphi-
cal objects:

●● Picture  This option includes photographs, of course, but can also be used to insert 
a file saved in any of numerous picture file formats. (See “Inserting Pictures into 
Office Documents” on page 162.)
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●● Clip Art  Clip art comprises photographs, illustrations, and even audio and video 
clips that are typically offered as part of a library of stock files from which you can 
choose. (See “Finding and Using Clip Art” on page 172.)

●● Screenshot  This option captures any open window (even those that are covered by 
other windows) or part of your screen and inserts it in your document. (See “Captur-
ing and Inserting Screenshots” on page 174.)

●● Shapes  This option provides line illustrations in a wide variety of shapes that you 
can further customize. (See “Adding Shapes and Text Boxes” on page 175.)

●● SmartArt  SmartArt is a collection of templates for drawings, diagrams, flow charts, 
organizational charts, and so on. (See “Adding SmartArt to Documents” on page 180.)

●● Chart  Office supports a large number of ways to display numeric data as an image 
for easier interpretation and analysis. (See “Displaying Data Graphically with Charts” 
on page 179.)

●● Text Box  As you would expect, a text box holds text, which gives you greater flex-
ibility in placement and formatting vis-à-vis surrounding text. (See “Adding Shapes 
and Text Boxes” on page 175.)

●● WordArt  WordArt provides a number of effects (such as skewing, stretching, rotat-
ing, shading, coloring, and distorting) that can be applied to text for use in logos, 
titles, and similar display purposes. (See “Applying Text Effects with WordArt” on 
page 182.)

Toward the end of the chapter we describe two other ways to apply art, colors, and shapes 
to your documents: ink (drawn with a stylus) and Office themes.

Working with Drawing Layers in Office Documents
Before we dive into the specifics of inserting pictures, shapes, SmartArt, and other graphi-
cal elements, it helps to understand how Office manages those objects. In this section, we 
explain the concept of layers in Office documents, how to select graphical elements, and 
how to manipulate those graphics in ways that are common to all Office programs.

Although the finished product from Office is two-dimensional—whether it’s printed on a 
sheet of paper or displayed on a flat-screen monitor—a graphics-laden document has a 
layer for each graphic, arranged in a virtual three-dimensional stack. It’s as though you took 
a blank sheet of paper, wrote some text on it, and then started laying printed photographs 
and graphics clipped from a magazine atop the sheet. You’d soon have a stack of clippings, 
with some obscuring part or all of the ones behind them. 



	 Working with Drawing Layers in Office Documents	 151

Ch
ap

te
r 6

In Word and Outlook you can, in effect, peel the text off the page and lay it in front of the 
stack of graphics. PowerPoint can also place a slide’s text in front of the stacked graphics, 
but the implementation is slightly different; in PowerPoint, slide text (with a transparent 
background) is itself stored in a placeholder (a type of graphics container), so placing the 
text in front of other graphics is simply a matter of bringing that layer to the front. Graphics 
in Excel always remain in front of text and numbers in cells, so you need to be sure that you 
move your graphics to a place where they don’t cover important data.

Selecting Graphics and Pictures

To work with a graphic or picture after it is placed in a document—whether you want to 
move it, resize it, adjust its colors, or whatever—you must select it. The simplest way to 
select an object is to click it. A selected object is shown with a frame, as you can see in Fig-
ure 6-2.

Rotate handle

Sizing handles

Figure 6-2  A selected picture or graphic has a frame with handles.

Selecting Text Boxes and WordArt

When you click a text box or a WordArt object, the frame initially appears as a dashed line, 
as shown in Figure 6-3. With the frame in this state, you’ll also notice the appearance of an 
insertion point or a text selection, for this is the way you edit the text in such objects. To 
work with the object itself rather than the text it contains, move the mouse pointer to the 
dashed line, where it changes to a four-headed arrow, and click. The insertion point or text 
selection disappears, and the frame becomes a solid line. To return to text editing, click the 
text inside the frame. Alternatively, once an object is selected, you can toggle between text 
selection and object selection by pressing Enter and Esc. Table 6-1 shows other keyboard 
shortcuts for selecting objects.
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Figure 6-3  To select a text object with a dashed frame, point to the frame and click.

Table 6-1  Keyboard Shortcuts for Selecting Graphics and Pictures

Action Keyboard Shortcut
Select an object when another object is selected Tab or Shift+Tab
Select all objects Ctrl+A
Open the Selection And Visibility pane Alt+F10
Selecting Text in WordArt and Text Boxes
Select an object when text in the object is selected Esc
Select text when the object is selected Enter

Working with Multiple Graphics and Pictures

Selecting objects becomes more complicated when your document contains several 
objects, especially if they are stacked one in front of another. When objects are stacked, 
clicking selects only the front-most one. If objects further back are not completely cov-
ered, you can click an uncovered part to select that object. Alternatively, after you select 
an object, you can press Tab to cycle the selection through the objects back to front (or 
Shift+Tab to cycle from front to back).

A complex document with many graphics and pictures becomes much easier to manage 
when you use the Selection And Visibility pane (see Figure 6-4), which you can display in 
any of the following ways:

●● On the Home tab, in the Editing group, click Select, Selection Pane.

●● If an object is already selected, under Picture Tools or Drawing Tools, click the Format 
tab. Then, in the Arrange group, click Selection Pane.

●● Press Alt+F10.

The Selection And Visibility pane lists all objects on the current page, worksheet, or slide. To 
select an object, simply click its name. 
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Figure 6-4  The Selection And Visibility pane, shown on the right side of this cluttered screen, lets 
you select individual objects—no matter how deeply they’re buried.

The default object names aren’t particularly helpful in determining which object is which, 
so in a document with many objects that you manipulate often, you might want to take the 
time to give each object a more meaningful name. To do so, click the object name, click it a 
second time to enter edit mode, and then type the new name.

The Selection And Visibility pane has another handy trick: the ability to hide objects. Click 
the icon to the right of an object’s name to hide it or to make it visible again. (Note that 
objects in Word with Wrap Text set to In Line With Text can’t be hidden.)

To select multiple objects, hold Ctrl as you click each one. This works whether you click the 
objects directly or click their names in the Selection And Visibility pane.
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Positioning Objects

To move a selected object (or multiple selected objects), move the mouse pointer over the 
object until it becomes a four-headed arrow, and then drag. (For some types of objects, 
such as SmartArt, WordArt, or text boxes, you must point at the object’s border frame. For 
other objects, you can point to any part of the object.)

Note
Word and Outlook support a positioning style called In Line With Text, which is not 
available in Excel or PowerPoint. Inline objects move as part of the text flow, and there-
fore can’t be moved by dragging or using the Layout dialog box, described next. To 
position an object using these features, you must first select a different text wrapping 
style by right-clicking the object and choosing Wrap Text. 

For more precise positioning, right-click the object and choose Size And Position (Word, 
PowerPoint, and Outlook) or Size And Properties (Excel). Then:

●● In Word or Outlook, the Layout dialog box appears. Click the Position tab, where 
you’ll find options for aligning the object with margins and other page landmarks as 
well as for specifying a precise location on a page. For details, see “Adding Pictures 
and Graphics” on page 237.

●● In PowerPoint, the Format Shape dialog box appears. In the left pane, click Position, 
whereupon you’ll see options for specifying the position relative to the upper left 
corner or center of the slide. For more information, see “Adding Graphics and Video 
Clips” on page 601.
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●● In Excel, the Format Shape dialog box appears. In the left pane, click Properties. 
Although you can’t enter dimensions to identify a precise location, options here 
allow you to specify whether and how an object’s position and size change when you 
change the width and height of underlying cells.

Aligning and Evenly Distributing Objects

In many cases, you won’t want to fiddle with precise positioning of individual elements. 
Instead, you want to quickly align one or more objects, or you want to evenly space several 
objects on a page or slide. Office offers a quick path to each goal. To find that path, select 
the object (or objects); then, under Picture Tools, Drawing Tools, Chart Tools, or SmartArt 
Tools, click the Format tab. In the Arrange group, click Align to display an array of options, 
as shown in Figure 6-5.
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Align

Figure 6-5  Regardless of how carelessly you place objects, you can whip them back into this 
arrangement with just two steps: click Align Center (to center each object horizontally) and click 
Distribute Vertically (to evenly space each object vertically).

Changing the Z-Order of Stacked Objects

As we explained earlier in this chapter, graphics and pictures are layered one in front of 
another in a virtual stack. You’ll sometimes need to change the order so that one object 
doesn’t improperly obscure another. For example, if you place a caption for a picture in a 
text box, you’ll want the text box to be in front of the picture.

To move an object forward or back in the stack, select the object and, under Picture Tools, 
Drawing Tools, Chart Tools, or SmartArt Tools, click the Format tab. In the Arrange group, 
click either Bring Forward or Send Backward, which moves the object forward or backward 
one position in the stack. (Clicking the arrow next to these buttons exposes an additional 
command that moves the object all the way to the front or back of the stack.)



	 Working with Drawing Layers in Office Documents	 157

Ch
ap

te
r 6

Alternatively, you can move items within the stack by using the Selection And Visibility 
pane, shown earlier in Figure 6-4. Select the item to move, and then click a Re-Order arrow 
to move the item up (toward the front of the stack) or down (toward the back) in the list of 
shapes.

Resizing and Rotating Graphics and Pictures 

The techniques for changing the size or the orientation of pictures are similar to those for 
positioning objects. You can directly manipulate objects by clicking and dragging, or for 
more precise control, you can enter specific values in a dialog box.

To resize an object using the mouse, select the object and then drag one of the sizing 
handles (shown earlier in Figure 6-2). Your results might not match your expectations unless 
you use these techniques:

●● To maintain the object’s aspect ratio, use one of the corner sizing handles and hold 
down the Shift key as you drag. (For pictures, it’s not necessary to hold Shift to main-
tain the aspect ratio. But it doesn’t hurt, and that way you can use a consistent tech-
nique for all object types.)

●● To keep an object centered in the same location as you change its size, hold down 
Ctrl as you drag.

●● To maintain the aspect ratio and the center location, hold Ctrl and Shift as you drag.

To resize using the keyboard, select the object and then hold Shift as you press an arrow 
key. Hold Ctrl+Shift to enlarge or reduce in smaller increments. 

You can achieve greater precision when you resize by entering dimensions in the Size group 
on the Format tab or in a dialog box. Right-click the object, and choose Size And Position 
(Word, PowerPoint, and Outlook) or Size And Properties (Excel). In the resulting dialog 
box, you can specify the dimensions or enter a scaling factor, which calculates the size as a 
percentage of the object’s current size or original size. Figure 6-6 shows the Format Shape 
dialog box in PowerPoint; you’ll find similar options in the other Office programs.

You’ll sometimes want to rotate graphics and pictures in a document. This might be 
required because your camera doesn’t automatically rotate pictures when you shoot in por-
trait orientation. Or you might want to tilt an item slightly as an artistic effect.
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Figure 6-6  As you change the height and width, the scaling values change to match—and vice 
versa.

To rotate a graphic or picture with the mouse, select it and then point to the rotate handle 
(shown earlier in Figure 6-2). Drag in either direction around the center of the object, and it 
rotates in that direction.

Start your dragging motion here . . .

. . . and move the mouse here 
to rotate the picture clockwise

You’ll find that the image “snaps” into position at each 90-degree mark when you rotate it 
using the mouse. If your intent is to rotate an image 90 degrees, an easier method is to use 
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the Rotate tool, which is in the Arrange group on the Format tab (under Picture Tools or 
Drawing Tools).

Rotate the selected object with the keyboard by holding the Alt key as you press the Left 
Arrow (for counterclockwise rotation) or Right Arrow key. Each keypress rotates the object 
15 degrees. Press Ctrl+Alt with an arrow key to rotate 1 degree at a time. 

The last command on the Rotate menu, More Rotation Options, opens the Layout dialog 
box (Word) or Format Shape dialog box (shown earlier in Figure 6-6), where you can specify 
a rotation angle with one-degree precision.

INSIDE OUT  �
Use the Mini toolbar

When you right-click an object, a Mini toolbar that includes the most commonly used 
tools on the Format tab appears.

Height                Bring Forward

Width                 Crop

Send Back

Rotate And Flip

Office also supports three-dimensional rotation of graphics and pictures. For more informa-
tion, see “Adding Shapes and Text Boxes” on page 175 and “Applying Picture Styles” on page 167.
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INSIDE OUT  �
Specify dimensions using your preferred unit of measure

By default, Office displays measurements using the units associated with your comput-
er’s Region And Language settings, which turns out to be inches in the United States 
and millimeters in other countries. Nevertheless, in any Office dialog box, you can 
enter dimensions using any of the following units:

●● Inches: in or "

●● Centimeters: cm

●● Millimeters: mm

●● Points (a printer’s measurement equal to 1/72 inch): pt

●● Picas (a printer’s measurement equal to 12 points, or 1/6 inch): pi

●● Pixels (normally 1/96 inch; dots per inch [dpi] can be changed in Control Panel): px

To use one of these units, type the numeric value followed by one of the abbreviations 
in the list above. (If you don’t specify the unit, Office assumes you’re using the default 
unit.) As soon as you move to a different field in the dialog box, Office converts the 
dimension you entered to the default unit.

To change the default unit of measure in Word, Excel, or OneNote, click File, Options. In 
the Options dialog box, click Advanced, and then scroll to Display (Other in OneNote). 
Under that heading, you’ll find the list of available units of measure. Note that your 
setting in one Office program doesn’t affect the other programs. If you want to change 
the default setting for all programs (not just Office), visit Region And Language in Con-
trol Panel.

Grouping Objects

When you have several related objects properly positioned in relation to each other, you’ll 
want to group them. Doing so makes it easier to move or manipulate all the component 
objects as one, and it prevents inadvertently modifying part of the graphic or picture.

A simple example of the benefit of grouping is a logo that comprises two objects: a design 
saved as a picture and a slogan in a text box. After resizing and moving the objects indi-
vidually until they’re in proper position, select them both. Then, on the Format tab, click the 
Group button (see Figure 6-7), and then click Group. 
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Figure 6-7  Choosing Group causes the selected objects to be combined into a single object, as 
shown in Figure 6-8.

Figure 6-8  After grouping, the grouped objects share a single selection frame. Note that the 
Selection And Visibility pane shows the objects within the group.
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TROUBLESHOOTING
Grouped objects remain grouped after you choose Ungroup

After you choose the Ungroup command, it might appear that the objects remain 
grouped. For example, if you drag one of the formerly grouped objects, all objects 
move together. The problem is that Office leaves all objects selected after you choose 
Ungroup. The solution is simple: Click outside any of the grouped objects, which clears 
the selection. You can then select individual objects.

Inserting Pictures into Office Documents
In the context of Office, “picture” refers to much more than photographs. Regardless of 
composition, a picture is a file in any of many popular graphics formats, including JPEG, 
Portable Network Graphics (.png), Graphics Interchange Format (.gif), Windows Bitmap 
(.bmp), Windows Metafile (.wmf), and Encapsulated PostScript (.eps). 

To insert a picture, click the Insert tab, and in the Illustrations group (Images in PowerPoint), 
click Picture. The Insert Picture dialog box appears, which has all the same features as the 
familiar File Open dialog box. Navigate to the picture you want, select it, and click Insert. 
Note that you can select and insert multiple pictures simultaneously; hold Ctrl as you click 
to select each picture.

Also note the arrow next to the Insert button, which exposes two additional insert options. 

Choosing Link To File commands Office to insert a link to the picture file’s location instead 
of embedding the picture file in the Office document. This results in a smaller document 
file size, but more importantly, it means the document will always show the current version 
of the picture file. If you change the file in its original location, you’ll see the updated ver-
sion the next time you open the Office document. If the file is not available at the linked 
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location (if, for example, it has been renamed or deleted, or if it’s on a server drive that’s not 
currently available), a red X appears instead of the picture. 

Insert And Link embeds the picture file in the document and includes a link to the origi-
nal file. When you open a document, if the linked file is available, Office displays it; if not, 
Office displays the embedded version. 

That’s all there is to it. After you insert a picture, you can select it, move it, resize it, and 
work with it in various ways, as described in the next section, “Making Your Pictures Look 
Great.”

INSIDE OUT  �
Choose a better default wrapping style for pictures in Word

When you insert a picture or screenshot in Word, by default it is placed at the inser-
tion point. A graphic positioned this way (which is called In Line With Text) acts like any 
other letter or symbol in the text stream: when you type to the left of the graphic, it 
shifts to the right until it no longer fits and then wraps to the next line. In-line graph-
ics work best in layouts that have text above and below each picture (like most of the 
screen illustrations in this book, for example) but not beside them. Place each picture 
in its own paragraph to use this style.

You can be much more creative in your layouts by setting pictures so that text “wraps” 
around them. To change the wrapping style for a picture, right-click it and choose Wrap 
Text. For details, see “Adding Pictures and Graphics” on page 237.

If you find yourself frequently changing the wrapping style, you should change the 
default. To do that, click File, Options. In the Word Options dialog box, click Advanced. 
Under Cut, Copy, And Paste, locate Insert/Paste Pictures As, and select an option.

Making Your Pictures Look Great
Programs in Office 2010 include picture editing tools that rival many stand-alone programs 
for editing digital images. Using just the tools in Word, Excel, PowerPoint, or Outlook, you 
can apply artistic touches such as blurs, paint strokes, and mosaic effects. A number of pre-
defined picture styles include borders, reflections, 3-D effects, and perspective tilting. You 
can automatically outline the subject of a photo and remove the background. Other tools 
let you overlay text in creative ways. And then there are the more mundane tasks: making 
color corrections; adjusting brightness, contrast, and sharpness; and resizing photos. A new 
cropping tool even makes it easier to see what you’re removing from the image. 
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A complete description of the picture-editing capabilities of Office could fill a chapter—or 
a book—so we don’t explain every option in detail. Fortunately, with the start we provide 
here, you’ll find that these features are easily discoverable. And the Live Preview capability 
provided by most of the picture-editing tools makes them intuitive to use as well.

For information about two other common tasks that apply to other types of graphics as 
well as pictures, see “Resizing and Rotating Graphics and Pictures” on page 157.

Cropping Pictures

You’re an exceptional photographer if each picture you take is perfectly composed. For 
those pictures that aren’t perfect, you’ll want to crop to remove unnecessary background 
or to better fit the space in your document. Earlier Office versions had cropping capabili-
ties, but they were difficult to use because you couldn’t really see what you were doing. In 
Office 2010, you can see exactly what’s included and what’s excluded before you commit.

To crop a picture, select it, click the Format tab (under Picture tools), and in the Size group, 
click Crop. Cropping handles appear on your picture; drag a handle to adjust the cropping. 
Alternatively, you can drag the picture. Either way, note that the area to be cropped out 
remains visible but shaded. To crop equally from both sides of a picture, hold Ctrl as you 
drag one of the side cropping handles. To crop equally from all four sides, hold Ctrl and 
drag one of the corner handles. Press Esc or click outside the picture when you’re done.

As shown in Figure 6-9, you can also crop to a particular aspect ratio (that is, the ratio of 
width to height). This is useful when you want an image to perfectly fill a screen or a partic-
ular size of photo paper or picture frame, for example. Click the arrow by the Crop button, 
and then click Aspect Ratio and select the ratio you want. 

Note that when you drag a cropping handle, the aspect ratio is not maintained; you get 
free-form dragging just as if you used the normal Crop command. You’ll sometimes find 
that getting the best results when cropping to a particular aspect ratio requires an iterative 
process of resizing and cropping. Those iterations might also include choosing the Fill or Fit 
command on the Crop menu. Both commands maintain (or restore, if necessary) the origi-
nal picture’s aspect ratio, but they crop the image to fit the current picture shape and size.
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Figure 6-9  To maintain the aspect ratio after you make a selection, drag the picture instead of 
dragging the cropping handles.

For more precise cropping control, right-click the picture and choose Format Picture. In the 
left pane of the Format Picture dialog box, click Crop, and then enter the dimensions.
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If you find rectangular cropping to be too dull, you might enjoy experimenting with the 
Crop To Shape command on the Crop menu. With it, you can get some truly strange (and 
sometimes wonderful) effects by using predefined shapes as crop outlines. (Figure 6-10 
shows an example of the former.) Most shapes can be modified in various ways after you 
apply them. For more information about working with shapes, see “Adding Shapes and Text 
Boxes” on page 175.

Figure 6-10  Drag the shape handles (in this example, the diamonds along the left and bottom 
edges) to adjust the shape.

Adjusting Colors and Applying Artistic Effects

Features in Office for correcting picture colors and applying special effects range from the 
essential to the bizarre. Yet they’re generally easy to understand, and, best of all, with Live 
Preview you’re able to see how a particular setting looks with your picture. You don’t need 
to rely on a thumbnail of a sample picture or try to guess how numeric settings translate to 
visual images.

The tools for adjusting color are on the Format tab (under Picture Tools) in the Adjust 
group. Select a picture, click the Format tab, and then click Corrections to see a gallery of 
options for adjusting the picture’s sharpness, brightness, and contrast. As shown in Fig-
ure 6-11, clicking Color displays a gallery for adjusting saturation and tone, as well as for 
applying a color tint to the picture. To see how a setting will look, simply hover the mouse 
pointer over it, and the setting is temporarily applied. When you find the one you like, 
click it.

The third gallery in the Adjust group, Artistic Effects, works in an identical fashion. The 
effects include an assortment of filters and simulated techniques, such as pencil sketch, 
paint brush, looking through frosted glass, and so on. Most defy description, so the best 
way to learn about them is to open the gallery and point.
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Figure 6-11  The current settings have a bold outline in the gallery.

At the bottom of each gallery is a command that leads to an options dialog box. You can 
get to the same dialog box by right-clicking the picture and choosing Format Picture, or 
by clicking the dialog box launcher in the lower right corner of the Picture Styles group on 
the Format tab. In the Format Picture dialog box, click Picture Corrections, Picture Color, 
or Artistic Effects. You can view and edit numeric values that correspond to the gallery set-
tings, and you can make precise adjustments to the settings. In addition, Presets buttons on 
each tab provide another gallery view. One difference here: To see the effect on your pic-
ture, you must click the thumbnail in the gallery; pointing to it does nothing.

Applying Picture Styles

The Picture Styles group on the Format tab contains tools for adding a border to your pic-
ture and for applying effects such as shadows, reflections, glows, and three-dimensional 
rotation. The Picture Styles group also includes a Quick Styles gallery, which contains pre-
configured combinations of each of these settings. 

To use the Quick Styles gallery, select one or more pictures, and then point to one of the 
visible thumbnails. If none of those suit your fancy, you can scroll down in the gallery or, 
better yet, click the More button, the arrow at the bottom of the scrollable window. Figure 
6-12 shows an example. When you find a suitable option, click it to apply the settings.
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Figure 6-12  The Quick Styles gallery makes it easy to try different effects.

To make your own settings—or to adjust the ones made by a Quick Styles preset—click Pic-
ture Border (where you can select a color, line width, and line style) or Picture Effects (where 
you can choose shadows, reflections, glows, softened edges, bevels, and three-dimensional 
rotation from galleries). Each of these options can be viewed and fine-tuned in the For-
mat Picture dialog box. Click the dialog box launcher in the Picture Styles group, and then 
click Line Color or Line Style to set up a border, or click Shadow, Reflection, Glow And Soft 
Edges, 3-D Format, or 3-D Rotation to make settings that correlate to the Picture Effects 
galleries.

Another option in the Picture Styles group, the Picture Layout gallery, embeds your 
selected pictures into SmartArt objects. With this feature, you can make some professional-
looking presentation materials with just a few clicks. For more information, see “Adding 
SmartArt to Documents” on page 180.

Removing the Picture Background

Another feature new to Office 2010 is one that automatically removes the background 
from a picture, leaving only the picture subject visible. To use this feature, it helps to have a 
picture with the subject in sharp focus, and with good contrast. Yet you can sometimes get 
surprisingly good results even with less-than-perfect pictures.

To remove the background from a picture, select the picture, click the Format tab, and in 
the Adjust group, click Remove Background. Office quickly makes its best guess at crop-
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ping and masking the background, which it identifies with a magenta overlay. As shown in 
Figure 6-13, this initial attempt isn’t always perfect.

Figure 6-13  Initially, Office didn’t include this penguin’s wings, which are closer in color to the 
background than to the rest of the penguin.

If the initial results aren’t quite right, click Mark Areas To Keep, and then click the additional 
areas to include (such as the penguin’s wings in Figure 6-13). Click Mark Areas To Remove 
and then click any unwanted areas that Office left in. If a single click merely deposits a 
mark but doesn’t include or exclude the area of interest (as indicated by the colored mask), 
try dragging through the area. When you’re done, click Keep Changes. In our example, 
we zoomed in, and then it took just a drag along the length of each wing to produce this 
result.
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INSIDE OUT  �
Adjust the cropping area

You’ll find that with some photos, automatic background removal doesn’t work well, 
and the initial results mistakenly include or exclude several areas. Before you start mak-
ing manual corrections, the first thing you should do is adjust the cropping indicators 
to more closely match the final outline you want. When you change the cropping, 
Office modifies the background selection and, in our experience, often does a much 
better job with your assistance here.

Undoing Picture Edits

As you experiment with the picture formatting features in Office, not every shot is going 
to be a keeper. Mistakes that you recognize right away, of course, can always be undone in 
the usual manner: click Undo on the Quick Access Toolbar, or press Ctrl+Z. But you might 
decide much later to revert to the original photo settings. 

Doing so is quite simple: Select the picture, click the Format tab, and in the Adjust group, 
click Reset Picture (to restore the background, remove borders and other picture styles, and 
restore the original colors) or Reset Picture & Size (to do all of the foregoing, plus remove 
any cropping and restore the picture’s original size). 
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TROUBLESHOOTING
Changes to pictures can’t be undone, or edits disappear

A setting buried deep in Office options can lead to some head-scratching moments if 
it’s not set properly. The symptoms can be either of the following:

●● After making various picture edits, as described in the following sections, you 
decide you don’t like the changes and want to restore the original picture—but 
the Reset button is unavailable.

●● Each time you open a document containing a picture inserted with the Link To 
File or Insert And Link command, all the artistic effects and other edits you’ve 
added are gone, and the original picture file appears.

These seemingly opposite symptoms can arise from the same root cause: the Discard 
Editing Data setting. To review the setting, click File, Options. In the Options dialog 
box, click Advanced, and scroll to Image Size And Quality. Unless reducing the file size 
of your Office document is paramount, clear Discard Editing Data.

What About Office Picture Manager?
Office 2010 includes a program called Microsoft Office Picture Manager, which you’ll 
find on the Start menu in the Microsoft Office 2010 Tools subfolder of the Microsoft 
Office folder. Office Picture Manager provides a way to manage your pictures as stand-
alone files outside Office documents. With Office Picture Manager, you can convert 
picture files from one format to another (by using its Export command, not Save As). 
Compared with the tools built in to the primary Office programs, Office Picture Man-
ager has slightly better options for color correction (but no live previews) and a few 
additional tools, such as red-eye removal.

Nonetheless, Office Picture Manager is a relic from earlier Office versions, and there’s 
little reason to use it because better options are readily available. Windows Live Photo 
Gallery (available as a free download from Microsoft at download.live.com) provides 
all the functionality of Office Picture Manager and more. Another program we recom-
mend is IrfanView (irfanview.com), which offers unsurpassed viewing capabilities and 
file conversions, among other features.
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Finding and Using Clip Art
The term “clip art” comes from the days when graphic artists would purchase printed cata-
logs of stock art, from which they would “clip” (literally cut out) an item to be pasted into 
camera-ready artwork. Although the methods have changed radically, clip art lives on—
now in the form of an online catalog of line art, illustrations, photographs, audio clips, and 
video clips.

For more information about working with video, see “Adding Graphics and Video Clips” on 
page 601.

To find and insert clip art, follow these steps:

	 1.	 Click the Insert tab, and click Clip Art. The Clip Art task pane appears. 

	 2.	 Under Search For, type a word or two that describes what you’re looking for. 

	 3.	 Click the arrow by Results Should Be, and select the types of media you want to 
include in your search.

	 4.	 To include Microsoft’s online catalog in the search, select Include Office.com Content. 
If you don’t select this box, Office looks only at your local collection, which includes 
a handful of clip art included with Office 2010, plus any items you’ve added to your 
collection.

	 5.	 Click Go. To learn more about a displayed result, hover the mouse pointer over it.

Click for more options 
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	 6.	 To insert an item in your document, click it. For other options, click the arrow along 
its right side.

Choose Make Available Offline if you want to reuse the clip in the future. Office stores the 
clip in a collection, which is a database file stored on your computer. You can organize your 
clip collection into folders (you’re asked to select a folder or create a new one when you 
choose Make Available Offline), which can be useful for managing large collections.

Although the search capabilities of the Clip Art task pane don’t rely on the organizational 
structure of your collections, if you feel compelled to tidy them up, Office 2010 includes for 
that purpose a program called Microsoft Clip Organizer. You can find it on the Start menu 
by clicking All Programs, Microsoft Office, Microsoft Office 2010 Tools. Clip Organizer is also 
useful if you want to add items to your collections from files on your computer, a scanner, 
or a camera. Other than that, there’s seldom reason to venture into Clip Organizer.

INSIDE OUT  �
Edit clip art

A limitation of stock art is that it might not precisely fit your artistic concept. Many clip 
art images can be modified, however. For example, you can right-click an illustration 
and choose Edit Picture. Office warns that the picture is not editable, but then offers 
to convert it to an editable format. Click Yes, and get creative. Similarly, imported pho-
tographs can be modified with any of the techniques and effects described earlier in 
“Making Your Pictures Look Great” on page 163. 
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Capturing and Inserting Screenshots
You’ll sometimes find it useful to insert a representation of a window (or part of a window) 
clipped from your computer’s screen. For example, you might want to include part of a web 
page in a document, or if you’re documenting computer procedures for your office, you 
might want to show a program window.

To insert a screenshot, first be sure that the window you want to capture is not minimized 
to the taskbar. (It’s okay if it’s covered by other windows, including the Office window 
you’re working in.) Then click the Insert tab, and in the Illustrations group, click Screenshot. 
Thumbnail images of each window appear, as shown in Figure 6-14.

Figure 6-14  Available windows include all windows and dialog boxes that are not minimized, 
except for the Office window in which you’re working.

Click a thumbnail to insert an image of the entire window. If you want to show only part 
of the screen, you can crop the window image after you insert it, or you can click Screen 
Clipping. When you click Screen Clipping, the Office window disappears from view, expos-
ing the underlying screen—whatever it may contain. Use the mouse to drag across the area 
you want to capture, creating a rectangular clipping area. When you release the mouse 
button, Office immediately inserts an image of the area you outlined.

Note
Although OneNote doesn’t have the ability to capture and insert entire windows, you 
can grab screen clippings in OneNote. On the Insert tab, in the Images group, click 
Screen Clipping. For more information, see “Screen Clippings” on page 504.
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INSIDE OUT  �
Capture the Office window

Ironically, the new screenshot feature in Office 2010 doesn’t let you capture an 
image of the Office program itself. Workarounds abound, but the simplest is to press 
Alt+PrtScn (which copies the current window to the Clipboard) and then press Ctrl+V 
to paste the Clipboard content into your document.

Inserted screenshots are handled by Office programs exactly like pictures. When you select 
a screenshot, Picture Tools appears on the ribbon. The Format tab contains the same tools 
and features, and you can apply to a screenshot any of the changes described earlier in 
“Making Your Pictures Look Great” on page 163.

Unlike pictures that you insert, however, screenshots don’t exist elsewhere as an image file. 
In Word, OneNote, PowerPoint, and Outlook (but not Excel), it’s easy to create such a file. 
Simply right-click the image and choose Save As Picture. 

Adding Shapes and Text Boxes
Office includes a variety of shapes that can be inserted as line illustrations. Shapes include 
arrows and other symbols to use in diagrams, various polygons, boxes for callouts and 
other text, and some that’ll leave you wondering what possible use they could have. 
Although the unadorned shapes are not much to look at, Office includes a full range 
of effects, colors, shading, and other customizations that can add some pizzazz to your 
document.

The tools for inserting and customizing shapes also work on text boxes. A text box is, in 
fact, merely a rectangular shape that can contain text.

To insert a shape, click the Insert tab, and in the Illustrations group, click Shapes. A gallery 
of predefined shapes appears. (If you’re inserting a text box, you can bypass the Shapes 
gallery by clicking Text Box, which is in the Text group on the Insert tab.)
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Click a shape, and then drag in the document to create a container for the shape. Don’t 
worry if the size or position isn’t quite right; you can easily change move, resize, or rotate 
the shape by selecting it and dragging its handles. (For details, see “Positioning Objects” 
and “Resizing and Rotating Graphics and Pictures” earlier in this chapter.) To modify a 
shape, select the shape and look for shape handles, which appear as yellow diamonds.

Drag this shape handle to adjust the size of the arrow’s head

Drag this shape handle to adjust
the width of the arrow shaft

For more fine-grained control, on the Format tab, in the Insert Shapes group, click Edit 
Shape, Edit Points (or right-click the shape and click Edit Points). Each point that defines 
the shape appears as a black square, which you can drag in any direction. To add a new 
point, hold down Ctrl and click anywhere on the shape’s outline; Ctrl+click an existing point 
to remove it. When you click a point to select it, two additional handles appear; together, 
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these three points define the point and the line segment on either side of it. You can drag 
the point or one of its handles to get different effects. To change the type of point, hold 
Shift (for a smooth point), Ctrl (straight point), or Alt (corner point) as you drag a handle.

The real fun begins when you apply shape styles. Select a shape, click the Format tab 
(under Drawing Tools), and click the More button in the Shape Styles group to see a gallery 
of predefined styles, as shown in Figure 6-15. Like the Picture Styles gallery, this one uses 
Live Preview; as you point to a thumbnail, its formatting appears in your document as well. 
Click a gallery item to apply the formatting.

Figure 6-15  The Shape Styles gallery can apply pleasing combinations of colors and effects with 
a single click.

The Shape Styles gallery displays colors and styles that conform to the currently selected 
theme; changing the theme also changes the gallery contents. (For more information, see 
“Using Office Themes” on page 185.) If none of the options in the Shape Styles gallery tickles 
you, use the tools on the right side of the Shape Styles group on the Format tab:

●● Shape Fill  Options here let you fill the shape with a color (either solid or as a gradi-
ent), a picture from a file on your computer, or a texture (from a gallery that includes 
various fabrics, stones, wood grains, and other materials). 

●● Shape Outline  Select a color, line weight, and line style for the shape’s outline.
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●● Shape Effects  Available effects are similar to the ones you can apply to pictures: 
shadows, reflections, glows, soft edges, bevels, and three-dimensional rotation, each 
of which is displayed in a Live Preview gallery.

All the settings available on the Format tab—and more—can also be configured in the 
Format Shape dialog box. To view it, click the dialog box launcher (the arrow in the lower 
right corner of the Shape Styles group on the Format tab) or right-click a shape and choose 
Format Shape.

INSIDE OUT  �
Copy and move graphics and formatting

To copy or move a selected graphic or picture, you can use the Clipboard as you would 
with ordinary text. The usual keyboard shortcuts (Ctrl+X for Cut, Ctrl+C for Copy, and 
Ctrl+V for Paste), Home tab commands, and menu commands do the job.

But—just as you can with text—you can copy all the formatting for a graphic or pic-
ture, which is handy when you need to apply extensive (but consistent) styles and for-
mats to many pictures. Use the Format Painter or use keyboard shortcuts: Ctrl+Shift+C 
to copy formatting, and Ctrl+Shift+V to paste formatting. For more information, see 
“Copying Formatting” on page 128.
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Displaying Data Graphically with Charts
Data charts have been a key feature of Excel since its earliest appearance back in 1985. 
The chart capabilities and features increased dramatically over the years, of course, but 
full-featured charting remained primarily an Excel feature, with lesser charting capabilities 
available in other Office programs. With Office 2010, however, the full range of charting 
features is available in Word, PowerPoint, and Outlook, as well as Excel.

To insert a chart in a document, click the Insert tab and then click Chart. The Insert Chart 
dialog box appears, in which you can select from an astonishing gallery of chart types. 
(Because charting remains a central part of Excel, there isn’t a single Chart tool on the 
Insert tab. Instead, each chart type appears in its own gallery. You can, however, open Insert 
Chart by clicking the dialog box launcher in the Charts group on the Insert tab.)

Select a chart type (you can change it later) and click OK. A worksheet then opens in a 
new window in Excel; this is where you enter the data for your chart. You can then switch 
back and forth between entering data in the Excel window and viewing and formatting the 
resulting chart in your document window. (If you’re inserting a chart in Excel, the data and 
the chart appear in different parts of the same window.)

To change the appearance of your chart, select the chart and click the tabs under Chart 
Tools:

●● Use the Design tab to change overall settings, such as chart type, data orientation, 
and styles.
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●● On the Layout tab, you can modify specific chart elements, such as titles, axes, and 
legends.

●● The Format tab is the place to manage shape styles, position, and size—settings we 
cover elsewhere in this chapter. (See “Adding Shapes and Text Boxes” on page 175; “Posi-
tioning Objects” on page 154; and “Resizing and Rotating Graphics and Pictures” on 
page 157.)

For details about displaying data with charts, including descriptions of features on the Design 
and Layout tabs, see Chapter 13, “Charts and Data Analysis.”

Adding SmartArt to Documents
SmartArt graphics provide an easy way to create graphical lists, process diagrams, organi-
zational charts, and similar diagrams that meld shapes, text, and pictures into compelling 
visuals.

To insert SmartArt, click the Insert tab, and click SmartArt. A dialog box appears, in which 
you can select from an array of layouts, as shown in Figure 6-16. Select one and click OK.

The next step is to enter text into the SmartArt graphic. If the Text pane isn’t displayed, 
select the graphic and click the arrow at the center of the left side of the frame. Within the 
Text pane, shown in Figure 6-17, use the keyboard shortcuts shown in Table 6-2. Alterna-
tively, right-click an item in the Text pane, and choose from the menu. Tools in the Create 
Graphic group on the Design tab under SmartArt Tools provide a third (and sometimes 
best) method for organizing the text in a SmartArt graphic.
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Figure 6-16  When you select a graphic, a larger visualization and a description of the graphic’s 
use appear in the right pane.

Figure 6-17  Although you can enter text directly into the graphic, it’s usually easier with the aid 
of the Text pane.

Table 6-2  Keyboard Shortcuts for Text Entry in SmartArt Graphics

Action Keyboard Shortcut
Go to next entry Down Arrow
Go to previous entry Up Arrow
Create new entry Enter
Delete entry Delete (you must first delete any text) 
Demote current entry Tab
Promote current entry Shift+Tab
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The Design tab under SmartArt Tools includes galleries in which you can select a different 
SmartArt design (in the Layouts group), a different color scheme (in the SmartArt Styles 
group), or a different style (a predefined configuration of fill, outline, and effects settings 
for shapes and text in the SmartArt graphic).

You’ll find more granular controls on the Format tab under SmartArt Tools. You can modify 
shapes individually or en masse (a SmartArt graphic is an assemblage of individual shapes) 
by using the tools and techniques described earlier in this chapter for individual shapes. 
(See “Adding Shapes and Text Boxes” on page 175.) In addition, you can format text using all 
the options available for WordArt, as described in the next section.

Applying Text Effects with WordArt
A fixture in Word for many years, WordArt has changed significantly (for the better) in 
recent editions. It’s now easier to use, more flexible, and can create attractive text effects—
instead of the funhouse-mirror style distortions that typified its output in earlier editions. 
Moreover, you can now use WordArt in Excel, PowerPoint, and Outlook as well as Word.

To convert existing text to WordArt, first select the text. Then (whether you have text 
selected or not) click the Insert tab, and in the Text group, click WordArt. A gallery of color-
ful styles appears. Click one, and you’ll see your text (or placeholder text, if you didn’t have 
any selected) in the new style. When the selection frame is a dashed line, you can select 
and enter text. (Use the Esc and Enter keys to switch between text entry and formatting 
modes.) You also specify a font, font size, and effects such as bold and italic while you’re in 
text entry mode; use the usual text formatting tools on the Home tab or the Mini toolbar.

With your text in place, you can proceed to modify other aspects of its appearance. Select 
the WordArt object and then click the Format tab (under Drawing Tools). Here, in the 
WordArt Styles group, you can select a different predefined lettering style from the gallery. 
(If a Quick Styles button appears, click it to display the gallery.) The three tools to the right 
of the gallery offer additional customization options similar to those available for shapes:

●● Click Text Fill to select coloring options for the letters. You can select a color (solid or 
gradient). Or go crazy: use a picture from a file or a texture cropped to the shape of 
the letters.
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●● Click Text Outline to specify the color, line weight, and style of the letter outlines.

●● Click Text Effects (see Figure 6-18) to add shadows, reflections, and other effects. Each 
item on the Text Effects menu leads to a gallery submenu with Live Preview. 

Figure 6-18  You’ll find the funhouse-mirror effects in the Transform gallery.

All the settings and effects available on the Format tab, along with additional options, can 
be viewed and configured in the Format Text Effects dialog box. To open it, click the Word-
Art Styles dialog box launcher.

Drawing with Ink
On tablet PCs and other computers equipped with pen input, you can use your stylus to 
add “ink” to a document. You might find this convenient for taking notes, marking up cor-
rections, or inserting free-hand drawings. 

When the stylus gets close to the display, Ink Tools appears on the ribbon and below it, the 
Pens tab, which is shown in Figure 6-19. In the Write group, you select a tool—pen, high-
lighter, or eraser—and your stylus acts as that tool. To use your stylus in its other role—as a 
mouse replacement that you can use to select text and objects, position the insertion point, 
and so on—click (or, more accurately, tap) Select Objects.
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Figure 6-19  In the Pens group you specify the color and thickness for each pen and then select 
your favorites, which remain visible without you having to open a gallery.

Ink is stored as an object similar to any other graphic. Click to select it, and you’ll see the 
familiar selection frame along with its sizing and rotate handles. When selected, the Format 
tab under Drawing Tools becomes available, although most of its tools and effects can’t be 
applied to ink.

The inking feature has a couple of nonobvious tricks that assist in converting your scrawl 
into usable data:

●● If you click Convert To Shapes (in the Ink Art group on the Pens tab) before you 
begin drawing, when you draw a shape that resembles a circle, rectangle, or other 
standard shape from the Shapes gallery, Office instantly and automatically converts it 
from ink to a normal shape object. With this capability, you can sketch out organiza-
tion charts, flow charts, and similar diagrams and not have it appear like it was cre-
ated by a six-year-old.

●● You can convert handwritten text into typed characters. Right-click the ink object 
that contains your handwriting, and choose Copy Ink As Text. The text is now on the 
Clipboard, and you can paste it into your document. The handwriting-to-text conver-
sion isn’t perfect (although we’ve seen it correctly interpret scratchings that we had 
trouble reading), so be sure to proofread it carefully.
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Using Office Themes
The final section of this chapter deals not with individual graphic objects but with a feature 
that can change the overall appearance of your document with just a few clicks. That fea-
ture is document themes. A theme is a collection of formatting options that include a set of 
colors, a set of fonts (one for headings and one for body text), and a set of effects (such as 
line styles and fill effects). 

A theme in PowerPoint also includes backgrounds. For more information about themes in 
PowerPoint, see “Applying Themes” on page 611.

Selecting a theme causes all these theme elements to be applied to a document. (You can 
override theme settings for any part of a document, and those parts won’t be affected by 
theme changes.) Themes are consistent across all Office programs. You can, for example, 
apply a theme to a Word document and apply the same theme to an Excel worksheet and a 
PowerPoint presentation, giving them a consistent look and feel.

To apply a theme to the current document, click the Page Layout tab (in Word and Excel) 
or the Design tab (PowerPoint) and then click Themes, as shown in Figure 6-20. Point to a 
theme to see a live preview of your document, and click a theme to apply its settings. 

Figure 6-20  The Custom section appears only if you have saved one or more themes.
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To see what components constitute a theme (and to change them to your liking), use the 
other buttons in the Themes group on the Page Layout (or Design) tab.

●● Colors  A theme includes a dozen (usually complementary) colors that are applied 
to different document elements. You can select one of the 40-odd built-in color col-
lections, or you can click Create New Theme Colors to make a custom collection.

 

●● Fonts  A theme comprises two fonts: one for headings and one for body text. Select 
a built-in pairing, or click Create New Theme Fonts to mix your own. Office differenti-
ates between headings and body text based on the paragraph style (Word), cell style 
(Excel), or placeholder type (PowerPoint).

●● Effects  Select one of the built-in line and fill effects combinations. You can’t create 
your own variation. 

After you’ve made your selections and customizations in each of these three areas, you 
might want to save this combination as a new custom theme. To do that, click Themes, 
Save Current Theme. Each theme is stored in its own file, so it’s easy to copy the theme file 
to other computers, thereby enabling consistent appearance throughout an organization. 
Theme files are stored by default in %AppData%\Microsoft\Templates\Document Themes 
(C:\Users\username\AppData\Roaming\Microsoft\Templates\Document Themes on a Win-
dows 7 computer with default settings), but you can store them in any folder. 

If your custom theme doesn’t appear in the Themes gallery after it’s been copied to a com-
puter, click Themes, Browse For Themes to locate it.
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CHAPTER 15

Inside OneNote 2010

M icrosoft’s OneNote is more than seven years old, and yet for many (if not most) 
Office users it’s a complete unknown. That’s understandable: After all, in Office 
2003 and Office 2007, OneNote was included only in a couple of Office editions, 

but in Office 2010, OneNote is elevated to marquee status and is part of every edition.

So what is OneNote exactly? In this case, the program’s metaphor is absolutely accurate. 
OneNote really is a digital replacement for a traditional loose-leaf notebook in which you 
can save class notes, academic research, meeting minutes, or just about anything else you 
might be tempted to put on a piece of paper. You can type, write, paste, print, snip, clip, 
and send just about anything to OneNote, which saves each item on a page in a section of 
a notebook. You can move the pieces around on the page, format text and resize pictures, 
and arrange text into tidy outlines and lists.

Did we mention that OneNote notebooks are infinitely expandable? You can add new 
pages and sections, organize pages and subpages, and create as many new notebooks as 
you can fit in your default storage location. Personal notebooks are stored on your hard 
drive; you can share and sync notebooks using Windows Live SkyDrive (or, on a home or 
business network, in a shared folder or SharePoint site).

Even if you already know OneNote well from an earlier version, you’ll want to read this 
chapter carefully. Office 2010 includes some significant new features and capabilities, as 
well as a new file format.

For more details on the Office 2010 file format and potential issues, see “Choosing the Right 
OneNote File Format” on page 494.
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What’s in a OneNote Notebook?
The basic organizational unit of OneNote is the notebook. When you create a new note-
book or open a saved one, its icon and name appear in the Navigation bar on the left of 
the OneNote window, with the hierarchy of sections (and, optionally, section groups) shown 
in an indented list below the notebook icon and in tabs along the top of the contents pane. 
Selecting a section displays its contents in the page tabs bar on the right. Selecting a page 
from that list displays it in the contents pane. To begin adding your own notes, pictures, 
and web clippings, you can rename the default section and page or start adding new sec-
tions and pages of your own.

Figure 15-1 shows an open notebook containing five sections, with five pages in the open 
section.

Page title      Search box

Navigation bar      Section tabs                                                   Page tabs bar

Figure 15-1  This notebook is arranged into five sections, shown in tabs on the left and on top; 
select a page from the current section using the list on the right.
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You can organize your notes in ways that are much more sophisticated than the simple 
Class Notes notebook shown here. For example, as your collection of notes grows in size 
and complexity, you can combine sections into section groups and gather a group of 
related pages together as subpages; although the previous OneNote version also allowed 
you to create subpages, OneNote 2010 is the first that allows you to collapse them under 
a parent page. You can also create clickable links that open other OneNote pages, Office 
documents, Outlook items, or web pages.

For more on how to manage section groups and subpages, see “Expert Organizational Tech-
niques” on page 542. You’ll find details on how to link pages to one another and to external con-
tent in “Using Links for Quick Connections” on page 530.

OneNote notebooks are automatically included in the Windows Search index. As a note-
book grows in size (and especially when you use multiple notebooks), search becomes not 
just handy but essential. For the best results, use the search box above the page tabs bar.

You’ll find full details on how to use the OneNote search box in “Smart Search Strategies” on 
page 534.

There’s no limit on the type of information you can save in a notebook. A partial list of 
common tasks and activities includes the following:

●● Taking notes during classroom lectures and lab sessions

●● Organizing online research

●● Recording the minutes of a meeting

●● Planning a family reunion or vacation

●● Creating to-do lists for short-term tasks and long-term goals

●● Organizing manuals and warranty information for household appliances

Or anything that strikes your fancy, really.

There’s no right or wrong way to build a notebook or to organize its parts. Your personal 
preferences dictate how you can manage and use notebooks. 

Creating and Opening OneNote Files

One striking difference between OneNote and other Office programs is the absence of a 
Save button or menu. OneNote does indeed store its work in files, but it handles virtually 
all of the management tasks for those files in the background. Except in rare circumstances, 
you should never need to directly manipulate OneNote files.
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To create a new notebook, click File, and then click New. Follow the three-step process 
shown in Figure 15-2 to choose where you want the notebook files stored, and then click 
Create Notebook to create the new notebook files and begin working immediately.

Figure 15-2  The name you enter in step 2 here is used as the display name for your new note-
book and as the name of the new folder where its files are stored.

In this chapter, we assume you’re creating and storing the new notebook locally (choose 
My Computer in step 1). The default location for all new notebooks is the OneNote Note-
books subfolder in the Documents folder of your user profile. You can specify an alternative 
location in the Location box.

The text you enter in the Name box under New Notebook is used as both the folder name 
and the display name shown in the OneNote Navigation bar. After you create a notebook, 
you can change its display name at any time without affecting the original folder name. To 
do so, right-click the notebook name in the Navigation bar and click Rename. That opens a 
dialog box like the one shown in Figure 15-3, which also allows you to change the location 
or format of the notebook.
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Figure 15-3  Changing the display name of a notebook here does not affect the name of the 
folder where its files are stored. 

So what about the files themselves? Each notebook section is saved in its own file, using the 
default Microsoft OneNote Section format with a file name extension of .one. If you create 
a OneNote notebook by clicking File and then New in OneNote 2010, the program creates 
a tiny file with the name Open Notebook; this file is saved in Microsoft OneNote Table Of 
Contents format, with a file name extension of .onetoc2. Strictly speaking, the Open Note-
book file isn’t needed. If you point OneNote to a folder filled with OneNote section files, it 
will ask you if you want to open the folder as a notebook, as shown here. 

If you click Yes, OneNote creates a new OneNote Table of Contents file, using the folder 
name as the notebook display name and populating it with all section files contained within 
the folder.

INSIDE OUT  �
What’s the right way to move a notebook?

If a notebook is simply a collection of OneNote section files in a folder, you can move 
the notebook to a new location just by moving its folder, right? Yes you can, and for a 
file stored on your local hard drive the results will almost certainly be successful. But 
for a notebook stored in a shared network location, manually moving files incurs the 
risk that any unsynchronized changes in that notebook will be lost. To avoid that pos-
sibility, we encourage using the official method: right-click the notebook name in the 
Navigation bar, click Properties, and then click Change Location in the Notebook Prop-
erties dialog box. 



Chapter 15

494	 Chapter 15  Inside OneNote 2010

Choosing the Right OneNote File Format
With OneNote 2010, Microsoft has changed the file format used for OneNote section 
files. When you create a new notebook in OneNote 2010, your files are automatically 
saved in the new file format. If you intend to share notebooks with people who are 
still using OneNote 2007, or if you want to preserve the ability to open those files on 
another computer using the earlier version of OneNote, you need to explicitly choose 
the alternative format.

To convert a notebook from OneNote 2007 format to OneNote 2010 format (or vice 
versa), right-click the notebook icon in the Navigation bar and then click Properties. 
Click Convert To 2010 or Convert To 2007 (the option for the current format will be 
unavailable). Note that this conversion can be made only on the entire contents of a 
notebook. When you make the conversion, the format you choose becomes the new 
default format for sections within that notebook.

When you move a section from one notebook to another, OneNote automatically con-
verts it to the default format of the destination notebook. If you use Windows Explorer 
to manually move a section file saved in OneNote 2007 format to a notebook whose 
default format is OneNote 2010, the older format is preserved, and you see an infor-
mation bar warning you of potential incompatibilities when you open that section.

If you choose to save a notebook using the older OneNote 2007 file format, the follow-
ing features are affected:

●● The math equations feature is unavailable, and any existing equations are con-
verted to static images.

●● Context links (linked notes) and version information are permanently removed.

●● Subpages are preserved but can no longer be collapsed in the pages tab list.

●● The contents of the OneNote Recycle Bin for that notebook are permanently 
removed.

In addition, you must use OneNote 2010 format to save a notebook in a Windows Live 
SkyDrive folder or on a SharePoint site so that you can open and edit the notebook in a 
web browser using the OneNote Web App.

OneNote 2010 allows you to open a notebook saved in OneNote 2003 format, but that 
notebook is opened in read-only mode. If you convert a notebook from OneNote 2003 
format to either OneNote 2007 or 2010 format, the conversion is permanent and can-
not be undone.
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You don’t need to manually save OneNote files. OneNote automatically saves your work 
every 30 seconds and when you close a notebook or the program itself. If you’ve just made 
a large number of changes and you want to force a save instead of waiting for the next 
automatic save, press Ctrl+S.

The Save As menu allows you to export or share notebooks, pages, and sections in a variety of 
formats, as we explain in “Printing, Publishing, and Sharing Notes” on page 566.

Filling a Notebook with Text, Pictures, Clippings, 
and More

Every time you type, paste, or otherwise insert a new item on a notebook page, OneNote 
creates a note container for that item. Note containers can hold text, pictures, audio and 
video clips, handwriting, and clippings from a web page or from the screen. The initial size 
of the container matches the size of the object you’re creating or inserting; if you click 
and begin typing, a new note container is created immediately and explands in width and 
depth to accommodate your input.

Note containers are normally invisible. To see the container, move the mouse pointer over 
its contents, click to select the contents, or position the insertion point within the container. 
Figure 15-4 shows a note container, with the pointer positioned over the Move handle at 
the top. Click and drag the handle to move the container and its contents to a new position 
on the page. Click the Move handle to select the entire container so that you can cut, copy, 
or delete it and its contents. Click the sizing handle in the upper right corner to make the 
container wider.

We can’t understand why anyone would want to hide note containers permanently, but 
if you do, there’s an option for that: click File, and then click Options. On the Display tab, 
clear Show Note Containers On Pages.

INSIDE OUT  �
Merge or split note containers 

If you’ve typed or pasted text into separate containers on the same page, how do you 
merge them into a single container? Simple: click the Move handle on the second con-
tainer to select its entire contents. Then, hold down the Shift key as you drag that con-
tainer into the first one. When you see the contents of the second container snap into 
position in the first container, release the Shift key. To split text in a single container 
into two discrete containers, select the text you want to move into a new container and 
drag it outside the original container. When you release the mouse button, OneNote 
creates a new container, which you can then work with independently.
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Move handle              Note container

Figure 15-4  Click and drag the Move handle at the top of a note container (shown by the four-
headed arrow here) to reposition the container and its contents on the page.

In the remainder of this section, we discuss the specifics of how to work with different types 
of content that you enter directly or paste from the Clipboard—text, pictures, equations, 
and ink, for example. But you can also send items directly to OneNote by using the Screen 
Clipping tool and Send To options in Outlook and Internet Explorer. When you send a web 
clipping, a screen clipping, or an Outlook item to OneNote, you see a dialog box like the 
one shown in Figure 15-5. If you choose a section from any open notebook, the item is sent 
to a new page in that notebook; you can also choose a specific page within a notebook and 
send the item to that page, where it’s placed at the bottom of the page, below any existing 
content.
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Figure 15-5  When you send an item or a clipping from another program to OneNote, you can 
specify the destination page or section here.

Text

Entering text from the keyboard is the simplest (and probably the most common) way to 
fill a notebook. Click to position the insertion point on the page, and start typing. (You can 
also paste text into a page, with or without formatting.) The text you enter or paste appears 
in a single note container.

OneNote supports basic outlining functions for text. Press Enter to create a new paragraph, 
and then change the outline level for that paragraph by pressing Tab (or Shift+Tab to pro-
mote a paragraph to a higher level.)

You can move any paragraph up or down or adjust its outline level by dragging it. You can 
also use keyboard shortcuts: press Alt+Shift and then use the Up or Down Arrow key to 
move the paragraph up or down in the outline; use Alt+Shift and the Right or Left Arrow 
key to demote or promote a paragraph in the outline. When you move the mouse pointer 
over a paragraph, a Move button appears to its left. Move the mouse pointer over the but-
ton, and the pointer turns to a four-headed arrow; click to select the entire paragraph and 
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move it up, down, left, or right. In the example shown here, the mouse pointer is to the 
right of “Christopher Marlowe,” so the Move button appears to the left of that line.

INSIDE OUT  �
Add a date and time stamp to any text

At the top of every notebook page is a title, and beneath the title is a date/time stamp 
that shows when you created that notebook page. If you use a notebook page to col-
lect random thoughts over a period of weeks or months, you might want to stamp 
individual note containers with the date and time. The secret? Before you begin typing 
a new note, right-click at the point where you want the text to appear. At the bottom of 
the shortcut menu, click the menu option that lists your name and the current date and 
time. That information appears as the first line in a new note container, ready for you 
to begin adding your text. To insert just the current date, use the keyboard shortcut 
Alt+Shift+D. To insert the current time, press Alt+Shift+T. To insert both the date and 
time (without your name), press Alt+Shift+F.

Lists

You can format any text on a OneNote page as a list using bullets or numbering. List for-
matting applies to the current paragraph or, if multiple paragraphs are selected, to all para-
graphs in the selection. If you’ve used list formatting in Word or PowerPoint, you already 
understand the basics. OneNote adds a few twists to simple lists.
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To choose a bullet character and immediately apply it to the current paragraph or selection, 
click the arrow next to the Bullets button (on the Mini toolbar or in the Basic Text group on 
the Home tab). The selection of characters in the Bullet Library (shown here) is fixed and 
cannot be customized.

To format the current paragraph or selection with the most recently used bullet character, 
click the Bullets button or use the Ctrl+period keyboard shortcut. To automatically add a 
standard bullet character (a big black dot) at the beginning of the current line, enter an 
asterisk at the beginning of the paragraph.

Numbered lists work in similar fashion. To begin a simple numbered list, start with a 
number or letter followed by a period, a closing parenthesis, or a hyphen; then press the 
Spacebar. You can choose from an assortment of ready-made numbering and outline for-
mats using the Numbering Library (shown next), which is available by clicking the arrow to 
the right of the Numbering button on the Mini toolbar or in the Basic Text group on the 
Home tab.



Chapter 15

500	 Chapter 15  Inside OneNote 2010

As with automatic list formatting in other Office programs, pressing Enter continues the list 
formatting in the next paragraph. To end automatic formatting, press Enter twice.

For more details on list-formatting techniques used in Word, see “Working with Bulleted and 
Numbered Lists” on page 240. For instructions on customizing numbered lists, see “Our Favorite 
OneNote Tweaks and Tips” on page 572.

Tables

You can add a simple table to any page in OneNote, using its rows and columns to arrange 
data that doesn’t lend itself to simple paragraphs. OneNote tables offer a basic set of 
features and formatting options, far simpler than those found in Word or PowerPoint. 
When the insertion point is within a table, OneNote makes a custom Layout tab available, 
as shown in Figure 15-6. (The same options are also available if you right-click anywhere 
within the table.)
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Figure 15-6  The Layout tab allows you to arrange rows, columns, and cells in a OneNote table 
and align their contents.

To create a table, use any of the following techniques:

●● On the Insert tab, click Table and drag the grid to select the number of rows and col-
umns you want.

●● Click Insert Table at the bottom of the Table menu and select the number of rows and 
columns from a dialog box.

●● Easiest of all, create a table automatically by typing the text you want to appear in 
the first cell of the first row, and then press Tab. Continue pressing Tab to create new 
columns, with or without text, and press Enter to begin a new row.

For more details on how to create and use tables in Word, see “Working with Tables” on 
page 253.
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If you use OneNote tables regularly, you can save some time by learning a few keyboard 
shortcuts in addition to the Tab and Enter keys. To create a new column to the left or 
right of the current column, press Ctrl+Alt+E or Ctrl+Alt+R, respectively. To create a new 
row below the current one, even if the insertion point is in the middle of the row, press 
Ctrl+Enter. To create a new row above the current one, move the insertion point to the 
beginning of the row and press Enter. To begin a new paragraph in the same cell, press 
Alt+Enter.

Pictures

Pictures fit nicely in OneNote pages, either alone or accompanied by text. To add a picture 
to a OneNote page, you can paste it from the Clipboard or click Picture on the Insert tab 
and then choose an image file.

What happens next depends on the destination you select. If you choose an empty page 
as the target for the paste, OneNote drops the picture into a note container, resizing the 
image if necessary so that its height is under 400 pixels, with the insertion point positioned 
just below the picture, awaiting your caption. If you insert another picture, it appears in the 
current note container at the insertion point. However, if you click an empty space, outside 
a note container, and then insert a picture into a page that already contains at least one 
item, the pasted picture appears at its original size with no note container. In either case, 
you can resize the image using handles on the bottom and right sides; use the handle on 
the lower right corner to preserve the picture’s aspect ratio. To resize any image to the full 
dimensions of the original file, right-click the picture and then click Restore To Original Size.

For a complete picture of how to work with photos and illustrations in Office 2010, see Chap-
ter 6, “Working with Graphics and Pictures.”

OneNote treats each picture as if it were a paragraph, so you can move it up and down 
with text (or other pictures) in a note container. You can also paste or move a picture into 
a table, as we’ve done in Figure 15-7. After you insert the first image and resize it to fit the 
column width and row height, pictures you paste into other cells are scaled accordingly.

OneNote can recognize text in pictures and use that text for searches; we explain how this 
works in “Our Favorite OneNote Tweaks and Tips” on page 572.

Web Clippings

OneNote and Internet Explorer work exceptionally well together. As you browse, you can 
collect snippets of text, images, or entire pages for insertion into a notebook page. The 
mechanics are simple: make a selection (skip this step if you want to save the entire page) 
and then click the Send To OneNote button on Internet Explorer’s Command bar. Alter-
natively, you can right-click a selection or an entire page and then click Send To OneNote 
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from the bottom of the shortcut menu. Choosing this option opens the Select Location In 
OneNote dialog box, where you can specify a section or page as the destination. 

Figure 15-7  You can insert pictures into a table on a OneNote page. After you scale the first 
image, OneNote handles the remaining images.

TROUBLESHOOTING
A web page doesn’t look right when you send it to OneNote

Although the process of sending a web page to OneNote is easy, the results are not 
always what you’d expect. In particular, heavily formatted web pages often translate 
poorly onto a OneNote page, with text flowing in an unreadable fashion and tables 
rearranged haphazardly. If that happens, click the Undo button and try either of these 
approaches. 

●● Select the most important portions of the web page and try to send them indi-
vidually to your OneNote page. You’ll lose the overall design, but that might not 
matter if you’re mostly concerned with content.

●● Use the Send To OneNote 2010 option on Internet Explorer’s Print menu to send 
the entire page or a selection to OneNote as an image. You lose the ability to 
copy or edit text on the resulting item, but you are certain to get an accurate 
(and readable) representation of the page.



Chapter 15

504	 Chapter 15  Inside OneNote 2010

If you use a browser other than Internet Explorer, your best option is to select all or part of 
a web page, copy the selection to the Clipboard, and paste the result into OneNote.

Regardless of the method you choose, OneNote adds a link to the source web page at the 
end of the item, making it easy to revisit the source when you review your research later.

Screen Clippings

Other Office programs allow you to copy and paste a screen shot from any open window. 
OneNote offers a more limited Screen Clipping version of that feature.

For full details on how to use screen shots and screen clippings in Office 2010, see “Capturing 
and Inserting Screenshots” on page 174. To learn how to customize this feature in OneNote, see 
“Our Favorite OneNote Tweaks and Tips” on page 572.

As with the other Office programs, you can use the ribbon to kick off the process: click 
Screen Clipping on the Insert tab to select a portion of any window to automatically copy 
and paste into OneNote at the current insertion point. When you use this option, OneNote 
temporarily minimizes itself so that you have full access to the rest of the screen; just make 
sure the window from which you want to clip is visible behind OneNote. Your selection is 
inserted in the current page at the current insertion point.

Unlike the other Office programs, you can use the Create Screen Clipping keyboard short-
cut, Windows logo key+S, to capture a portion of the screen, even if OneNote isn’t run-
ning. (If OneNote is open, the OneNote window remains visible on the screen, allowing 
you to capture a clipping from one page and paste it in another.) After you use this option, 
OneNote displays a variation of the Select Location In OneNote dialog box, shown in Fig-
ure 15-8. You can choose a OneNote section or page or use the Copy To Clipboard button 
to save your selection and use it in another program.

Every screen clipping you add to a page is tagged with the date and time it was taken; if 
the source is a web page, the tag includes the page name and URL.

Ink

Your keyboard and mouse aren’t the only way to put stuff on a OneNote page. The Draw 
tab includes a full gallery of pens (shown in Figure 15-9) that you can use to draw, write, 
and highlight information on a page.
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Figure 15-8  Use the Create Screen Clipping shortcut (Windows logo key+S) to copy part of a 
screen and paste it into OneNote or save it to the Clipboard.

Figure 15-9  Fine-point pens work best for handwriting. The thick markers on the bottom row 
are ideal for highlighting text.
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If none of the built-in pens are quite right, you can customize pens and highlighters, choos-
ing from a variety of colors and thicknesses.

When you select a pen from the Tools group on the Draw tab, the pointer changes to a 
colored dot or brush whose color and thickness match the pen you selected. Use the pen to 
draw or write in an unused area of the page, and your ink is captured in a container, where 
it moves along with any text or graphics in the container. If you use a highlighter, your 
markup is treated as a discrete drawing and does not move when you move the text. (To 
highlight text, use the Highlighter button in the Basic Text group on the Home tab, as we 
describe in “Formatting Text” on page 508.)

To switch from pen mode back to mouse/keyboard interaction, click the Select & Type but-
ton at the left of the Draw tab.

If you intend to take handwritten notes or create anything more interesting than stick fig-
ures, you’ll need a Tablet PC, a touch-enabled PC, or a digitizer and stylus. Although you 
can add ink using a mouse, the results are rarely satisfactory, especially for handwriting 
recognition. One noteworthy exception is the set of thick fluorescent-colored highlighters, 
which work well for marking up printouts.

For more details about how to use ink with Office programs, see “Drawing with Ink” on 
page 183.

Equations

Engineers and math majors can use the Equation menu on the Insert tab to create valid, 
editable math equations in OneNote. The tools are identical to those available in other 
Office applications.

For an overview of math-related features, see “Entering Mathematical Equations” on page 120.

E-Mail Messages and Other Outlook Items

If you use Outlook, you’ll find a Send To OneNote button (in the Move group on the Home 
tab) when you’re viewing a mail message in the message list or in a message window. Click 
that button to send the entire message to OneNote, with the message header (Subject, 
From, To, and Sent date) in a table and the text of the message itself just below the header.

If you select an Outlook appointment, meeting, task, or contact, you’ll see a Linked Item 
Notes button (where Item is the item type) with a slightly different button image. Clicking 
this button allows you to send relevant details from the current item to a OneNote page 
with a link back to the original item. (If you’ve already created the item in OneNote, click-
ing this button returns you to that page.) A Notes section at the bottom of the item allows 
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you to enter additional text. You can use this feature to keep notes about a meeting or to 
record details of your history with a contact, as shown here.

You can create new linked items in Outlook directly from OneNote as well. We discuss the 
tight connections between the two programs in “Using OneNote with Outlook” on page 547.

File Attachments

You’ll find an Attach File button in the Files group on the Insert tab. When you click that 
button and select a file from the Browse dialog box, OneNote embeds the selected file and 
displays its icon and name on the page. The file attachment is an independent copy, not 
linked to the original file in any way. Changes you make to the original file are not reflected 
in the OneNote attachment, and vice versa.

Attaching a file to a notebook is a good strategy when you want to preserve the file for 
historical purposes with your notes, or you want to make sure it’s always available with the 
notebook, even if it’s deleted from the file system or e-mail message from which it origi-
nated. For a document that you want to continue editing, especially with other members 
of a team, the preferred strategy is to create a link in OneNote to a file stored in a shared 
network folder or in Windows Live SkyDrive.

For more details about creating links to files, see “Using Links for Quick Connections” on 
page 530.

Printouts

During installation, OneNote adds a virtual printer to your Windows Devices And Printers 
folder. When you choose this “printer” as the output from any program (including a web 
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browser or another Office application), OneNote creates an image of the file as it would 
appear on paper and inserts that printout on a page you select. You can also create a print-
out from a file or use the output from a scanner—both options are available in the Files 
group on the Insert tab. Use this if you want to preserve the formatting of an original docu-
ment or web page.

There’s a subtle but significant difference between the two techniques for adding a print-
out to a OneNote page. If you use the virtual Send To OneNote 2010 printer, your printout 
appears on the page you select, without any links to the original document. In addition, 
you can choose which page (or pages) you want to include on the OneNote page. When 
you click File Printout on the Insert tab and select the same file, OneNote adds the selected 
file to the current page as an attachment, with a link to the location of the original docu-
ment. It then opens the associated program in the background, creates the printout, and 
inserts the printout below the file attachment.

Formatting Text
Regardless of its original source, any text on a OneNote page can be formatted using the 
same tools you use elsewhere in Office. The Basic Text group on the Home tab contains 
common formatting options, giving you the capability to select a font, change font size and 
color, and add character attributes such as bold, italic, underline, and strikethrough format-
ting. You’ll also find the Format Painter button on the Home tab, in the Clipboard group. 
Most of these options are available on the Mini toolbar as well.

For an overview of common text formatting techniques in Office 2010, see “Applying Text 
Formatting” on page 123.

As in Word and PowerPoint, you can apply some character formatting without making 
a selection first. If the insertion point is in a word, for example, and you press Ctrl+B or 
Ctrl+I (or click the Bold or Italic button), your formatting is applied to the entire word. To 
apply formatting to a phrase or sentence, you have to select the text first. One formatting 
shortcut you’ll find only in OneNote is a toggle to apply or remove strikeout formatting: 
Ctrl+hyphen.

The Ctrl+A (Select All) keyboard shortcut works a bit differently in OneNote than it does 
in the rest of Office. If the insertion point is within a paragraph, pressing Ctrl+A selects the 
entire paragraph. Press Ctrl+A again to select the entire contents of the current note con-
tainer, and press the combination once more to select the contents of all note containers 
on the current page.

If you’ve used indenting to create an outline, you can select the current paragraph and all 
its subordinate paragraphs by using the keyboard shortcut Ctrl+Shift+hyphen.
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Unlike previous versions, OneNote 2010 allows you to automatically select from a small 
group of ready-made styles to apply to text. The list, shown here, includes six heading styles 
as well as predefined styles for page titles and some common types of body text.

Styles on this list are applied to all text in the current paragraph, regardless of whether any 
text is selected. In addition, Word users will appreciate that some common style-related 
keyboard shortcuts work just as well in OneNote. Use Ctrl+Alt+1 through Ctrl+Alt+6 to 
apply the Heading 1 through Heading 6 styles, and use Ctrl+Shift+N to quickly convert all 
formatting for the current paragraph to the built-in Normal style.

There’s no keyboard shortcut for the built-in Page Title style, but it’s worth noting that 
Ctrl+Shift+T jumps to the page title and selects all text there. You can apply any text for-
matting to all or part of a page title; if you are unhappy with the results, reapply the Page 
Title style.

The bad news about OneNote styles is that the formatting associated with this list cannot 
be customized, nor can you add your own styles to the list.

INSIDE OUT  �
Apply highlighting quickly

If you want portions of text on a page to stand out, use the Text Highlight Color button 
to apply a fluorescent yellow background (use the drop-down arrow to choose a differ-
ent color). You can also use either of two keyboard shortcuts to highlight the current 
selection using the last color you selected: Ctrl+Alt+H or Ctrl+Shift+H. Note that this 
highlight applies formatting to the text itself and is not the same as the highlighter pen 
we describe in “Ink” on page 504. That pen creates a graphic image of the highlighter ink 
that can be used over a printout, a picture, or text.
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Navigating in OneNote
At the beginning of this chapter, we described the basic organization of OneNote, which 
consists of pages arranged into sections within notebooks. You don’t need us to tell you 
how to use the basic navigation tools—section tabs along the left and top of the page con-
tents, page tabs on the right. In this chapter, we focus on some of the more subtle naviga-
tion elements, especially keyboard shortcuts and hidden tricks that you’ll value when your 
collection of notebooks grows too big to simply scan.

The best navigation assistant of all is OneNote’s search box, which we discuss in detail in 
“Smart Search Strategies” on page 534. 

INSIDE OUT  �
Zoom in for a closer look

Most programs in the Office family include a status bar that offers, among other tools, 
a slider to zoom in on or out from the current page. OneNote lacks a status bar, but 
that doesn’t mean it’s lacking in the zoom department. The Zoom group on the View 
tab includes a list of preset zoom settings that range from 25% to 200%. Alternatively, 
you can use the Zoom In and Zoom Out buttons, which increase or decrease the zoom 
level in discrete steps from 11% to 477%. The keyboard equivalents are Ctrl+Alt+plus 
sign/minus sign (on the numeric keypad) or Ctrl+Alt+Shift+plus sign/hyphen (to the 
right of the numbers on the main keyboard).

Opening and Moving Between Notebooks

Every open notebook has an entry in the Navigation bar. The icon to the left of the display 
name provides clues about the notebook’s status and its location: a notebook with its cov-
ers open indicates which notebook you’re currently working with, and separate icons dif-
ferentiate locally stored notebooks from those that are stored in a shared folder and synced 
to a local copy.

For more details on how notebook syncing works, see “Sharing and Synchronizing Note-
books” on page 561.

Normally, clicking a section in another notebook replaces the page shown in the contents 
pane with the most recently opened page in the new section. If you want to open a second 
notebook without losing your place in the current one, switch to the View tab and click the 
New Window option on the Window menu (or use the keyboard shortcut Ctrl+M). If you’re 
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using Windows 7, you can open a new OneNote window by holding down Shift as you click 
the OneNote taskbar icon.

If you prefer keyboard navigation to mouse clicks, here’s how to switch to a different open 
notebook. Press Ctrl+G to move the focus to the first open notebook on the Navigation 
bar. Press Tab to move down the list of open notebooks (use Shift+Tab if you go too far and 
want to move back). When you see the selection highlight on the notebook you want to 
open, press Enter.

Working with Sections and Section Groups

OneNote displays the names of all sections for all open notebooks in the Navigation bar. 
(Click the up arrow to the right of the display name to collapse the list of sections for a 
notebook; click the down arrow to show the contents of a previously collapsed list.) You can 
also see a list of section tabs for the current notebook along the top of the contents pane. 
Click a tab to switch immediately to that section. To move quickly between sections in the 
current notebook, in order, press Ctrl+Tab (use Ctrl+Shift+Tab to move through the sec-
tions in reverse order).

The simplest way to create a new section in the current notebook is to click the Create A 
New Section button (the asterisk) at the rightmost edge of the section tabs at the top of 
the contents pane. Alternatively, you can use the Ctrl+T keyboard shortcut. In either case, 
the new section’s default name (New Section 1, for example), is selected so you can start 
typing immediately to replace it with a descriptive name. To rename a section, double-click 
its tab and begin typing.

New sections are automatically added to the bottom of the section tabs list. To change the 
order of sections, drag tabs up or down. You can also drag sections out of one notebook 
and into another to move them. Hold down the Ctrl key as you drag a section to make a 
copy in another notebook. If you prefer using dialog boxes for move and copy operations, 
right-click the section name and choose Move Or Copy from the shortcut menu. Choose a 
section from the list of open notebooks, as shown in Figure 15-10, and then click Move or 
Copy to complete the operation.

You can also combine the contents of two sections using the Merge Into Another Section 
option on the right-click shortcut menu. Choosing this option has the same effect as mov-
ing all pages out of the first section and into the second one and then deleting the first 
section.



Chapter 15

512	 Chapter 15  Inside OneNote 2010

Figure 15-10  To move or copy a section, use this dialog box. You might need to click the plus 
sign to the left of a notebook name to see its list of sections.

If the number of sections within a notebook starts to become unmanageable, the easy 
solution is to create one or more section groups. The advantage of section groups is that 
they can be collapsed and expanded in the Navigation bar. Although you can manually 
adjust the order of section groups by dragging them in the section tabs list, section groups 
always appear after sections that are not part of a group, as shown here.
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To create a section group, right-click the notebook name and then click New Section 
Group. Give the new section group a descriptive name and drag sections into it (or create 
new sections). Note that section groups can be nested within other section groups.

There’s nothing magical about section groups. They’re actually nothing more than subfold-
ers within the folder that contains the notebook. Creating a section group creates a new 
subfolder, and moving sections to that section group moves the corresponding OneNote 
Section files (with the .one file name extension) to that new subfolder.

Working with Pages

The techniques for working with pages are similar to those for working with sections. If you 
right-click any page name in the page tabs bar, you can use options on the shortcut menu 
to create a new page, delete the selected page, cut or copy the current page to the Clip-
board, or paste a page from the Clipboard to the current section.

To move quickly between pages in the current section, use the keyboard shortcut Ctrl+Page 
Up (use Ctrl+Page Down to move through all pages in reverse order). To jump to the first 
or last page in the currently visible set of page tabs, press Alt+Page Up or Alt+Page Down, 
respectively. 

To rename a page, select the page title box and adjust the text there. You cannot directly 
edit the title text shown on a page tab.

To change the order of pages in a section, drag the page tabs up or down in the page tabs 
bar, or use the keyboard shortcuts Alt+Shift+Up Arrow/Down Arrow. To move a page to 
a different section in the same or another notebook, drag the page to the Navigation bar 
and drop it on a section tab. (Hold down Ctrl while dragging to create a copy and leave the 
original page intact.) You can also right-click any page and choose Move Or Copy (or use 
the keyboard shortcut Ctrl+Alt+M) to choose a destination from a dialog box.

Selecting a page involves a few subtle techniques that can be confusing at first. For exam-
ple, if you click a page tab, the focus shifts to that page, and the insertion point appears on 
the page at the point where it appeared when you last edited the page. If you’re picking 
up where you left off with a set of meeting minutes or research notes, you can simply start 
typing. If you click that page icon a second time (or use the Ctrl+Shift+A keyboard short-
cut), the entire page is selected, as indicated by a thick blue border around the page in the 
contents pane. You’re then free to cut or copy the page to the Clipboard or press Delete to 
send it to the OneNote Recycle Bin.

To create a new, blank page, click the New Page button at the top of the page tabs bar, or 
use the keyboard shortcut Ctrl+N. In either case, your page is added at the end of the cur-
rent list of page tabs. To add a new page just below a specific page, click its page tab and 
press Ctrl+Alt+N. To create a new page at a specific location using the mouse, move the 
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mouse pointer up and down the page tabs bar. As you do so, you’ll see a small new-page 
icon and a small black arrow alongside the page tabs bar. When that arrow points to the 
location where you want to add the new page, as shown here, click the page icon.

Navigating on a page is a straightforward process, with one twist. Although every page 
has a paper size assigned to it for printing purposes, pages aren’t restricted to a fixed size; 
instead, they expand as needed, in both width and depth, to fit the content you add. If you 
plan to add a significant amount of new content in a specific location, you can manually 
add space to a page. Click the Insert Space button at the left of the Insert tab, and then 
move the mouse pointer over the page. As you move up or down, the pointer changes to a 
two-headed arrow. When you reach the spot where you want to add space, click and drag 
in the direction you want. A large blue arrow, similar to the one in Figure 15-11, shows you 
the dimensions of the new space you’re about to add, with a ghosted image of any existing 
note containers appearing in their new position.

You can also use the Insert Space button to add space at the left side of a page (click in the 
left margin and drag to the right) or to remove unwanted white space from a page (click 
and drag up or drag from the right margin to the left).

When editing a page, you can use any of the following shortcuts:

●● To scroll up or down in the current page, press Page Up or Page Down.

●● To move to the top of the current page, press Ctrl+Home. To move to the bottom of 
the note container that’s lowest on the page, press Ctrl+End.

●● To move down the page, from one note container to the next, press Alt+Down Arrow.
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Figure 15-11  Click Insert Space and drag down to add new space above an existing note 
container.

As in OneNote 2007, you can create subpages that are indented beneath a main page. For 
notebooks saved in OneNote 2010 format, these subpages are linked to the main page. 
The group can be collapsed or expanded and can be selected and moved or copied as a 
group. To create a new subpage below the current page, press Ctrl+Alt+Shift+N

To increase or decrease the indent level of the current page tab (or a group of adjacent 
page tabs), click and drag right or left, or right-click and use the shortcut menu options 
Make Subpage and Promote Subpage. You can also use the keyboard shortcuts Ctrl+Alt+] 
(right bracket) and Ctrl+Alt+[ (left bracket) to increase or decrease the indent.

Using the OneNote Recycle Bin

When you delete a page or section from OneNote, the object doesn’t actually disappear for 
good. Instead, OneNote moves the object to that notebook’s Recycle Bin. The Recycle Bin, a 
new feature in OneNote 2010, is stored in a special folder called OneNote_RecycleBin. This 
folder is added to every notebook you create using the OneNote 2010 file format; if you 
convert a notebook to OneNote 2007 format, this folder is deleted immediately.
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When you delete a section from a notebook, the entire section file is moved to the One-
Note_RecycleBin folder. When you delete one or more pages, those pages are moved to 
the OneNote_DeletedPages file, which is stored in OneNote Section format in the One-
Note_RecycleBin folder. To recover deleted pages or sections, right-click the notebook icon 
in the Navigation bar, and then click Notebook Recycle Bin. In this read-only notebook, 
you’ll see all pages and sections you’ve deleted in the past 60 days. (An information bar 
appears at the top of the contents pane to alert you that you’re working in the Recycle Bin.)

Figure 15-12 shows the Recycle Bin folder for the Travel notebook. It contains two deleted 
sections (Czech Republic and Vacation Research) and an indeterminate number of pages 
in the Deleted Pages section. Note the Read-Only label in the title bar and the information 
bar that indicates you’re working in the Recycle Bin.

Figure 15-12  To restore a previously deleted section or page, right-click the section tab (above 
the contents pane) or the page tab, click the Move Or Copy option, and select a destination.

Customizing the Look and Feel of a Notebook Page
By default, every new OneNote page starts out with a bland white background and no 
adornment. You can change the appearance of a page in a variety of ways—some for 
purely aesthetic reasons and others, such as rule lines, for practical effect. In this section, we 
discuss the main customizations you can apply to a page.
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OneNote 2010 includes an assortment of templates that incorporate many of the customiza-
tions we discuss in this section, and you can save your own templates as well. For details, see 
“Saving and Using Custom Page Templates” on page 575.

Page Title

The page title box appears at the top of every page in a fixed location, with a date and time 
stamp below it that (initially, at least) indicates when the page was created. Any text you 
enter as the title on the page is also used as a label on the page tab.

As far as we’ve been able to determine, there’s no technical limit on the number of char-
acters you can include in a title. From a practical standpoint, however, shorter is better; 
remember that the main purpose of a title is to provide a label in the page tabs bar.

By default, all page titles are formatted as 17-point Calibri. You can change the font, font 
size, and color of a title. You can also add hyperlinks, tags, and just about any other type of 
formatting that’s applicable to text. This sort of custom formatting might be useful if you 
intend to print a notebook page or save it as a PDF file for sharing; just remember that the 
page tab label does not reflect any formatting.

You can’t change the position of the date/time stamp just below the page title, nor can you 
add your own text to it. You can, however, change the date and time. This option is useful 
if, for example, you create a page in advance of a meeting so that you can keep minutes 
and want the date and time stamp to reflect the actual starting time. Click the date field 
to expose a calendar control (like the one shown here) and choose a date. Click the time 
stamp and use the clock control to choose a new time. Use the Today button to insert 
today’s date from the calendar. The clock control initially displays the current system time; 
the list of available alternate times is limited to round values, on the hour and half-hour.

For some pages, such as those that include design sketches or diagrams, you might prefer 
to have no title. In addition, any Side Notes you create are added to the Unfiled Notes 
folder with no title. Click Hide Page Title (in the Page Setup group on the View tab) to 
remove the existing title and date/time stamp and hide the page title box.
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CAUTION!
Don’t be misled by the wording of the Hide Page Title button. When you click that 
button, it permanently deletes the current contents of the page title box and replaces 
the page tab label with the first recognizable text on the page. If you want to keep the 
page tab label, copy the page title to the top of the page before “hiding” the title.

We discuss the best way to use the Unfiled Notes section in “Expert Organizational Tech-
niques” on page 542.

Page Color

The default background color for every notebook page is white. You can adjust this color to 
one of 15 pastel alternatives using the Page Color menu on the View tab, as shown here.

To remove the background color from an existing page, click the No Color button at the 
bottom of the Page Color menu.

Rule Lines

Adding rules or grid lines to a page can help with a variety of note taking and drawing 
tasks. To add a default set of rule lines (including a vertical red line in the left margin, just 
like the one on a yellow legal pad), click the Rule Lines button on the View tab. You can 
change the default lines by clicking the down arrow and selecting from an assortment of 
rules and grid sizes on the Rule Lines menu.
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To adjust the color of rule lines from their default light blue to one of 17 alternatives, use 
the Rule Line Color list on the Rule Lines menu.

You can show or hide rule lines as needed for a specific task. If you’re using a Tablet PC to 
take notes, for example, you might use rule lines to help keep your notes from creeping up 
or down the page and then hide them for reviewing later. Likewise, you can use grid lines 
to initially position images on the page. To toggle the display of rule or grid lines using the 
keyboard, press Ctrl+Shift+R.

If you prefer to use rule lines for all new pages, you can choose a set of rule or grid lines 
and then set it as the default. The easy way to accomplish this task is to click Create New 
Pages With Rule Lines at the bottom of the Rule Lines menu. This has the same effect as 
selecting Create All New Pages With Rule Lines on the Display tab in the OneNote Options 
dialog box.

Background Image

In addition to background colors, you can choose a single image to use as the background 
of a page. This option works best with an image that has been specifically created (or 
edited) for use as a page background. The ideal image has strong elements limited to the 
top and left margins and soft or faded image elements in the body of the page, where they 
won’t adversely affect readability of the page contents.

For examples of pages that use background images effectively, see the discussion of page 
templates in “Our Favorite OneNote Tweaks and Tips” on page 572.

To add a background image, first insert the image on the page and position the picture 
in the upper left corner, making certain it is not enclosed in a note container. Then right-
click the image and choose Set Picture As Background. To remove a background image, 
first clear the Set Picture As Background option, click to select the picture, and then press 
Delete.
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Paper Size and Margins

The Paper Size setting for a default OneNote page is Auto, which means it can expand in 
any direction with no limits. That’s fine if you’re planning to use a notebook for strictly digi-
tal purposes. However, if you intend to print one or more pages, you’ll want to define paper 
sizes and margins that match the paper and printer you plan to use.

OneNote includes 14 predefined paper sizes as well as a Custom option that allows you 
to specify your own dimensions. To edit these settings for an existing page, click the Paper 
Size button on the View tab. That opens the Paper Size pane on the right side of the page. 
In Figure 15-13, we’ve used the Index Card setting to mimic a standard 3-by-5-inch index 
card; to enhance the effect, we’ve hidden the page title and added rule lines.

Figure 15-13  These settings allow a OneNote page to mimic a standard 3x5 index card. Save the 
page as a template to reuse it on new notebook pages.

Personalizing the OneNote Interface
You can customize OneNote’s user interface by using the same tools available in the other 
Office 2010 programs, notably the options to fine-tune the ribbon and the Quick Access 
Toolbar.
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For step-by-step instructions on how to customize these common Office interface features, 
see “Personalizing the Ribbon” on page 57, and “Customizing the Quick Access Toolbar” on 
page 62.

The most useful set of personalization options for OneNote reflect the common desire to 
hide clutter and maximize the workspace as much as possible. This is particularly impor-
tant when you’re typing class notes or meeting minutes on a notebook or netbook, where 
screen real estate is severely limited. In that scenario, where access to other pages and sec-
tions isn’t necessary, the quickest path to a clean workspace is the F11 key, which toggles 
Full Page view (there’s also a Full Page View button on the View tab and on the Quick 
Access Toolbar). In Full Page view, section tabs and page tabs are completely hidden, the 
ribbon is minimized to just tab headings, and the Quick Access Toolbar remains visible. To 
toggle back to Normal view, press F11 again. (You can also click the Full Page View button 
on the Quick Access Toolbar or click the View tab to make its contents visible and then click 
Normal View.)

For a less drastic solution, you can collapse the Navigation bar and page tabs bar. Click the 
Collapse Navigation Bar arrow to the right of the Notebooks heading and the matching 
Collapse Page Tabs arrow to the right of the New Page button above the page tabs bar. 
With both elements collapsed, the main OneNote window looks like the example shown 
in Figure 15-14. Note that the section tabs list is invisible and the list of open notebooks is 
turned on its side. The page tabs bar is still visible, but it’s reduced to its absolute minimum 
width.

Expand Navigation Bar                                                              Expand Page Tabs

Figure 15-14  Click the arrow at the bottom of the Navigation bar to see additional open note-
books. Use ScreenTips to identify page names and notebook locations.
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To restore the Navigation bar and the page tabs bar to their normal widths, click the 
Expand Navigation Bar shortcut (the arrow just above the first notebook name) and the 
Expand Page Tabs arrow above the shrunken page tabs bar. In their expanded form, you 
can adjust the width of either element so that they use less space on a notebook computer 
or take advantage of the extra desktop real estate on a large monitor. Aim the mouse at the 
border between either element and the contents pane until the pointer turns into a two-
headed arrow, then drag in either direction to widen or narrow the Navigation bar or page 
tabs bar.

The other personalization options available for the main OneNote interface allow you to 
change on which side of the screen the Navigation bar, the page tabs bar, and the vertical 
scroll bar appear. Some OneNote users find it easier to navigate, for example, by moving 
the page tabs bar to the left side so that the contents of a section appear next to the sec-
tion tab itself. To adjust this setting, open the OneNote Options dialog box (click File, and 
then click Options), click the Display tab, and select Page Tabs Appear On The Left.

The other significant personalization option involves the OneNote icon in the notification 
area. We discuss its settings in more detail in “Customizing the OneNote Taskbar Icon” on 
page 573.
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Symbols and Numbers
& (ampersands), 360, 400, 467–468
* (asterisks), 211, 358, 463
@ (at signs), 397
\ (backslashes), 463
[ ] (brackets), 397, 463, 854
^ (carets), 358
, (commas), 361, 461
: (colons), 276, 361, 381, 745
$ (dollar signs), 361–363
= (equal signs), 359, 745
/ (forward slashes), 358
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? (question marks), 211
_ (underscores), 463
3-D effects in charts, 429, 432, 436, 439
3-D graphic rotation, 167–168, 178
32-bit and 64-bit editions, 22–23, 39
100% stacked column charts, 429, 431–432

A
Above Average filtering, 403
ABOVE range (Word table formulas), 261
absolute references in worksheets, 361–363
.accdb or .accde file extensions, 80
accelerator keys, 72. See also keyboard shortcuts
accepting

changes to files, 287–289, 664, 830–831
meetings, 781

Access databases, 416
access to files, restrictions, 46, 298. See also permissions
accessibility issues, 295

account setup for Outlook, 707
accounting worksheet cell format, 380–381
.acl file extension, 118
ACOS worksheet function, 373
ACOSH worksheet function, 373
action buttons (presentations), 675–679
actions, Quick Step, 760, 761
activating Office, 35–37
active worksheets, printing, 470
ActiveX controls, 818
Add A Digital Signature option, 299
Add New Account dialog box, 707
add-ins

managing, 53
preventing harm from, 818
security settings, 825
Silverlight, 853
Windows Desktop Search, 534

Add-Ins tab, 53
Address Book, 767–770
address searches, 750
administrators for SharePoint sites, 863
Adobe Acrobat, 595
Adobe Reader, 595
Advanced Settings dialog box (SharePoint), 872
Advanced tab (Backstage view), 69
Advanced tab (ribbon), 70
advancing slides, 635
agenda slides, 675
alerts. See also notifications

e-mail messages, 764
SharePoint activities, 880–882

aligning
Excel cell text, 459
graphic objects, 155–156
numbers in Word documents, 311
objects on presentation slides, 603
shapes, 176
text formatting, 125, 126
text in Word tables, 262
Word tables, 267

all caps text, 217
All Slides dialog box, 636
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alphabetical sorting. See sorting
always-on locations, 564
AM indicator, 462
ampersands (&), 360, 400, 467–468
AND searches, 535, 536, 746
AND worksheet function, 372–373
animation

adding to slides, 616–618
animated GIFs, 605
Animation gallery, 617
Animation Painter, 624–625
Animation pane, 620–621
duplicating, 624–625
layering effects, 618–622
modifying, 622
overview, 615–616
PowerPoint Web App features, 856
repeating, 627
rewinding, 627
Silverlight plug-in and, 853
slide effect options, 626–629
slowing, 627
SmartArt, 619
sound effects, 628
text elements, 626
timing settings, 622–624, 627
transitions, 588–589, 629–631
triggering, 625–626

Animation gallery, 617
Animation Painter, PowerPoint, 624–625
Animation pane, PowerPoint, 620–621
annotations

adding to slides, 634–635, 637
review comments in files, 827
slide show pointer options, 637

announcements on SharePoint, 873
antivirus programs, 820
apostrophes ('), 400
Appear entrance slide animation effect, 620
appointments. See also meetings

connecting OneNote and Outlook data, 548, 551–553
creating new, 726
importing and exporting, 792
managing calendars, 705, 723–728
overview, 694–695
recurring, 727–728
searching for, 750
sending to notebooks, 506–507
sending via e-mail, 782
sharing, 782, 784, 785
time zones and, 810
To-Do Bar display, 705

Arabic numerals, 374
Archive.pst file, 799
archiving. See backing up settings and data
area charts, 436

arithmetic operations. See also math worksheet functions; 
mathematical equations; numbers

during Paste Special command, 466
Word table data, 260–261
worksheet formulas, 358

arranging
contents of ribbon tabs, 59
custom ribbon tabs, 58–59
document windows, 73–74
Quick Access Toolbar commands, 63, 64
ribbon commands, 59, 60
windows and slides in PowerPoint, 655, 657
windows in Excel, 454–455

arrow keys, 426
arrows (graphic). See shapes
Artist Effects gallery, 166–167. See also special effects
ascending sort order, 398
ASCII character codes, 114–115
ASIN worksheet function, 373
aspect ratio, 164–166, 609–610, 635
asterisks (*), 211, 358, 463
asynchronous collaboration, 826–831
at signs (@), 397
ATAN worksheet function, 373
attaching files to notebook pages, 507
attachments to e-mail

deleting to save space, 749, 799
disabled file attachments, 820–821
OneNote files, 566–567
Protected View and, 819
searching for, 748, 749
security features, 820–821
sending blocked files and executables, 821
sending to notebook pages, 548

attendees, 695, 750
audio

exporting from OneNote, 570
musical backgrounds for presentations, 680–681
OneNote Web App missing features, 858
recording in OneNote files, 569–572
recording slide narration, 631–632
sound effects, 628
soundtracks for presentations, 680–681
using in presentations, 607–608, 628

authors. See also collaborating on Office files
Authors field information, 94
multiple, working simultaneously, 832–835
tagging changes with initials, 566

AutoArchive option, Outlook, 798, 799, 801–803
Auto-Complete feature, Outlook, 812
AutoCorrect feature. See also AutoText feature

adding to Quick Access Toolbar, 336
copying entries to other computers or profiles, 118
customizing, 68, 336
defining strings for, 112
entering characters with, 112–113, 200–201
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lists, storage location, 118
mathematical equations, 123
scope limitations, 118
sharing with other users, 118
special characters, entering, 200–201
spelling check, 140
undoing corrections, 118

Autodiscover service, e-mail, 707, 708, 713
AutoFitting tables, 255
AutoMark files (indexing), 277
automatic backups, 544
automatic page breaks, 472–473
AutoRecover feature, 69–70, 104
autosave option, 103–105
AutoSort option (PivotTables), 412
AutoSum worksheet formula, 359
AutoText feature, 118, 331. See also AutoCorrect feature
averaging numbers, 390, 403
axes (charts)

arranging data points, 443
labels, 439
numeric scale options, 427
overview, 424
scatter XY charts, 437
source data connections for, 439
sparkline mini-charts, 450
swapping, 431

B
Back button (Open dialog box), 91
backgrounds

calendar, 779
charts, 442
notebook pages, 518, 519
pictures, removing, 54, 168–170
presentations, 606, 612–613
Word document colors, 193

backing up settings and data. See also restoring settings 
and data

AutoRecover file location, 69–70, 104
Office Settings Backup Wizard, 41
Office-related settings, 40
OneNote data, 543–546
OneNote settings, 530
Outlook data, 734, 737, 797–803, 813
overview, 39
Save My Settings wizard, 40
saving documents automatically, 103–105
time intervals, 104
tools for, 40–41

backslashes (\), 463
Backstage view

access restrictions, 46
adjusting program options, 67
AutoCorrect feature settings, 68, 336
automatic e-mail replies, 49

automatic file save frequency, 69
AutoRecover file locations, 69–70, 104
CD presentation packages, 682–683
closing files, 45
Compress Media option, 596
confidential file information checks, 46
converting files to other formats, 48
copying files with the Recent list, 46
creating files in, 47
creation dates, files, 46
default file formats and locations, 69
e-mail accounts, 707
e-mail settings and tools, 49
exiting Protected View, 820
external references and, 481
file properties, inspecting, 46
file size information, 46
font defaults, 68
header and footer access from, 611
modification dates, files, 46
moving e-mail between folders, 49
multiple versions of files, 46
new features, 5–6
notebook settings, 49
opening, 44–45
opening files from, 45
permissions, 46, 49
personal file information, removing, 821–822
pinning files to Recent list, 46
printing e-mail, 49
printing files, 47, 49, 468–471, 642
printing to fax devices from, 48
Recent list size settings, 46, 336–337
recently used files, 46, 336–337
saving files, 45, 49
saving files to networks or websites, 48
sending files as faxes, 48
sending files via e-mail, 48
sharing notebooks, 51
SkyDrive folders, 850
spelling check customization, 68
sync status of notebooks, 49
tag display in, 46
templates in, 47
thumbnail file display, 46
video-from-presentation feature, 673
virtual printers in, 48

Backstage view tabs and options
Advanced, 69
Close, 45
General, 67–68
Help, 49
Info, 46, 49
New, 47, 49
Open, 45, 49
Options, 45, 67–70
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Backstage view tabs and options, continued
Print, 49
Proofing, 67–68
Recent, 46
Save, 45, 69
Save & Backup, 69
Save & Send, 48–49
Save As, 45, 49
Share, 51

balancing columns on last page, 252
balloon tips, 71
banded rows and columns in tables (Excel), 393–394
bar charts (Excel), 424, 435–436, 443–444, 450
Bar Of Pie charts, 435
.bat files, 820–821
BCC box in e-mail messages, 729
Below Average filtering, 403
BELOW range (Word table formulas), 261
bevels, 178
black and white handout printing, 644–645
blank cells, 375, 483
blank pages, notebooks, 513
Blank slide layout, 583
blocking

access to SkyDrive files, 845
executable file attachments, 820–821
files, 819, 824
sending blocked files and executables, 821

Blog template, 318
blogs. See also websites

categorizing posts, 317
creating new posts, 314–315
home page, opening, 317
HTML code, editing, 319
managing accounts, 315–317, 318
opening existing posts, 318
pictures, 314, 316
publishing, 314–315, 317
saving posts as local copies, 319
sending notebook pages to, 567
templates, 318
text-only blogs, 314
tools for, 317–318
troubleshooting, 316, 317
uploading posts, 317

.bmp file extension, 83
body content searches, 748
boilerplate text, 116–118. See also AutoText feature; 

building blocks (Word documents)
bold text, 508
bonds, charting performance, 438
booklets, printing, 338
bookmarks

hyperlinks to, 119–120
saving SkyDrive locations as, 849

video clips in PowerPoint, 606–607, 626
Word documents, 269

Boolean operators, 535, 746
borders

Excel cells and ranges, 458–459
Excel chart conditional formatting, 445
Excel table formatting, 391–394
PowerPoint Web App graphics, 857
Word pictures, 167–168
Word tables, 263
Word text, 307

Bottom Ten conditional formatting, 446–447
brackets ([ ]), 397, 463, 854
breaking

connections to external data, 418
links to external references, 480
links to SharePoint lists, 874

brightness of pictures, 166–167
Broadcast Slide Show dialog box, 650–652
broadcasting presentations, 649–654
Browse tool (Word comments), 283
browsers. See also specific browsers

broadcasting presentations in, 650
building web pages in, 875–877
editing files in, 837, 840
hiding interface, 838
MHTML files, 567
OneNote Web App, 493
sending clippings to OneNote, 504

browsing Word document review comments, 282–283
bubble charts, 439
Building Block Gallery Content Control, 303
building blocks (Word documents)

AutoText, 331
Building Blocks Organizer tool, 336
creating, 332
creating categories, 332
definition, 330
galleries of, 330
listing, 330
locations, 332
placement options, 332
ScreenTips, 332

Building Blocks Organizer tool, 336
Bullet Library, 499
bulleted lists

notebooks, 498–500
presentations, 684–685
Word documents, 125, 240–242

burning DVDs, 673
Business Card feature (Outlook), 717, 783–784
Business Contact Manager, 20
Business Productivity Online Suite, 713, 860
buttons, action, 675
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C
Cached Exchange Mode, 714
caches, 562, 835, 852
calculated columns (Excel), 396–397
calculation types (PivotTables), 407, 408–409
calendars. See also appointments; meetings

arranging multiple, 778–780
backgrounds, 779
changing dates on notebook pages, 517
connecting to SharePoint pages, 877–880
displaying in Word forms, 303, 306
Google Calendar, 787
groups of, 779
holidays on, 778
overview, Outlook, 723
publishing online, 786–787
reminders, 774
search keywords, 750–751
sending items via e-mail, 782
SharePoint sites, 864, 873
sharing, 782, 784–788
team calendars, 878
time zone coordination, 810–812
viewing multiple, 778
viewing options, 706, 724–725

captions
photo albums, 672
slide layouts, 583, 584
Word documents, 270–271

carets (^), 358
case formatting worksheet function, 371
categories, galleries, 332
category searches, Outlook, 748
CD presentation packages, 650, 682–684
cell formats (Excel)

accounting, 380–381
currency, 380–381
custom formats with cell styles, 377
date and time, 381–382
Excel Web App missing support, 855
exponential notation, 384
fractions, 383
keyboard shortcuts, 378–379
negative numbers, 380
numbers, 379–380
overriding for individual cells, 378
overview, 376–379
percentages, 383
phone numbers, 385
scientific notation, 384
Social Security numbers, 385
special data types, 385
text, 384
ZIP codes, 385

cell ranges (Excel)
borders, 458–459

contiguous ranges, 348
converting to tables, 388
creating customized lists, 483–484
definition, 348
naming, 349–350
PivotTables, 406
print ranges, 471
referencing, 348
sorting, 398–400

cell references (Excel), 397
Cell Styles gallery, 463–464
CELL worksheet function, 375
cells (Excel)

active address, displaying, 349
assigning formats to imports, 417
borders, 458–459
color formatting, 447
conditional formatting, 445–449
copying and moving data, 465
creating custom styles, 463–464
data bars, 447
definition, 344
finding and editing data, 465
formatting, 124, 459–463
history of visited cells, 481
icons in, 448
identifying, 344
information about, returning, 375
mini-charts in, 450
simultaneously editing, 834
sparklines in, 450
tracking changes in, 829–830
Word tables. See cells (Word tables)

cells (Word tables), 258, 259, 266
Change Chart Type dialog box, 429, 430
change tracking. See also review comments (Word 

documents)
accepting/rejecting changes, 287–289
added text, identifying, 285
color coding changes, 285
Combine tool, 288–289
Compare tool, 288–289
comparing presentations, 831
deleted text, identifying, 285
filtering by change type, 287
hiding markup, 287
highlighting changes in Excel files, 828–829
highlighting synchronized changes, 566
history of document changes, 828
history of notebook changes, 573
history of workbook changes, 829, 830
initials, tagging changes by, 566
keyboard shortcuts, 286
merging changes from multiple documents, 288
navigating among changes, 288
Office program features, 827–831



892	 CHAR functions

change tracking, continued
options, setting, 290–291
proofreaders’ marks, 286
redlined documents, 285
rejecting changes, 664, 830–831
removing changes for SharePoint files, 866
resolving changes to SkyDrive files, 852
reviewing tools, 53
reviewing tracked changes, 287–289
ribbon tools for, 53
searching for specific text, 288
SharePoint version tracking, 869
synchronous scrolling and, 289
traditional markup, 286
turning on, 285, 290
underlined text, 828
updating read-only file copies with changes, 833
view options, changing, 286–287

CHAR functions, 467–468
character codes, 114–115
character counts, 66
character styles, 224
characters

bullets, 499
formatting, 215–218, 587, 608, 679–680

charts. See also charts (Excel); graphics
inserting in PowerPoint Web App, 857
inserting in Word, 53
ribbon chart tools, 54

charts (Excel)
3-D effects, 429, 432
appearance, changing, 179–180
conditional formatting, 444–449
creating, 421–423
data points, 433
definition, 150
editing data in, 441–442
elements of, 424–425
Excel Web App display, 856
formatting elements, 426, 442–444
gridlines, 426
highlighting data in, 444–450
incorrect values in, 441
inserting, 179–180
labels, 433
legends, 427
linking data to, 439–442
moving, 423
Quick Layout gallery, 425
resources and best practices, 423
selecting chart areas, 426
selecting elements in, 426
selecting type, 179
sparklines, 450
switching types, 429
templates, 421

tools for, 425
types of, 422, 429–439

area charts, 436
bar charts, 435–436, 443–444, 450
bubble charts, 439
column charts, 429–432, 443–444
doughnut charts, 439
line charts, 432–433, 443, 450
mini-charts, 450
pie charts, 433–435, 441
PivotCharts, 428–429
radar charts, 439
scatter (XY) charts, 437, 440, 441
sparklines, 450
stock charts, 438, 441
surface charts, 439

Check Box Content Control (forms), 303
check boxes (tags), 525–526, 540
check mark icons, 564
checking files in or out of libraries, 865–867, 869, 870
checking grammar, 53, 242–243
checking spelling. See spelling check
circling invalid data, 478
circular references in spreadsheets, 395
Clean Up option for e-mail conversations, 756
CLEAN worksheet function, 371
cleanup tools, 798, 799–801
clearing. See removing
Click-to-Run service, 24, 27–30, 35, 38
click-triggered slide animations, 622, 624
clip art, 150, 172–173, 624, 857. See also graphics; 

photographs and pictures
Clip Organizer, 173
Clipboard

copying or cutting to, 129
default paste options, 132–133
keyboard shortcuts, 129
multiple clippings, 133, 134, 135
pasting special formats and values in Excel, 465–467
pasting text only, 132
pasting text with formatting, 132
previewing pasted results, 130
replacing existing content, 130–132
ribbon function, 53

clippings
multiple clippings, 133, 134, 135
sending to OneNote, 502–504

clocks, changing time, 517
closing files, 45
cloud-based storage, 299, 837. See also Windows Live 

SkyDrive
clustered column charts, 429, 430, 443–444
collaborating on Office files. See also SharePoint 2010; 

Windows Live SkyDrive
asynchronously, one person at a time, 826–831
cloud-based computing and Web Apps, 837
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comments in files, 827
comparing versions of files, 663, 831
connecting Outlook to SharePoint pages, 877–880
new features for, 17
online collaboration on presentations, 661–665
sending links to SkyDrive files, 847–848
SharePoint site documents, 817, 835
simultaneous editing, 291–293, 832–835
SkyDrive folder permissions, 844–846
tracking changes, 827–831
user names and, 826

collapsing
navigation and tabs in OneNote, 521
outline levels in Word, 247
page lists in OneNote Web App, 858
PivotTable data, 410
results lists, 540
section lists in notebooks, 511

collated printing, 470
colons (:), 276, 361, 381, 745
color

calendars, 779
cell and range borders, 458–459
cell contents, 460–461
charts, 442
color mapping, 645
conditional formatting in charts, 445, 447
Excel tables, 391–394
fonts, specifying with styles, 235
gradients, 445
lines, 183
notebook pages, 518
notebook tags, 528
notebook text, 508–509
pictures, adjusting, 166–167
print settings for speaker notes or handouts, 644
rules or gridlines, 519
shapes, 177
slide annotations, 634–635
text effects, 182–183
themes, 186, 611
tracking editorial changes, 828
Word document backgrounds, 193

color coding
Office programs, 44
Word document changes, 285
Word document comments, 281
worksheet tabs, 347

color mapping, 645
Color Scales conditional formatting, 447
column breaks (Word), 252
column charts (Excel), 424, 429–432, 443–444
column labels (Excel), 473
column sparklines, 450
columns (data imports), 417

columns (Excel)
adding to tables, 389, 394, 442
banded, 393
calculated, 396–397
copying only visible data, 483
features in tables, 389
formatting in tables, 392–393
hiding, 453–454, 829
hiding names, 452
hiding on printed worksheets, 473
locking for visibility, 457
maximum number of, 344
nonscrolling headings, 389
PivotTables, 406–410
preserving original sort order, 400
repeating labels on printed worksheets, 473
selecting, 349
sorting by, 399
sparklines, 450
splitting view of, 456–457
switching in charts, 431
switching in PivotTables, 411

columns (OneNote tables), 501
columns (SharePoint pages), 876
columns (Word multicolumn pages), 250–252
columns (Word tables), 255
COM Add-Ins dialog box, 825
.com files, 820–821
Combine tool, 288–289
combining

changes to Word documents, 288–289
shapes, 604

Combo Box Content Control (forms), 303
Comma Separated Values (CSV) files, 415, 418, 793
commands. See also specific commands

Help for, 71
Quick Access Toolbar. See Quick Access Toolbar
the ribbon. See the ribbon

commas (,), 361, 461
comma-separated values (.csv) file format, 415, 418, 793
comments. See also review comments (Word documents)

checking in SharePoint files, 866
limiting characters in comments fields, 476
meeting notes, 552
presentation reviews, 661
ribbon Review tab, 53
Word files. See review comments (Word documents)

Comments feature (PowerPoint), 661
Common Feed List, 804–806
Communicator (Office edition), 20
Compact Form PivotTable layout, 414, 415
Compare Documents feature (Word), 288–289, 831
Compare feature (PowerPoint), 663–665, 831
comparing

calendars, 777
contents of document windows, 73–74
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comparing, continued
Excel conditional formatting for, 446
files, 53
presentations, 663–665, 831
Word documents, 288, 831
worksheet formulas for, 359–360

comparison operators, 446, 463
Comparison slide layout, 583
compatibility. See also Compatibility Mode

add-ins under 64-bit editions, 23
DirectX, 22
file formats, 76–77, 87–90
Word document versions, 191–193
worksheet function, 376

Compatibility Mode, 89, 191–193, 304, 557
completing tasks, 525–526
composing presentations, 580–593
compressing

pictures, 94
presentations, 596–597

Computer Network Consultants, 41
CONCATENATE function, 467–468
concatenating text, 360–361
concordance files, 277
conditional formatting, 444–450, 855
Conditional Formatting menu, 446
Conditional Formatting Rules Manager dialog box, 448
conditions, Excel number formats and, 463
confidential information, 46, 821–822
conflicting conditional rules, 449
Conflicts folder, Outlook, 799
conflicts, simultaneous editing, 834
Connect To Outlook command, 879, 880
“connected” symbol, 564
constants, 356, 483
Contact Card feature, Outlook, 715–716
Contact Groups, Outlook, 721, 722
contacts

Address Book, 767–770
browsing, 717
connecting OneNote and Outlook data, 548, 549–551
duplicates, 722
grouping, 721
importing and exporting, 792
linking all to OneNote, 551
merging information, 723
organizing, 715–723
overview, 697
pictures of, 810
searching, 720, 749–750
sending to notebooks, 506–507
sending via e-mail, 782
sharing information on, 782–785
Suggested Contacts folder, 813
suggested list, 812–813

content controls (Word forms), 302–306

Content With Caption slide layout, 583
Contents pane (Outlook), 701
context-sensitive ribbon tabs, 51
contrast in pictures, adjusting, 166–167
Contribute permissions, 862, 863
conversations, e-mail and discussions, 755–757, 864, 

877–880
Convert Text To Table command, 253, 256–257
CONVERT worksheet function, 374
converting

Arabic numerals to Roman, 374
charts to other types, 429
date/time text to date/time values, 370
documents to other formats, 48
e-mail messages to appointments, 726
legacy lists to Excel tables, 387–388
notebooks to shared status, 563
numbers to text, 371–372
older notebooks, 493
OneNote printouts to text, 574–575
presentations to video, 595, 650, 673–674
text to numbers, 372
text to tables, 253, 256–257
Word outlines into PowerPoint presentations, 597–599

Copy Link command, 553
copying

animation effects, 625
appointment data to OneNote vs. linking, 551
AutoCorrect entries, 118
calendar information, 779
cell contents, 465
to Clipboard, 129. See also Clipboard
converted OCR text, 575
custom number formats, 459
documents, with Recent list, 46
files from Web Apps, 840
graphic formatting, 178
graphic objects, 178
hyperlinks from OneNote, 553, 561
keyboard shortcuts, 128–129
lines to Outlook items, 553
links to OneNote items, 532
links to SkyDrive files, 847
notebook pages, 513
notebook sections, 511
notebooks to Windows Live SkyDrive, 566
OneNote formatting, 13
Outlook items for backup, 801
presentation designs, 657
rows or columns into chart data sources, 442
slides, 582, 588, 655–656
styles between documents or templates, 233
tags to other OneNote installations, 529–530
text, 130
text formatting, 128–129
visible data in Excel, 483
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web clippings to OneNote, 502–504
Word section formatting, 250
worksheet cell contents, 355
worksheet cell formats, 355

copyright issues, 681
corrupted files, 819
COS worksheet function, 373
coworkers. See collaborating on Office files
Create dialog box (SharePoint), 863–864
Create PivotTable dialog box, 406
Create Rule dialog box (Outlook), 764
Create Table dialog box (Excel), 388
criteria (Outlook searches), 744–747
cropping

graphics in PowerPoint Web App, 857
pictures, 164–166, 170
screen shots, 174

cross references (Word documents), 269, 271–273
.csv (comma-separated values) file format, 80, 257, 415, 418, 

793
cube worksheet functions, 375–376
currency, 380–381, 460, 462
Custom AutoFilter dialog box, 403
custom formats (cells). See cell formats (Excel)
Custom Lists dialog box, 483–484
Custom Shows dialog box, 659–660
customizing

address book listings, 770
AutoCorrect, 68, 336
Excel cell formats, 459–463
Excel data series, 483–484
Excel data validation rules, 476
Excel filters, 401, 403
Excel numeric and date formats, 459–460
Excel PivotTable field layouts, 409, 410–413
Excel sort options, 399
Excel worksheet views, 451–457
keyboard shortcuts, 71–72
Office Clipboard, 135
Office installations, 34–35. See also installing Office
OneNote interface, 520–522
OneNote page templates, 575
OneNote tags, 525, 526–528, 858
OneNote taskbar icon, 573
OneNote unfiled notes, 542–543
Outlook, 700–707
Outlook forms, 53
Outlook search folders, 752
Outlook viewing options, 753–757
PowerPoint backgrounds, 612
PowerPoint bullets, 684–685
PowerPoint handouts, 645, 669
PowerPoint layouts, 608–611, 667–670
PowerPoint notes masters, 669
PowerPoint slide masters, 665
PowerPoint slide shows, 657

PowerPoint slide transitions, 630
Quick Access Toolbar, 335–336
ribbon commands. See the ribbon
ribbon tabs, 59
RSS feeds, 883
SharePoint library file templates, 872
SharePoint library settings, 871–872
SharePoint lists, 873
SharePoint websites, 868–877
spelling check, 68, 141–142
status bar, 67, 335–336
themes, 186
To-Do Bar, 706

Customizing Tags dialog box, 525
cutting to the Clipboard, 129

D
daily alerts, 882
data. See also data files; data points; data series; data 

sources
backing up. See backing up settings and data
editing in charts, 441–442
Excel data types, 474
external database connections, 391
highlighting in charts, 444–450
PivotTables, 387–390
sample random data, 484–485
sorting, filtering, and outlining Excel data, 397–405
tables, 387–389
validation in Excel, 474–478
visualizing with charts, 421–423

data bars, 445, 447
Data Bars conditional formatting, 447
Data Execution Prevention, 818
data files. See also data sources

Hotmail, 738
.ost file format, 690, 734, 736
Outlook, 733, 813
.pst file format, 690, 734, 736, 793–794

data markers, 432–433, 450
data points, 407, 433, 437, 442, 443
data series

adding new data to charts, 440–441
arranging data points, 443
customizing, 483–484
editing, 440, 442
Excel chart overview, 424
incorrect values in, 441
linking to charts, 439–442
pie chart options, 435
removing from charts, 441

Data Series Options dialog box, 437
data sources

charts, 422
connecting queries to SharePoint lists, 873
creating PivotTables from, 406–410
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data sources, continued
enlarging with handles, 441
Excel Web App support, 856
external databases, 391
external references, 480
importing into Excel, 319, 415–419
linking to charts, 439–442
PivotTables, 390
refreshing connections to, 418
sparklines, 450

data stores
OneNote. See notebooks (OneNote)
Outlook, 75

data tables (Excel), 387
data types (Excel), 474
databases

connecting queries to SharePoint lists, 873
connecting to Excel tables, 391
database worksheet functions, 375–376
importing data into Excel, 416
SharePoint sites, 864
simple, 387

Date Navigator, 705, 723–724
Date Picker Content Control (forms), 303
dates

appointments and meetings, 726
audio or video recording time stamps, 570
converting text to worksheet values, 370
criteria for Outlook search queries, 746–747
as data types, 475, 476
date and time stamps in notebooks, 498, 517, 566
Date Picker (forms), 303
date serial numbers, 368
due dates for To-Do Bar, 772
entering in Outlook calendar, 727
expiration dates in SkyDrive, 848
filtering Excel tables by, 401–404
follow-up flags, 772
inserting in Word, 202–203
Outlook calendar, 723
Outlook Date Navigator, 705, 723–724
PivotTable date-based reports, 390
regenerating tasks at future date, 776
relative dates, 403–404
on screen captures, 504
searching by, 541, 745, 746
selecting in Word forms, 303, 306
sorting in Excel, 400
sorting in OneNote searches, 538
Start date property of follow-up flags, 773
today’s date, entering in Excel, 352
today’s date, returning in Excel, 369–370
worksheet cell formats, 381–382, 409, 459, 460, 461–463
worksheet functions, 368–370

DATEVALUE worksheet function, 370
Day view in calendar, 725

DAY worksheet function, 369
days

custom Excel formats, 461
DAY worksheet function, 369
filtering Excel tables by, 402–403
Outlook views, 705

DAYS360 worksheet function, 370
.dbf file extension, 80
decimal alignment, 461
decimal places, 459, 460, 475
decks of slides, 581
declining meetings, 781, 782
Define Custom Show dialog box, 660
delaying e-mails, 730
delays in animation, 622, 623–624
Deleted Items folder, Outlook, 799
deleting. See removing
delimiter characters, 417
delivering presentations, 609–610, 632–641, 650, 682–684. 

See also slide shows
Delivery Options for e-mail messages, 730
demoting

headings in Word documents, 204, 246
subpages in notebooks, 515

descending order sorts, 398
designing slides, 594
desktop publishing features, 10–11
destinations for OneNote pages, 497
Developer ribbon tab, 53
diagonal lines in cells, 459
diagrams. See shapes
.dic file extension, 143
dictating documents, 109
dictionaries, 53, 140–143, 144–145
.dif file extension, 80
digital rights management (DRM), 681
digital signatures, 299, 822
digitizers, 506
digits, 460, 461
DirectX compatibility issues, 22
disabling backups, 544
discarding changes to SkyDrive files, 852
discussions

connecting Outlook to SharePoint pages, 877–880
displaying e-mail as, 755–756
e-mail discussion lists vs. Contact Groups, 722
SharePoint threaded discussions, 864

display names
contacts in Outlook, 718–719
OneNote tags, 528

displaying
author information, 566
bookmarks (Word documents), 269
calendars, 706, 724–725, 779, 780
document tags, 46
Draft view (Word), 195–196
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file creation dates, 46
file modification dates, 46
file properties, 102
files in Office Web Apps, 838
Full Screen Reading view (Word), 194–195
handout masters, 585, 592, 669
header rows (Excel), 392
hidden Excel rows and columns, 454
hidden slides, 658
note masters, 585, 592, 669
note pages (PowerPoint), 585, 590–591
OneNote Quick Launcher, 573
Outline view (Word), 195
outlines (PowerPoint), 586–588, 593–594, 595
Outlook viewing options, 700–707, 753–757
overlay view of multiple calendars, 779, 780
PivotTable totals and grand totals, 413
presentation restrictions on broadcast type, 654
presentations in Normal view, 580, 585, 586–588, 616
Presenter view (PowerPoint), 638–641, 653
Print Layout view (Word), 193, 196
Reading pane (Outlook), 706–707, 820
Reading view (PowerPoint), 585, 589–590
recently used files, 46, 336–337
schedules, 725
slide masters, 585, 591–592, 665–668, 665–670
slides, 655, 657
switching Word views, 196–197
text wrapping, 195
threaded e-mail discussions, 755–756
web pages in OneNote, 503
web views, 195
weekly view, 725
Word default view, 193

distributing graphic objects evenly, 155–156
.doc file extension, 77, 78, 83, 820
Dock To Desktop command, 558
docking OneNote windows, 13, 558
.docm file extension, 77, 83
Document Inspector dialog box, 294–295, 821–822
Document libraries (SharePoint), 869, 870–871
documents (Word)

automatic saving, 69
background color, 193
Backstage view of SkyDrive folders, 850
browser editing, 840
bulleted lists, 240–242
captions, 270–271
character counts, 66
comments. See also review comments (Word documents)
compatibility with earlier Word versions, 191–193
consistent appearance, 226, 230
content controls, 223
converting to other file formats, 48
copying, 46
creating, 47, 97–98

creating in SkyDrive folders, 844
dates and times, 202–203
definition, 76
Document libraries (SharePoint), 869
editing with Office Web Apps, 838
equation captions, 270–271
fields and field codes. See field codes (Word documents)
formatting text. See text formatting
grammar check, 242–243
graphics, 237–240
green squiggly underlines, 242
highlighting text, 194
hyperlinks to, 119–120
hyphenation, 201–202
line breaks, 201–202
line counts, 66
line numbers, 242
linking to OneNote, 557–561
lists, 240–242
locked documents, 833
magnifying. See zooming views
margins, 196, 221–222
metadata, 99
multiple versions, 46
nonbreaking spaces, 202
numbered lists, 240–242
opening from SkyDrive folders, 851
opening Word from Office Web Apps, 840
orientation, 221–222
overview, 189
page layout options, 221–222
page numbers, 66, 222–224
page size, 190, 221–222
paragraph counts, 66
pinning to the Recent list, 46
printing, 47
properties, 46, 99–101, 203
Protected View disabled features, 818–820
reading aloud, 337–338
recovery, 11
removing personal information, 821–822
restricting format changes, 230
reviewing comments. See review comments (Word 

documents)
ruler display, 191
saving, 69, 95–97, 103–105
saving OneNote files as, 568
saving to SkyDrive, 850–851
sending via e-mail, 48
SharePoint alerts for updates, 880–882
SharePoint site libraries, 864
sharing in SharePoint sites, 835, 864–868
simultaneous editing, 832
Speak command, 337–338
special characters in, 200–201
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documents (Word), continued
spelling check, 242–243
statistics about, 66
synchronizing with SkyDrive, 851–852
tables. See tables (Word)
tags, 46, 101
templates, 47, 97–98
text-to-speech conversion, 337–338
themes. See themes
thumbnail display, 46
tracking changes. See change tracking
watermarks, 222
word counts, 66
wrapping text around images, 238–239

Documents folder (SkyDrive), 842–843
.docx file extension, 77, 81, 83
Dodge, Mark, 423
dollar signs ($), 361–363
DOLLAR worksheet function, 371
donut charts, 439
.dot file extension, 77
.dotm file extension, 77
doughnut charts, 439
downloading

backup copies of Outlook data, 737
changes to SharePoint files, 867
e-mail message headers only, 790
e-mail messages, 791
locations of downloads, 806
Microsoft Office 2010 Resource Kit, 24
Microsoft Office Compatibility Pack, 88
Office Environment Assessment Tool, 21
Office from the Web, 27
Office updates, 38
Outlook Hotmail Connector, 714
pictures from SharePoint libraries, 869
PowerPoint Viewer, 595
Protected View and, 92, 819
Ribbon Hero, 826
SharePoint library items, 869
snapshots from Excel Web App, 856
templates, 97, 98
Windows Desktop Search, 534
Windows Live Photo Gallery, 171
Windows Live Writer, 314
Word building blocks, 330

.dqy file extension, 80
Draft view (Word), 195–196
dragging

docked OneNote windows, 558
files to link in OneNote pages, 531
files to SkyDrive folders, 843
PivotTable items, 411

Draw Table command, 253, 256
drawing, 54, 183–184, 253, 504–506, 858. See also graphics
drawing layers, 150–151

drawing tools, 54, 858
DRM (digital rights management), 681
drop caps, 313
Drop-Down List Content Control (forms), 303
drop-down lists, 474, 475
Duarte’s Five Rules, 594
due dates, 555, 772, 773
dummy text, 338–339
duplicate contacts, 722
duplicating

animations, 624–625
slides, 582, 588, 655–656

duration of animations, 622, 623
Duration option, animation timing, presentation slides, 623
DVDs of presentations, 673
Dynamic Content slide transitions, 630

E
earlier versions of files, 819
Edit Links dialog box (Excel), 481
Edit Permissions page (SkyDrive), 846
Edit Series dialog box (Excel), 440
Edit Wrap Points command (Word), 239
editing

address book entries, 770
animations, 622
appointments, 726
audio, 608
author’s name and initials tagging, 566
changing fonts, 809
chart data, 441–442
checking files in or out from SharePoint, 865–867
clip art, 173
conditional formatting rules, 448
data series for charts, 440
disabled features in Protected View, 818–820
document properties, 100–101
e-mail account settings, 709
e-mail signatures, 731
enabling in Protected View, 819–820
files on SharePoint sites, 870–871
files on SkyDrive, 845
files one person at a time, 826
files simultaneously, 832–835, 866–867
files with Office Web Apps, 837, 838, 840, 853, 854–855
finding recently edited notebook pages, 539
folder permissions, 844–846
headers or footers, 224
HTML code, 876
hyperlinks, 53, 120
keyboard shortcuts, 116
meetings, 726
notes with attached recordings, 570
OneNote links, 532–533
OneNote tags, 527
Outlook display names, 737
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page column layout in Word, 250
Paste Options for, 109
presentation handouts in Word, 646
presentation text on slides, 593–595
Quick Step actions, 761
redoing changes, 115–116
repeating changes, 115–116
resolving conflicts, 834, 852
ribbon tools, 53
shared notebooks, 562
SharePoint pages, 875–877
slide comments, 662
slide headers and footers, 610
slide text, 593–595
sparklines, 450
spelling check dictionaries, 143
styles, 232
syncing changes to SkyDrive files, 851–852
syncing notebook changes manually, 564–565
table styles (Excel), 393
text with speech recognition, 109
text wrap around pictures, 239
undoing changes, 115–116
video clips, 605–607
Windows registry, 692

editing tools, 53
Editing view, Web Apps, 853, 856, 857
editions of Office. See names of specific editions
effective interest rate, calculating, 367
elapsed time, 461, 462
e-mail

account settings, 49, 690–691, 707–715
addresses, hyperlinks to, 120
alerts, 764
appointment sharing via, 782, 784
attachments to, 749, 799, 819
automated message handling, 16
automatic replies, 49
calendar sharing via, 785–788
cleaning up, 49, 756, 798
contacts and, 716
conversations, 755
converting to appointments, 726
creating, 729–732
delaying, 730
deleting redundant messages, 16
deleting vs. permanently deleting, 766
discussion lists vs. Contact Groups, 722
finding and filtering, 753
fonts, 810
formatting, 730–731, 809–810
formatting notebook pages as, 575
HTML-formatted messages, 820
ignoring messages, 16
importing and exporting, 792

inserting pictures from SharePoint libraries, 869
junk mail filters, 820
mailbox size tool, 798
meeting invitations and, 780–782
moving items between folders, 49
organizing, 757–767
overview, 694
permissions, 49
printing, 49
properties, 49
Protected View and attachments, 819
Quick Steps feature, 758–762
rules and alerts, 49, 758, 762–767
save options for sent messages, 729
searching, 744, 748, 753
security features, 820–821
sending, 730

blocked files and executables, 821
documents, 48
notebook pages or sections, 557, 566, 575
to notebooks, 506–507, 548–550

servers, 710
shared notebooks, links to, 563
SharePoint file update notifications, 880–883
signatures, 731
SkyDrive files, links to, 847
spam, 820
threaded discussions view, 15–17, 755–756
tracking message histories, 16–17
unread count, displaying, 66
webmail services, 714–715, 757, 786, 792

e-mail discussion lists vs. Contact Groups, 722
embedded audio clips, 607
embedded fonts, 679–680
embedded video clips, 605–607
emphasis effects for slide animations, 617, 628
encryption, 298, 822
End Mode workbook navigation, 351–352
engineering worksheet functions, 374
entrance effects for slide animations, 617, 628
entries in galleries, 55
EOMONTH worksheet function, 370
equal signs (=), 359, 745
equal to comparisons, 446
equation tools, 54, 493, 506
equations. See mathematical equations
erasing. See removing
error messages

data validation rules, 476
Excel invalid data, 474, 477
suppressing, 375

errors in sorting, 400
EVEN worksheet function, 374
events, 694, 727, 880–882
Everyone permission, 845
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Excel
documents. See workbooks and worksheets (Excel)
Excel Web App, 838, 840–841, 853, 855–856
favorite tips, 478–485
file formats supported, 79–80
new features, 12
opening files from Office Web Apps, 840
SharePoint site file sharing, 864–868

Excel 97-2003 templates, 479
Excel Options dialog box, 452, 478–479
Excel Web App, 838, 840–841, 853, 855–856
Excel Web Query File format, 874
Excel.exe process, 455
Exchange ActiveSync, 690, 788
Exchange Anywhere, 713
Exchange server, Microsoft, 707, 713–714, 736, 780, 791
Exciting slide transitions option, 630
executable files (.exe), 820–821
exit effects for slide animations, 617, 628
expanding

Excel tables, 394–395
navigation and tabs in OneNote, 521
page lists in OneNote Web App, 858
PivotTable data, 410
search results lists, 540
section lists in notebooks, 511
Word outline levels, 247

expiration dates (SkyDrive), 848
exploding pie charts, 434
exponential notation cell format, 384
exporting

documents as other formats, 48
Excel data, 418
lists to Excel workbooks, 874
notebook data, 566–568
OneNote audio or video, 570
Outlook data, 792–796
presentations to video, 595, 650, 673–674
ribbon settings to other programs, 65
tags to other OneNote installations, 529–530
Word outlines into PowerPoint presentations, 597–599

external data sources. See data sources
external references (Excel), 480

F
FALSE results (data validation), 476
Favorites

saving SkyDrive locations as, 849
Search folders as, 752
SharePoint server links, 864
SkyDrive Favorites folder, 842–843

feeds, 803–807, 882–883
field codes (Word documents)

captions, 271
codes vs. results, 333
displaying, 271

{INDEX} code, 277
inserting fields, 334
keyboard shortcuts, 334
marking index entries, 275–276, 277
marking tables of contents, 275
switching views from codes to results, 333
updating, 271
{XE} code, 275–276

fields (PivotCharts), 428–429
fields (PivotTables), 407–413
fields (Word), 333, 334
figure captions, 270–271
file attachments. See attaching files to notebook pages; 

attachments to e-mail
File Block feature, 819, 824
file formats. See also specific formats

audio, 571
comma-separated values (.csv), 793
compatibility issues, 76–77, 87–90
compatibility mode, 89
Excel, 79–80
Microsoft Excel Web Query (.iqy), 874
OneNote, 81, 492, 493, 567
OOXML (Office Open XML), 85
Outlook, 84, 690, 734, 736, 793–794
overview, 76–77
PDF, 595
PowerPoint, 82–83, 595, 656
setting defaults, 86–87
video, 571
Word, 77–78

file locations, 27, 492
file paths, 531, 839
file properties, 102–103
file size

audio and video, 571
displaying, 46
Outlook data files, 737

files. See also data files
attaching to e-mails, 749, 799
Backstage view of SkyDrive folders, 850
checking in or out of libraries, 865–867
closing, 45
comparing, 53
compressing presentations, 596–597
converting to PDF format, 48
converting to XPS format, 48
creating in SkyDrive folders, 844
creation dates, 46
digital signatures, 299, 822
earlier versions of, 819
encrypting, 822
File Block settings, 824
finding, 102–103
flattening into images, 597
formats. See file formats
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hyperlinks to, 119–120
in-use warnings, 832
linking to OneNote pages, 531
managing in SharePoint libraries, 870–871
managing in SkyDrive, 848–850
managing Outlook files, 733–740
modification dates, 46
opening, 45
paths for Office Web Apps, 839
permissions, 822
personal and confidential information, 821–822
protecting presentations, 663
recently used, 46, 336–337
recovery, 11
renaming, 45
saving, 45
saving to networks, 48
saving to the web, 48
sending as faxes, 48
sending links to SkyDrive files, 847–848
SharePoint addresses, 864
SharePoint templates for, 872
size, 46, 571, 737
synchronizing with SkyDrive, 851–852
tracking changes, 53
update notifications, 867
uploading to SkyDrive, 843

filler text, generating, 338–339
filling

data across worksheets, 467
data series with data, 483–484

fills
gradients, 308, 445
shapes, 177
text colors, 308
text effects, 182–183

Filter E-Mail menu, 753
filtering

chart data, 428–429
e-mail, 753, 820
Excel limitations, 402
Excel tables, 389, 401–404
Excel Web App features, 855
files by properties, 102–103
junk mail, 820
notebook tag searches, 540
PivotTable data, 412
SharePoint library views, 872
Word documents, by change type, 287

filters (graphic), 166–167
financial worksheet functions, 366–367
Find And Replace dialog box, 465
Find feature, 136, 753. See also finding and replacing; 

finding and searching
FIND function, 468
Find option for archiving Outlook data, 798–799

finding and replacing
Excel shortcuts for, 465
ribbon tools, 53
text, 136–138, 214
text formatting, 136–138

finding and searching
Address Book information, 769
for all word forms, 211
archiving Outlook data with find options, 798–799
for clip art, 172–173
in closed or open notebooks, 536
contact information, 720, 749–750
cross-program comparison of find features, 136
date search queries, 746–747
e-mail messages, 748, 753
by Excel cell or data types, 482–483
for Excel data with filters, 401–402
Excel shortcuts for, 465
Excel worksheets quickly, 456
for files by properties, 102–103
for files to open, 91
FIND and SEARCH functions, 468
for handwritten comments, 281
for highlighted text, 213
for homonyms, 211
for invalid data, 478
keyword searching, 539, 745–751
logical operators, 746
new features, 10
for nonstandard characters, 212
in OneNote pages and notebooks, 491, 534–542
for OneNote recently modified pages, 539
OneNote Search Results pane, 537–538
OneNote search scope, 537, 538
OneNote Summary pages, 541–542
for OneNote tagged items, 523, 540–542
Outlook criteria, 744–747
Outlook features for, 720, 741–753, 769
in Outlook folders, 720, 742–743, 751–753, 763
Outlook Instant Search feature, 741–753
Outlook Search folders, 751–753, 763
for Outlook tasks, 751
in passworded notebook sections, 565
repeating searches, 213
scope of search, setting, 742–743
Search folders as Favorites, 752
Silverlight plug-in and, 853
for special characters, 212
for text formatting, 212–213
for themes, 186
tracking and highlighting Word changes, 288
updating Windows XP for search, 534
wildcard characters, 211
Windows Search, 741, 747
for Word comments, 281
Word overview, 210–211, 212–213
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Firefox, 567, 838, 853
first names, 718
fitting printouts on pages, 470
Five Rules presentation, PowerPoint, 616
fixed table column widths, 255
FIXED worksheet function, 371–372
Flag options for follow-up in Outlook, 771–773
flagging tasks, 554–555, 774–776
Flash video, 605
flattening presentations into images, 597
Float In entrance slide animation effect, 620
floating notes windows, 574
Fly In entrance slide animation effect, 619
folders

limiting search to, 742
Outlook

archives, 800
Cleanup Tools, 799–801
folder organization, 738–740, 763
pop-out lists of, 703
searches, 720, 742–743, 751–753, 763
Suggested Contacts, 813
temporary folders, 796

permissions for, 842
search folders, 751
searching in, 748
SharePoint sites, 869–872
SkyDrive, 842–843, 848–850, 851

Backstage view, 850
folder links, 847–848
permissions, 844–846
properties, 848
subfolders, 842
syncing, 851–852
types, 848, 850

follow-up flags for Outlook items, 771–777
fonts. See also text formatting

charts, 442
color, specifying with styles, 235
deleting, 128
e-mail defaults, 809
embedding in presentations, 679–680
Excel defaults, 479
Excel table formatting, 391–394
Excel Web App features, 855
hiding, 128
license restrictions on, 680
notebook defaults, 67, 68
notebook page titles, 517
notebook text, 508–509
Office Web App views, 838–839
OneNote tags, 528
size, 854, 855
styles and, 235
substituting, 216
themes, 127–128, 186, 611

Web App editing and, 854
Word features, 312
workbook defaults, 67

footers and headers. See headers and footers
Form libraries (SharePoint), 869
Format Axis dialog box, 428
Format Background dialog box (PowerPoint), 612–613
Format Cells dialog box, 458
Format Data Labels dialog box, 433–434
Format Data Series dialog box, 435, 443
Format Painter, 13, 128–129, 508
Format Text Effects dialog box (Word), 309
formatting. See also fonts; layouts; text formatting; themes

changes not tracked, 829
chart elements, 426
charts, 442–444
conditional formatting for chart data, 444–450
copying. See also Format Painter

graphic formatting, 178
presentation designs, 657
styles between documents or templates, 233
text formatting, 128–129
Word section formatting, 250
worksheet cell formats, 355

date or time information, 727
e-mail messages, 730–731, 809–810
Excel tables with styles, 391–394
formatting marks in Word, 221, 336
galleries of predefined options, 54
notebook lists, 498–500
notebook page titles, 517–518
notebook text, 508–509
in Office Web App views, 838–839
outlines, 587
PivotTables, 409, 413–415
ribbon tools, 53
SharePoint pages, 876
slide backgrounds, 612–613
slide text, 587, 608, 679–680
text. See text formatting
Web App editing and, 853, 854
Word documents. See text formatting
workbook settings, 478–479
worksheets, 458–464

forms (Outlook), 53, 864, 869
forms (Word)

advantages of, 301
building blocks, selecting, 303
calendar, displaying, 303, 306
check boxes, 303
combo boxes, 303
Compatibility Mode restrictions, 304
content controls, 302–306
converting controls to text, 305
dates, selecting from a calendar, 303, 306
drop-down lists, 303
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editing restrictions, 305–306
fields, adding, 302
formatted text, allowing, 303
Legacy Tools, 303
pictures, 302, 303
plain text in, 302
properties, setting, 304–305
protecting, 305–306
rich text in, 302
SharePoint site libraries, 864, 869
table layout, 302
templates for Word forms, 301

formula bar, 452
formulas (Excel). See also functions

absolute references, 361–363
arithmetic operations, 358
AutoSum, 359
concatenating text, 360–361
constants, 356
copying, 465
data validation rules, 476
elements of, 356
Excel Web App features, 856
finding cells with, 483
functions, 357
hiding formula bar, 452
intersection operator, 361
keyboard shortcuts, 358
making comparisons, 359–360
mixed references, 361–363
naming, 349, 359
nested functions, 357
operators, 357–358
order of operations, 363
preventing accidental copies of, 396
range operators, 361
references, 356
relative references, 361–363
=SUM, 359
summing numbers, 359
symbols in, 397
in Total rows, 395–396
validating data for, 474–478

formulas (Word tables), 260–261
forums (SharePoint sites), 864
Forward button (Open dialog box), 91
forward slashes (/), 358
fractions, 383
freezing worksheet panes, 456–457
frequency of alerts, 882
Friends permission, 845
Full Control permission, 861–862, 863
Full Name field, Outlook contacts, 718
Full Page view (OneNote), 521
Full Screen presentations, 634
Full Screen Reading view (Word), 194–195

functions
arguments, listing, 365
built-in

date and time, 368–370
engineering, 374–375
financial, 366–367
information, 375
logical, 372–373
lookup and reference/database/cube, 375–376
math and trigonometry, 373–374
statistical, 373
text, 370–372

case formatting, 371
compatibility issues, 376
converting Arabic numerals to Roman, 374
converting date/time text to date/time values, 370
converting text to numbers, 372
converting values to text, 371–372
error messages, suppressing, 375
filling blanks with default values, 375
inserting in formulas, 363–365
invalid, troubleshooting, 365
listing, 365
measurement system conversions, 374
Not Applicable error message, 375
removing unwanted characters, 371
rounding numbers, 371–372, 374
system environment information, returning, 375
table management, 376

G
galleries

adding to the Quick Access Toolbar, 56
Artist Effects for pictures, 166–167
categories, creating, 332
changing entries, 55
creating entries, 55
description, 54
live previews, 54, 57
mathematical equation components, 120, 122
picture styles, 167–168
pictures, borders, and shadows, 54–55
predefined formatting options, 54
Quick Style, 226–228, 233
saving changes to, 56
shape styles, 177–178
text effects, 183, 308
themes, 55
Windows Live Photo Gallery, 171
Word building blocks, 330
Word styles, 226

GAMMADIST worksheet function, 376
GAMMA.DIST worksheet function, 376
gaps between chart groups, 443
General options (Backstage view), 67–68
General options (saving), 94
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General tab for Word, Excel, PowerPoint, 67–68
generating random numbers, 484–485
Get External Data group, 416
.gif file extension, 83
globally unique identifiers (GUIDs), 533, 551
glow effects, 167–168, 178, 308
Gmail, 715, 781
Go To dialog box

navigating in Excel, 481–483
navigating Word comments, 283
navigating Word documents, 206

Go To Special dialog box, 482–483
Google Calendar, 787
gradients, 308, 445
grammar checking, 53, 242–243. See also spelling check
grand totals in PivotTables, 413
graphics. See also clip art; photographs and pictures; shapes

aligning objects, 155–156, 603
animated GIFs, 605
backgrounds for notebook pages, 519
bullets, 684
clip art, 624
clipping, 221
combining shapes, 604
contacts’ pictures, 810
copying, 178
copying formats, 178
default names, 153
dimensional units of measure, 160
distributing objects evenly, 155–156
drawing layers, 150–151
drawing with ink, 54, 183–184
in Excel, 155, 448
flattening files into images, 597
grouping, 160–162, 604–605
handwritten text as, 184
inserting into slides, 602–603
In Line With Text style, 154
moving objects, 154, 178
in Office Web App views, 838–839, 854, 855, 857, 858
on OneNote pages, 502
OneNote tagging, 525
OneNote Web App features, 858
in Outlook, 154
pen input, 183–184
Photo Album feature, 670–672
Picture libraries (SharePoint), 869
picture styles, 857
Picture With Caption slides, 584
PowerPoint Web App features, 857
precision placement, 154
presentations, 154–155, 601–605, 624, 670–672, 684
renaming, 153
resizing, 157–159
rotating, 157–159
selecting, 151–153

Selection And Visibility pane, 152–153
on SharePoint pages, 876
in SharePoint site libraries, 864
stacking objects, 156–157
text wrapping style, 154
types of, 149–150. See also specific types
visibility, 153
in Word, 154, 237–240
in Word Web App, 854, 855

grayscale printing, 644–645
greater than comparisons, 446
greater than or equal to operators (>=), 359
greater than operators (>), 359, 745
Greek text, generating, 338–339
green check marks, 564
green spinning arrows, 564
green squiggly underlines, 242
Grid And Guides dialog box, 603–604
gridlines

charts, 424, 426
dividing charts into quadrants, 437
hiding, 452
hiding before printing, 473
notebook pages, 518–519
slides, 603–604
toggling on or off, 53

Groove Workspace, 867
grouping

calendars, 779
contacts, 697, 721
found tagged items, 540
graphic objects, 160–162
notebook sections, 511–513
PivotTable data, 412–413
sections in OneNote, 491
SharePoint library views, 872
worksheets (Excel), 467

Grouping dialog box, 413
groups of people

adding SkyDrive permissions for, 846
Outlook Contact Groups, 721, 722
SharePoint 2010, 861–863

guides, 603–604
GUIDs (globally unique identifiers), 533, 551

H
hackers, 818, 820, 821. See also security
Handout Master view, 585, 592, 669
handouts, 642, 643–647, 669
handwritten text, 184, 504–506
HDTV format, 609
Header And Footer dialog box, 610
header rows (Excel)

detecting for tables, 388
hiding or displaying, 392
nonscrolling table headings, 389
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repeating on printed worksheets, 473
headers (PivotTable fields), 412
headers (presentation sections), 583
headers and footers

footers (printed worksheets), 470
footers (Word documents), 196, 222–224
presentation handouts, 646
presentation slides, 610–611
SharePoint pages, 876
Word Web App missing support, 854

headings (Word documents), 203–204, 246, 247–248, 269
Help

Backstage view, 49
balloon tips, 71
for commands, 71
Help tab, 49
for keyboard shortcuts, 71
for slide shows, 640
support options, 70–71

hidden Excel columns or rows, 483
hidden notebook page titles, 518
hidden slides, 657, 659
hidden Word text, 217–218
Hide & Unhide group, 453–454
hiding

audio icons, 681
author’s names, 566
browser interface, 838
date and time stamps, 517
fonts, 128
formula bar, 452
header rows (Excel), 392
Hide & Unhide group, 453–454
interface tabs, 838
Navigation pane, 704
nonplaying videos, 606
note containers, 495
notebook gridlines, 519
notebook page titles, 517, 518
notebook rule lines, 519
OneNote Quick Launcher, 573
Outlook elements, 704, 705
PivotTable totals or grand totals, 413
PowerPoint interface elements, 595
Quick Access Toolbar, 62
ribbon, 54, 452
ribbon tabs, 59
scroll bars, 452
slide background elements, 612
slide backgrounds, 606
slides, 657, 659, 856
slides during slide shows, 657
To-Do Bar, 705
toolbars, 838
video clips during slide shows, 606
worksheet gridlines, 452, 473

worksheet row and column headers, 452, 473, 829
worksheet rows and columns, 453–454
worksheet rulers, 452
worksheet sheet tabs, 452

Highlight Cells Rules option, 446
Highlight Changes dialog box, 828–829
highlighting

applying highlighting, 218
cells, 446
changes in Excel files, 828–829
changes in Word documents. See change tracking
data in charts, 444–450
Full Screen Reading view and, 194
hiding, 218
invalid data, 478
notebook items, 504–506
notebook keyboard shortcuts, 509
notebook tags, 528
removing, 218
searching for highlighted Word text, 213
shading, 218
with styles, 218
synchronized changes, 566
with Text Highlight tool, 218
Word Web App features, 854

history
of changes in Excel, 829, 830
document changes, 828
notebook changes, 573
SharePoint web pages, 876
SkyDrive account access, 849
visited cells, 481

History worksheet, 830
holidays on calendar, 778
Home and Business edition, 7–8, 25
Home and Student edition, 7, 25
Home Members group, 862
Home page (SharePoint), 875
Home Page tool (Word), 317
Home ribbon tab, 53
home.aspx page, 849
homonyms, 211
hosted SharePoint sites, 860
hot spots in slides, 678–679
Hotmail. See Windows Live Hotmail
HOUR worksheet function, 369
hours, 462
.htm file extension, 78, 80, 83, 84
HTML code, editing, 319, 876
.html file extension, 78, 80, 83, 84
HTML-formatted messages, 731, 820
hyperlinks. See also linking

to bookmarks, 119–120
copying from OneNote, 553
creating, 53
within current document, 119–120
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hyperlinks, continued
deleting, 120
display text for, 120
editing, 53, 120
to e-mail addresses, 120
to existing documents, files, or web pages, 119–120
inserting in text, 119–120
linking OneNote and Outlook data, 548
to new documents, 119–120
to notebook pages, 517, 530–533. See also linking
opening, 120
in presentations, 674–675
ScreenTips, 120
target frames, 120

hyphenation, 201–202
hyphens (-), 400

I
iCalendar format, 782, 785
Icon Sets conditional formatting, 448
icons

displaying in Excel cells, 448
OneNote tags, 523, 528
OneNote task management, 554–555
Quick Access Toolbar, 63
removing or rearranging in Outlook, 703
ribbon commands, 60–61

.ics file extension, 84, 782
ID, Windows Live. See Windows Live ID
IF worksheet function, 372–373
IFERROR worksheet function, 373
images. See graphics
IMAP (Internet Mail Access Protocol) incoming mail server, 

710, 736, 772, 791–792
Import And Export Wizard, 792–793
Import Spreadsheet option, 873–875
Important tags, 523
importing

bullets, 684
custom number formats, 459
data into Excel, 415–419
mail, Vista and, 793
Outlook data, 792–796
tables into SharePoint lists, 874
tags to other OneNote installations, 529–530
text files into Excel, 416–418
worksheets into SharePoint lists, 873–875

In Line With Text style, 154
Inbox, 738–739, 740, 791, 813
Inbox Repair Tool, 813
In-Cell Dropdown check box, 475
incoming mail servers, 710, 735, 791
indenting

notebook text, 508
PivotTable data, 414

subpages (notebooks), 515
text with tabs, 200

{INDEX} field code, 277
indexes (Word documents), 275–277
Info options (Backstage view), 46
Info tab

Backstage view, 49
OneNote, 49
Outlook, 49
Word, Excel, PowerPoint, 46

INFO worksheet function, 375
InfoBar, Outlook Reading pane, 707
InfoPath, 20, 869
Information option (data validation), 477
Information Rights Management (IRM), 298, 822
initials, 566, 826
ink objects, 54, 504–506. See also graphics
input devices (laser pointers), 638
Insert Captions tool, 271
Insert Category tool, 317
Insert Hyperlink dialog box, 119–120
Insert ribbon tab, 53
Insert Symbol, 110–112
Insert Table command, 253, 254–255
inserting. See also importing; linking

blog categories, 317
captions, 271
dates on notebook pages, 498
graphics on slides, 602–603
hyperlinks, 119–120
Insert ribbon tab, 53
links to external references, 480
page breaks (Excel), 472
pictures in OneNote, 502
symbols, 110–112, 462
tables, 253, 254–255
text, 107

insertion point, 107, 108
inspecting document properties, 46
Installation Options tab, 26–27
Installed On First Use option, 27
installing Office. See also upgrading Office

activating, 35–37
activation status, 37
complete components, 27
customizing installation, 34–35
file locations, 27
first use of components, 27
identifying installed Office editions, 9
Installation Options tab, 26–27
licensing agreements, 29
on multiple computers, 24
Not Available option, 27
omitting unwanted components, 27
over previous versions, 25
previewing components, 26–27
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product keys, 35–36, 37
Q drive error messages, 28
from retail media, 24–27
retaining previous versions, 32–33
Run All From My Computer option, 27
Run From My Computer option, 27
selecting components, 25
subcomponents, 27
uninstalling, 33
update settings, 39
updates, checking for, 38–39
user information, 27
validating copies, 35–37
volume-licensed copies, 37
from the Web (Click-to-Run), 27–30

installing SharePoint 2010, 860
instant messaging, 716, 847
Instant Search feature, 534, 741–753
INT worksheet function, 374
Internet. See the web
Internet E-Mail Settings dialog box, 711
Internet Explorer

Linked Notes feature and, 557
multiple-file uploads, 843
Office Web Apps support, 838
opening .mht files, 567
RSS feeds, 882
sending clippings to OneNote, 502–504
Silverlight plug-in, 853

Internet Fax, 48
Internet Mail Access Protocol (IMAP) incoming mail server, 

710, 736, 772, 791–792
Internet service providers (ISPs), 712
Internet-standard mail servers, 710
interruptions during slide shows, 641
intersecting shapes, 604
intersection operator in formulas, 361
invalid data, 474–478
investments, charting performance, 438
invitations to meetings, 695–696, 726, 780–782
IPMT worksheet function, 367
.iqy file extension, 80, 874
IrfanView picture management, 171
IRM (Information Rights Management), 298
ISBLANK worksheet function, 375
ISERROR worksheet function, 375
ISPs (Internet service providers), 712
italic text, 508

J
Journal items in Outlook, 700
.jpg file extension, 83
jumping to bookmarks (Word documents), 269
junk mail filters, 820
Just Me permission, 846

K
keyboard shortcuts (all programs). See also specific 

programs below
accelerator keys, 72
Clipboard, 129
customizing, 71–72
deleting text, 109
displaying, 71
from earlier versions of Office, 73
editing text, 116
entering text, 112, 114
finding and replacing, 137
Help for, 71
insertion point, 108
multiple keystrokes, 72
opening files, 91, 95
overview, 71–73
saving files, 95
selecting graphics, 152
selecting text, 108
text formatting, 124, 126

keyboard shortcuts (Excel)
cell formats, 378–379, 458, 460
copying cell contents, 465
finding and replacing data, 465
finding recently viewed cells, 481
formulas, 358
navigation, 350–351

keyboard shortcuts (OneNote)
bulleted lists, 499
formatting text, 508
magnifying views, 510
moving items on pages, 497
page entries, 13
page shortcuts, 513
screen clippings, 504
searching pages, 534, 536
switching notebooks, 511
tables, 502
tags, 525
text styles, 509

keyboard shortcuts (Outlook)
new items, 693
Quick Step actions, 761
unconventional, 789
viewing options, 700

keyboard shortcuts (PowerPoint), 636
keyboard shortcuts (Word)

applying styles, 228
deleting, 113
displaying, 113
field codes, 334
formatting text, 217, 220
navigating, 207
outlines, 247
SmartArt, 181
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keyboard shortcuts (Word), continued
specifying, 113
tables, 258
tracking changes, 286
window management, 209

keywords, 539, 745–751
kiosk presentations, 634
knowledge bases, 869

L
labels. See also tags

charts, 425, 433–434, 442
Excel columns or rows, 457
mailing, 320
PivotTables, 409
Quick Access Toolbar, 63
source data, 439

landscape orientation, 470
languages, 53, 140, 145–148
laser pointers, mouse as, 638
last day of month, calculating, 370
last names, 718
layering animation effects, 618–622
layouts

custom presentations, 667–670
Office Web App views, 838–839
Photo Albums, 672
PowerPoint Web App features, 856
presentation Master views, 585, 591–592, 665–670
presentation page options, 608–611
presentation slides, 581–584
SharePoint pages, 876

LEFT function, 468
LEFT range (Word table formulas), 261
legacy files, Protected View and, 819
Legacy Tools (Word forms), 303
legends, 424, 425, 427, 439
LEN function, 468
less than comparisons, 446
less than or equal to operators (<=), 359
less than operators (<), 359, 745
libraries

checking files in or out, 865–867
customizing settings and permissions, 871–872
managing files in, 870–871
SharePoint alerts for updates, 881
SharePoint site libraries, 864, 869–872

licensing agreements, 20, 29
licensing fonts, 680
ligatures, 310, 312
line breaks, 201–202, 467
line charts (Excel), 424, 432–433, 443, 450
line color, 183, 256, 307
line count, 66
line illustrations. See shapes

line numbers (Word documents), 242
line spacing, 125, 220
line sparklines, 450
line styles, 177, 256, 307, 458–459
line weight, 177, 183, 256, 307
lining up numbers, 310–312
Link dialog box (OneNote), 120, 531, 533
Link To Outlook Item command, 550
Linked Contact Notes button, 549
Linked Notes features, 557–561
linked styles in Word, 313–314
linking. See also hyperlinks

action buttons, 675
all contacts to notebooks, 551
appointments to notebooks vs. copying, 551
audio in presentations, 607
copied text in notebooks, 559
copying links from notebooks, 553, 561
Linked Notes feature, 557–561
losing links in notebook conversions, 493
notebook pages to files, web pages, or other pages, 

530–533
notebooks to Outlook, 506–507, 548, 858
pasting links into slides, 647
in presentations, 605, 609, 674–675
relinking notebooks to other content, 561
sending links to shared notebooks, 563
sending links to SkyDrive files, 847–848
SharePoint pages to Outlook data, 877–880
to SharePoint site lists, 873
slide text to Word handouts, 647
wiki-style links, 869
to workbooks and worksheets, 480
workbooks to SharePoint lists, 874

listening to audio or video, 570
lists

connecting to Outlook data, 877–880
creating in notebooks, 498–500
exporting as Web Query files, 874
history of workbook changes, 830
SharePoint alerts for updates, 881
SharePoint websites, 864
Word document features, 240–242

lists (Excel legacy feature), 387–388, 856
alternatives to, 387
customization, 483–484
data validation, 475
importing worksheets into, 873–875

live delivery of presentations, 632–641
Live Photo Gallery, 171
Live Preview, 67, 603
live previews, 54, 57, 67, 603
loan payoff, calculating, 367
local copies of shared notebooks, 562
local networks. See networks
locked files, 833
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locking
Excel row or column headers, 457
Excel worksheet panes, 456–457
files, 833

logical operators, 746
logical worksheet functions, 372–373
lookup and reference worksheet functions, 375–376
looping presentations, 634
=lorem() command, 339
Lorem ipsum text, generating, 339
LOWER worksheet function, 371

M
macros, 53, 479, 818
magnifying documents. See zooming views
mail. See e-mail
mail merge

connecting data files to documents, 322–324
data fields, 324–326
document layout, 322
document types, 321
header records in data files, 323
Mail Merge Wizard, 320–322
overview, 319
previewing results, 322, 326
printing envelopes or labels, 320
selecting data records, 322
starting documents, 321

Mail Setup dialog box, 690–691
Mailbox Cleanup dialog box, 798
mailbox size tool, 798
mailing lists vs. Contact Groups, 722
malware, 818, 820
Manage Accounts tool (Word blogs), 318
Manage Quick Steps dialog box, 762
Manage Styles dialog box (Word), 232–233
manual archiving, 799
manual syncing, 564–565
manual table formatting, 391
manual workbook page breaks, 472–473
Map Network Drive command, 94
margins

notebook pages, 520
printed worksheets, 470
Word documents, 196, 221–222

marking documents as final, 297
marking tasks complete, 525–526
markups. See also change tracking; review comments (Word 

documents)
highlighting in notebooks, 506
SharePoint pages, 876

Master views (PowerPoint), 585, 591–592, 665–670
matching rules for data validation, 474–478
math symbols, 122
math worksheet functions, 373–374

mathematical equations. See also arithmetic operations; 
numbers

AutoCorrect and, 123
component galleries, 120, 122
equation tools in notebooks, 493, 506
inserting in text, 120–123
math symbols, 122
replacing existing equations, 121
ribbon tools, 54
tools for, 121–122

.mdb file extension, 80, 416

.mde file extension, 80
measurement system conversions, 374
meetings

connecting OneNote and Outlook data, 548, 551–553
creating new, 726
invitation management, 695–696, 726, 780–782
overview, 695
recurring, 727–728
searching for, 750
sending to notebooks, 506–507
time zones, 810

merging. See also synchronizing
changes in shared notebooks, 562
combining shapes, 604
contacts in Outlook, 723
note containers, 495
notebook sections, 511
presentations, 663–665
SharePoint file changes, 867
SkyDrive file changes, 851–852
Word table cells, 266

messages. See alerts; e-mail; error messages; notifications
metadata in documents, 99
.mht file extension, 78, 80, 81, 83, 84, 567
.mhtl file extension, 78, 80, 81, 83, 84
MHTML file format, 567
Microsoft Excel 2010 Inside Out, 423
Microsoft Exchange ActiveSync, 690, 788
Microsoft Exchange server, 707, 713–714, 736, 791
Microsoft InfoPath, 20, 869
Microsoft OneNote section format (.one), 493
Microsoft OneNote Table Of Contents format (.onetoc2), 

493
Microsoft Online, 860
Microsoft Outlook Inbox Repair Tool, 813
Microsoft products. See specific products
Microsoft SharePoint Foundation 2010, 841
Microsoft SharePoint Server 2010, 841. See also SharePoint 

2010
Microsoft SharePoint Workspace 2010, 867
MID function, 468
milestones, 554
MIME HTML file format, 567
Mini toolbar, 67
Mini Translator, 146–148
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minus signs (–), 358
MINUTE worksheet function, 369
minutes, 369, 462
mixed references in formulas, 361–363
modified date searches, 748
Modify PivotTable Quick Style dialog box, 414
Modify Table Quick Style dialog box, 393
modifying. See editing
monitors

docked OneNote windows and, 558
formatting presentations for, 609
multimonitor presentation setup, 634, 639–641, 653
widescreen calendar display, 706

monochrome printing option, 644–645
MONTH worksheet function, 369
months

custom Excel formats, 461
filtering Excel tables by, 402–403
MONTH worksheet function, 369
Outlook views, 705
searching by, 747

motion path slide effects, 617
mouse as laser pointer, 638
mouse clicks

presentation action buttons, 677
timing for slide animations, 622, 624

mouse over actions, 677
mouse pointers, 107
Move Chart dialog box, 423
moving. See also navigating

calendar information, 779
charts on worksheets, 423
within documents. See navigating
e-mail items between folders, 49
files in SkyDrive, 848
graphic objects, 154, 178
note containers, 495
notebook files, 492–493
notebook page tabs, 522
notebook pages, 513
notebook pictures, 502
notebook scroll bars, 522
notebook sections, 511
notebook text, 497
Outlook folders and items, 801
PivotTable items, 411
Quick Access Toolbar, 62
shapes, 176
slide objects, 582, 588, 655–656
tags in list, 526
Word tables, 267

.msg file extension, 84
multimonitor setup

docked OneNote windows and, 558
presentations, 634, 639–641, 653
Windows Vista and, 641

multiple calendars, 778
multiple-file uploads, 843
musical background for presentation, 680–681
My Documents folder (SkyDrive), 842
My Friends And Their Friends permission, 845

N
NA worksheet function, 375
names

contacts, 718
e-mail accounts, 711
Excel tables, 389
notebooks, 492
objects in presentations, 620
OneNote tags, 528
Quick Steps, 759, 760
searching for, 748, 749
slide layouts, 668
user names, 826
worksheet cell ranges, 349–350
worksheet formulas, 349, 359

narration, 631–632
navigating. See also moving

by browse targets in Word, 205–206
collapsing or expanding OneNote Navigation bar, 521–522
to document thumbnail views, 204
jumping to bookmarks, 269
to last document edit location, 207
Navigation bar, 522
to notebook pages or sections, 511, 513
Outlook Navigation pane, 700, 702–704
presentation slides, 677
scrolling with a stylus, 207
in slide shows, 636–637
to Word document changes, 288
by Word document elements, 205–206
in Word document outlines, 247–248
in Word documents, 203–207
to Word headings, 203–204
Word keyboard shortcuts, 207
Word Navigation pane, 191
to Word review comments, 282–283
in Word tables, 258
in workbooks, 481–483

navigation buttons, slides, 677
Navigation pane

adding tool to Quick Access Toolbar, 336
displaying or hiding, 336
new features, 10
Open dialog box, 92
Outlook, 700, 701, 702–704
Word documents, 191

negative numbers, 380, 459, 460
nested functions, 357
networks

attached files in OneNote and, 507
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saving files to, 48
SharePoint 2010, 859
SharePoint server links, 864
sharing notebooks on, 493, 561
sharing workbooks on, 829
simultaneously editing documents on, 832–835
unavailable servers, 851

New Alert dialog box, 881
New Backstage view, 47
New Comment tool, 336
new features

Backstage view, 5–6
collaborating on Office files, 17
desktop publishing, 10–11
document recovery, 11
Excel, 12
Navigation pane, 10
OneNote, 12–14
Outlook, 15–17
picture-editing tools, 6–7
PivotTables, 12
PowerPoint, 14–15
restoring draft versions, 11
the ribbon, 4–5
rolling back changes, 11
search capability, 10
sharing Office files, 17
sparklines, 12
text effects, 11

New Formatting Rule dialog box, 448
New Search Folder dialog box, 751
New tab

Backstage view, 49
OneNote, 49
Word, Excel, PowerPoint, 47

New Table Quick Style dialog box, 393
New tool (Quick Access Toolbar), 336
No symbol, 564
nonbreaking spaces, 202
nonscrolling Excel rows or columns, 457
nonzero digits, 461
Normal style, 237
Normal view (PowerPoint), 580, 585, 586–588, 616
Normal.dotm template, 224
Not Applicable error message, 375
Not Available option, 27
not equal operators (<>), 359
NOT searches, 745
NOT worksheet function, 373
note containers, 495–496, 514
notebooks (OneNote). See also pages (notebooks)

attaching files to pages, 507
Backstage view of SkyDrive folders, 850
connecting to Outlook items, 506–507, 547–557
converting older versions of, 493
creating and opening, 491–495

creating in SkyDrive folders, 844
deleting, 515–516
docking, 13
docking for notetaking, 558
in Document libraries (SharePoint), 869
editing in browsers, 840
editing with Office Web Apps, 838
exporting, 566–568
features of, 490–495
file formats supported, 81, 492, 493
Format Painter, 13
keyboard shortcuts, 13
keywording, 539
linking to documents, 557–561
linking to other notebooks, 532
moving, 492–493
navigating in pages and sections, 510–516
new features, 12–14
note containers, 495–496, 514
OCR (optical character recognition), 574–575
OneNote Quick Launcher, 573
OneNote Web App, 840, 857–858
opening, 510–511, 840, 851
opening from SkyDrive folders, 851
opening OneNote from Office Web Apps, 840
organizational techniques, 542–543
pages. See pages (notebooks)
passwording, 565
Personal notebooks, 542–543
printing, 49, 568–569
printouts, 507–508, 574–575
read-only mode, 493
recently-modified pages, 539
recording audio and video, 569–572
Recycle Bin, 515–516, 572–573
saving, 49, 494
saving to SkyDrive, 850–851
searching, 534–542
sections and section groups, 511–513
sending items to, 496, 506–507
settings, adjusting, 49
sharing, 51, 561–566
sharing in SharePoint sites, 864–868
Side Notes feature, 574
simplified view of, 574
switching between, 510–511
sync status, viewing, 49
synchronizing, 561–566, 851–852
tagline advertising, 557
tags, 523–530, 540–542
templates for, 575
versions of, 572–573
wiki links in, 533

Notes item in Outlook, 698–699
Notes Master view (PowerPoint), 585, 592, 669
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Notes Page view (PowerPoint), 585, 590–591
notes, speaker. See speaker notes
notifications

in-use files ready for opening, 833
SharePoint file updates, 867, 880–883

NPER worksheet function, 367
number formats, 465–467
number forms (Word), 310–311
number sign (#), 397
numbered lists

formatting, 125
notebooks, 498–500
Word documents, 240–242

numbering
lines in Word documents, 242
Word document review comments, 280

Numbering Library, 499–500
numbers

aligning in Word documents, 311
chart axes, 427
converting to text, 371–372
as data types, 475
Excel formats, 409, 459, 461
filtering Excel tables by, 401–404, 403
generating random numbers, 484–485
sorting in Excel, 400
spacing in text, 311
worksheet cell format, 379–380

numeric keypad codes, 462, 525
numerical sorting. See sorting

O
OCR (optical character recognition), 574–575
ODD worksheet function, 374
.odp file extension, 83
.ods file extension, 80
.odt file extension, 78
Office. See also specific editions

32-bit vs. 64-bit editions, 22–23
availability of editions, 20
determining installed edition, 9
DirectX compatibility, 22
edition comparison chart, 20
e-mail security, 820–821
Home and Business edition, 7–8
Home and Student edition, 7
installing. See installing Office
licensing, 20
multiple computer editions, 21
Office Environment Assessment tool, 21
Professional Academic edition, 8
Professional edition, 8
Professional Plus edition, 8
Ribbon Hero tutoring add-in, 826
security features, 818–826
Standard edition, 8

Starter edition, 8
system requirements, 21–23
upgrade costs, 19

Office Anytime Upgrade, 33–34
Office Clipboard, 133, 134, 135. See also Clipboard
Office Environment Assessment tool, 21
Office Open XML (OOXML), 85
Office Picture Manager, 171
Office Settings Backup Wizard, 41
Office Web Apps

creating files on SkyDrive, 844
editing files on SkyDrive, 837
Excel Web App, 855–856
OneNote Web App, 857–858
PowerPoint Web App, 856–857
SharePoint Foundation and SharePoint Server, 841
simultaneous editing and, 832
supported and unsupported features, 853
URLs and paths for files, 839
viewing and editing features, 839–840
Word Web App, 854–855

offline, working, 564–565
.oft file extension, 84
older files

File Block settings, 824
Protected View and, 819
retaining versions, 32–33

old-style numbers, 310–312
“on click” option vs. timing for animations, 622, 624
.one file extension, 81, 493, 545, 567
OneNote. See also notebooks (OneNote); pages (notebooks)

connections to Outlook, 547–557, 699, 777, 858
converting older files, 493
docking windows, 13
documents. See notebooks (OneNote)
Fast Search feature, 534
file formats supported, 81, 492, 493
Format Painter, 13
functions of, 489
keyboard shortcuts, 13
new features, 12–14
OCR (optical character recognition), 574–575
Office Web App, 493, 566, 838, 840, 857–858
organizational techniques, 542–543
preferences file, 529–530
recording audio and video, 569–572
Recycle Bin, 515–516
SharePoint site file sharing, 864–868
sharing files, 492, 493
Side Notes feature, 574
simplified view of, 574
tagline advertising, 557
tags, 523–530

OneNote Options dialog box, 522, 557, 573
OneNote Package format, 568
OneNote Quick Launcher, 573
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OneNote Web App, 493, 566, 838, 840, 857–858
OneNote_DeletedPages file, 516
OneNote_RecycleBin folder, 515–516
.onepkg file extension, 81, 568
.onetoc2 file extension, 81, 493
online collaboration, 661–665. See also collaborating on 

Office files
online references for spelling check, 140
OOXML (Office Open XML), 85
Open And Repair option, 92
Open As Copy option, 92
Open Backup dialog box, 545
Open dialog box, 90–93, 300, 865
Open Existing blog tool, 318
Open File After Publishing option (Save As dialog box), 96
Open In Protected View option (Open dialog box), 92
Open tab

Backstage view, 49
OneNote, 49

opening
Backstage view, 44–45
documents, 90–93, 300, 865
file options and modes, 92
file settings, 824
files, 45
files in SkyDrive folders, 851
files on SharePoint sites, 864
linked documents from OneNote, 560
new instances of Excel, 455
notebook page templates, 574–575
notebooks to search, 536
OneNote backup files, 544–545
programs. See specific programs
programs from Office Web Apps, 840
read-only mode, 92
recent files, 336
second notebooks, 510–511

OpenType fonts, 679
operators in worksheet formulas, 357–358
optical character recognition (OCR), 574–575
optimizing files for web, 96
.oqy file extension, 80
OR searches, 535, 746
OR worksheet function, 372–373
order of operations in formulas, 363
organizational techniques (OneNote), 542–543
orientation

printing worksheets, 470
slides in presentations, 608–609
Word documents, 221–222

original sort orders, preserving, 400
.ost file format, 690, 734, 736
outgoing mail servers, 710, 711, 735
Outline Form (PivotTables), 414, 415
Outline view (PowerPoint), 586–588, 593–594, 595
Outline view (Word), 195

outlines (borders)
text effects, 183
Word text, 307

outlines (Excel)
data in PivotTables, 410
subtotaling in Excel, 404–405

outlines (OneNote), 497, 508
outlines (PowerPoint)

creating in Word, 597–599
Outline view, 586–588, 593–594, 595

outlines (Word)
collapsing or expanding levels, 247
demoting or promoting headings, 246
jumping to headings, 247–248
keyboard shortcuts, 247
navigating, 247–248
overview, 245–247
Word outlines as presentations, 597–599

Outlook. See also appointments; contacts; data files; e-mail; 
meetings; tasks (Outlook)

accounts, 707
archiving data, 734, 797–803
Auto-Complete feature, 812
Business Card feature, 717, 783–784
connecting data to SharePoint pages, 877–880
conversation view, 15–17
custom forms, creating, 53
damaged data file repair, 813
exporting data, 792–796
file formats, 84, 690, 734, 736, 793–794
files and folders management, 733–740
follow-up flags, 771–777
Home tabs, 53
importing data, 792–796
introduction, 689
items overview, 693
Journal item, 700
managing windows, 704
multiple accounts per profile, 15
Navigation pane, 700, 702–704
new features, 15–17
Notes item, 698–699
OneNote links to, 699, 777, 858
People pane, 16–17, 807
personalizing, 700–707
profile setup, 690–692
Quick Steps, 16
Reading pane, 706–707
RSS feeds in, 803–807, 882
searching in, 720, 741–753, 769
security features, 820–821
sending items to OneNote notebooks, 506–507
Social Connector, 808
synchronizing received data, 788–792
threading messages, 15–17
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Outlook, continued
time zone coordination, 810–812
To-Do Bar, 705–706, 771–772, 775
tracking message histories, 16–17
viewing options, 700–707, 753–757

Outlook Calendar Sharing Service, 786, 787
Outlook Data File (.pst) format, 690, 734, 736, 793–794
Outlook Hotmail Connector, 714–715, 736
Outlook Inbox Repair Tool, 813
Outlook Options dialog box, 743
Outlook Social Connector, 769, 807
overlapping bar charts, 443
overlapping column charts, 443
overlaying

multiple calendars, 779, 780
slide text on video, 626

Owners group, 861–862

P
packaging presentations, 682
page breaks

Excel, 469, 472–473
inserting in Word, 202, 332
searching for in Word, 212
tables spanning, in Word, 267
tracked changes and, 286
Word document views, 193
Word Web App missing support, 854

Page History view, 876
page layout options

Excel, 468, 473
Word documents, 221–222

page numbers, 66, 222–224, 268, 269, 272–273, 330, 472
Page Setup dialog box (PowerPoint), 608–609
page size

Excel, 468, 473
notebooks, 514
Word documents, 190, 221–222

Page tab (SharePoint), 875–876
pages (notebooks)

adding graphics, 502
adding text, 497–498
background images, 519
collapsing or expanding tabs for, 521
color, 518
connecting to Outlook items, 547–557
copying formatting, 13
creating, deleting, and reordering, 513–515
customizing, 516–520
date and time stamps for items, 498
docking for notetaking, 558
equations in, 506
finding tagged items, 540–542
font defaults, 67, 68
Format Painter, 13
Full Page view, 521

ink objects, 504–506
keyboard shortcuts, 13
keywording, 539
linking to documents, 557–561
links on, 530–533
list features, 498–500
margins, 520
navigating in pages and sections, 510–516
new features, 12–14
note containers, 495–496, 514
OneNote Web App features, 858
page size, 514
paper size, 520
printing multiple, 569
printouts, 574–575
recently-modified pages, 539
rules or gridlines, 518–519
saving as files, 566
searching, 534–542, 536
sending as attachments, 566–568
sharing, 561–566
Side Notes, 574
subpages, 515
synchronizing, 561–566
table features, 500–502
tagged items, 540–542
templates for, 575
text formatting, 13, 508–509
text styles, 509
titles, 517–518
versions of, 572–573
web clippings in, 502–504
wiki links in, 533

paper size options, 470, 520
paragraph breaks, 212, 854
paragraph count, 66
paragraph marks, 221, 336
paragraph spacing, 220, 221
paragraph styles, 224
paragraphs

formatting, 125–126, 219–221
linking to documents, 557
tagging, 523–530

passwords
encryption, 822
notebooks, 565
PstPassword utility, 794
sharing Word documents, 298

pasting
custom number formats, 459
data into multiple worksheets, 466–467
default paste options, setting, 132–133
invalid data, 478
links on slides, 647
links to SkyDrive files, 847
notebook pages, 513
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options for edited text, 109
pictures in OneNote, 502
previewing paste results, 130
replacing existing content, 130–132
rows or columns into chart data sources, 442
special formats and values in Excel, 465–467
text only, 132
text with formatting, 132

pausing audio or video recording, 569
payment calculations, 366–367
.pdf file extension, 48, 77, 80, 81, 83, 568, 595
pen color, 634–635
pen input, 183–184, 504–506
people. See also collaborating on Office files; sharing

adding SkyDrive permissions for, 846
People pane in Outlook, 701, 807

percent signs (%), 358
percentages, 383, 403, 446–447
performance and optical character recognition, 574–575
periods (.), 461
Permanently Delete during Outlook archiving, 802
Permanently Delete It rules action for e-mail, 766
permissions

editing documents, 46, 833
e-mail settings, 49
published calendars, 787
securing documents, 822
SharePoint, 861–863, 869, 871–872
SkyDrive, 842, 844–846, 848

personal information, removing, 821–822
Personal notebooks, 542–543
personalizing Outlook, 700–707
phone numbers, 385, 463, 750
Photo Album feature in PowerPoint, 670–672
photographs and pictures. See also graphics

3-D rotation, 167–168
adding to SharePoint pages, 876
artistic effects, 166–167
aspect ratio, 164–166
background, removing, 168–170
backgrounds for notebooks, 519
in blogs, 314, 316
borders and shadows, 54–55, 167–168
brightness, 166–167
bullets on slides, 684
color adjustments, 166–167
contrast, 166–167
converting formats, 171
cropping, 164–166, 170
default text wrapping style, 163
definition, 149
filters, 166–167
glows, 167–168
inserting in Word forms, 303
inserting into files, 53, 162–163, 237–240, 502
linking to vs. embedding, 162–163

new features, 6–7
Office Picture Manager, 171
Picture libraries (SharePoint), 864, 869
PowerPoint photo albums, 670
PowerPoint Web App, 857
red X instead of, 163
red-eye removal, 171
reflections, 167–168
resizing, 157–159
ribbon picture tools, 54
rotating, 157–159
selecting, 151–153
sharpness, adjusting, 166–167
styles gallery, 167–168
tinting, 166–167
unavailable, 163
undoing changes, 170
Windows Live Photo Gallery, 171
Word Web App, 855

Photos folder (SkyDrive), 842–843
Picture Bullet dialog box (PowerPoint), 684
Picture Content Control (Word forms), 302
Picture libraries (SharePoint), 864, 869
picture tools, 54, 855, 857
Picture With Caption slide layout, 584
pictures. See photographs and pictures
pie charts, 433–435, 441
Pie Of Pie charts, 435
pinning documents to Recent list, 46
PivotCharts, 428–429
pivoting data, 406. See also PivotTables
PivotTables

changing layout of, 409
creating, 406–410
creating from Excel tables, 395
creating from SharePoint lists, 874
dragging and moving items, 411
Excel Web App support, 856
filtering data, 412
formats and designs for, 413–415
modifying fields in, 407–409
new features, 12
outlining data in, 410
overview, 390
sorting data in, 410
styles, 414
using in PivotCharts, 428–429

placeholders
filler text, 338–339
presentation slides, 581, 593, 608, 668
Word Web App display, 854

Plain Text Content Control (Word forms), 302
Plain Text format for e-mail messages, 731
planning presentations, 631–632
playing back audio or video, 570
plot areas in charts, 424
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plug-ins. See add-ins
plus signs (+), 358
PM indicator, 462
PMT worksheet function, 366–367
.png file extension, 83
Pointer Options in slide shows, 637
points on shapes, 176–177
Pop-Out button, 838
POP/POP3 (Post Office Protocol) incoming mail server, 710, 

735, 791
portions of screens, capturing, 504
portrait orientation, 470
ports for e-mail access, 712
positioning. See aligning; moving
positive numbers, 459, 460
Post Office Protocol (POP/POP3) incoming mail server, 710, 

735, 791
posting to blogs. See blogs
PostScript fonts, 679
.pot file extension, 82
.potm file extension, 82
.potx file extension, 82
pound signs (#), 397
PowerPoint. See also presentations; slide shows; slides, 

presentation
Arrange All view, 655, 657
Comments feature, 661
file formats, 82–83, 595, 656
Master views, 585, 591–592, 665–670
new features, 14–15
Normal view, 580, 585, 586–588, 616
Notes view, 585, 590–591, 592, 669
Office Web App, 838, 856–857
opening from Office Web Apps, 840
overview, 579, 584–586
page setup, 608–609
Photo Album feature, 670–672
Presenter view, 638–641, 653
Reading view, 589–590, 595
SharePoint site file sharing, 864–868
Slide Sorter view, 585, 588–589
viewing options. See slide shows

PowerPoint Broadcast Service, 650
PowerPoint Presentation (.pptx) file format, 595
PowerPoint Show (.ppsx) file format, 595
PowerPoint Viewer, 682
PowerPoint Web App, 853, 856–857
power-saving features, 641
.ppa file extension, 82
.ppam file extension, 82
PPMT worksheet function, 367
.pps file extension, 82
.ppsm file extension, 82
.ppsx file extension, 82
.ppsx file format, 595

.ppt file extension, 82, 820

.pptm file extension, 82

.pptx file extension, 82, 83

.pptx file format, 595
predefined tags, 524
presentations. See also slide shows; slides, presentation; 

speaker notes
action buttons, 675–679
audio in, 607–608, 631–632, 680–681
backgrounds, 606, 612–613
Backstage view of SkyDrive folders, 850
broadcasting, 649–654
CD packaging, 682
collaborative, 661–665
commenting in, 661, 827
comparing, 663–665
composing, 580–593
compressing files, 596–597
converting to video, 595, 650, 673–674
creating, 47, 597–600
creating in SkyDrive folders, 844
delivering, 609–610, 632–641, 650, 682–684. See also slide 

shows
Document libraries (SharePoint), 869
editing in browsers, 840
editing locked presentations, 833
editing with Office Web Apps, 838
flattening into images, 597
fonts in, 679
graphics in, 601–605, 624, 670–672, 684
handouts, 642, 643–647, 669
layouts, 581–584, 585, 591–592, 608–611, 665–670
linking to OneNote, 557
links in, 605, 609, 674–675
merging, 663–665
multimonitor setup, 639–641, 653
music, 680
opening from Office Web Apps, 840
opening from SkyDrive folders, 851
outlining, 586–588, 593–594, 595, 597
photo albums, 670
planning, 631–632
PowerPoint Web App, 840, 856–857
Protected View disabled features, 818–820
protecting files, 663
rehearsing, 631–632
removing personal information, 821–822
resolution, 635
saving, 595
saving to SkyDrive, 850–851
sharing, 595–597, 649–654
sharing in SharePoint sites, 835, 864–868
simultaneous editing, 832
slide numbers, 66
soundtrack, 680–681
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speaker notes. See speaker notes
synchronizing with SkyDrive, 851–852
themes, 611–612, 654, 656–657, 667
tracking changes by comparing, 831
video clips in, 605–607, 625–626
Word outlines as, 597–599

Presenter view, PowerPoint, 638–641, 653
preserving original sort order, 400
previewing

animation, 617
data imports in Excel, 417
files, 91–92
installing Office components, 26–27
live previews, 54, 57
mail merge results, 322, 326
OneNote printing, 568–569
presentation themes, 612
presentations, 603
results of pasting, 130
results of printing Word documents, 327
slide transitions, 630
workbook print previews, 468–469
worksheet page breaks, 472–473

previous versions
File Block settings, 824
notebooks, 572–573
retaining, 32–33

prices, charting, 438
print areas in Excel, 471–472
Print Layout category (PowerPoint), 642
Print Layout view (Word), 193, 196
Print tab (Backstage view), 49
printer fonts, 679
printers

printer settings, modifying, 327
printer status, 327
virtual, 507–508

printing
Backstage view options, 47
booklets, 338
converting documents to other formats, 48
e-mail, 49
envelopes, 320
Excel print ranges, 471
Excel worksheets, 468–473
to fax devices, 48
files, 47
grayscale, 644–645
handouts, 642, 643–647, 669
mailing labels, 320
notebooks, 49, 507–508, 520, 574–575
Outlook items, 49
PowerPoint options, 642
previewing Word results, 327
printer settings, modifying, 327
printer status, 327

Protected View disabled features, 818
scaling options, 329
slides, 612, 659
speaker notes, 643, 670
target text, specifying, 328
virtual printers, 48, 507–508
Word document information, 329
Word Quick Print tool, 336
Word review comments, 283–285

printouts (OneNote), 507–508, 574–575
priorities in conditional formatting, 449
.prn file extension, 80
problems. See troubleshooting
product keys, 35–36, 37
Professional Academic edition, 8
Professional edition, 8, 25
Professional Plus edition, 8
profiles

OneNote tags and, 529
Outlook profile setup, 690–692

projection display, 635
projectors, 639–641, 653
projects, managing in OneNote, 553–557
promoting

headings, Word documents, 204, 246
subpages in notebooks, 515

proofing
Backstage view, 67–68
files, 67–68
tools for, 53

proofreaders’ marks, 286
PROPER worksheet function, 371
properties

e-mail, viewing, 49
file properties, 102–103, 870
inserting in Word documents, 203
setting alerts, 880–882
Word documents, 46, 99–101, 203
Word forms, 304–305

proportional numbers, 311
Protected View, 818–820, 839
protecting files

encryption and passwords, 822
Outlook data files, 794
presentations, 663

protecting personal information, 821–822
.pst file format, 690, 734, 736, 793–794
PstPassword utility, 794
Public Documents folder, 564
Public folder (SkyDrive), 842
Public permission, 845
Publish tool (blogs), 317
publishing

blogs, 317
calendars, 786–787
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punctuation
AutoCorrect and, 117
bookmarks and, 269
custom number formats, 461
entering data, 385
entering symbols, 110
file names, 347
functions in Excel, 462–463
ignoring in searches, 211
sorting in Excel, 400
special purposes in Excel, 461
symbols in names, 59
tag names, 528

Pure Black And White printing option, 644–645

Q
Q drive, 28, 30
quadrants (charts), 437
queries. See also finding and searching

connecting to SharePoint lists, 873
Microsoft Web Query File format, 874
Outlook queries generated by SharePoint, 880
Outlook search, 745–751

question marks (?), 211
Quick Access Toolbar

adding commands, 63–64
adding galleries, 56
adding toolbar groups, 335
arranging commands, 64
creating submenus, 63
customizing, 65–66, 335–336
grouped commands, 63
hiding, 62
icons, resizing, 63
moving, 62
moving commands, 63
OneNote customizations, 520–522
overview, 62
predefined lists of commands, 63
resizing, 63
restoring defaults, 61, 64
scope of changes to, 62
separator lines, adding, 63
submenus, creating, 63
text labels, adding, 63

Quick Click options, Outlook, 777
Quick Launch pane, 869, 872
Quick Launcher (OneNote), 573
Quick Layouts gallery, 425
Quick Print tool, 336, 469
Quick Steps feature for e-mail messages, 758–762
Quick Style gallery, 226–228, 233
Quick Tables feature, 254, 258
QuickTime video, 605
quotation marks ("), 462–463, 535, 536

R
radar charts, 439
=rand() command, 339
RAND function, 485
RANDBETWEEN function, 485
=rand.old() command, 339
random numbers, 484–485
range operators in formulas, 361
ranges of cells. See cell ranges (Excel)
RATE worksheet function, 367
Read permissions, 863
Reading pane, Outlook, 706–707
Reading view, OneNote Web App, 857
Reading view, PowerPoint, 585, 589–590
Reading view, PowerPoint Web App, 856
Reading view, Web Apps, 853
read-only mode

checked-out files, 866
Everyone (Public) permissions, 845
in-use files, 833
notebooks, 493
OneNote backups, 546
Protected View, 818–820

Read-Write mode, 833
rearranging. See also arranging

notebook pages, 513
notebook sections, 511
search results, 538
slides, 623, 856
tag order, 526

receiving e-mail, 788–791
recent activity

Backstage view, 46
recently used files, 46
recently viewed cells, 481
SkyDrive files and folders, 849

Recent Edits menu, 539
Recent list, 46, 336–337
recommended Word styles, 233
Record Slide Show feature, 632–633
Record Sound dialog box, 607
recording

audio for presentations, 607
audio or video in OneNote, 569–572
interactions with contacts, 549
narration in presentations, 631–633
OneNote Web App missing features, 858
quality, 571

Recording tab (OneNote), 569
Recording toolbar, 632
records, importing into Excel, 415
recovering. See restoring settings and data
recurring events in Outlook, 727–728
recurring tasks in Outlook, 776
Recycle Bin (OneNote)

backup and recovery, 543
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converting files to older versions, 493
links to items in, 551
searches including, 536
uses, 515–516
versions and, 572–573

red No symbol, 564
red Protected View messages, 820
red squiggly underlines, 139
red X picture icon, 163
red-eye removal, 171
redlined documents, 285
redoing changes, 115–116
reference tools

dictionaries, 53, 140–143
Research task pane, 144–145
ribbon tools, 53
thesaurus, 144–145

references in formulas, 356
refining searches, 744
reflections

pictures, 167–168
shapes, 178
text effects, 183
Word text, 307–309

refreshing
connections to external data, 418
data in Web Apps files, 840
external data sources (Excel Web App), 856
search results in OneNote, 541
workbooks connected to SharePoint lists, 874

regenerating tasks at future date, 776
regional options, setting, 145–146
regions in spreadsheets, 398–400
registry, 692
rehearsing presentations, 631–632
rejecting changes, 287–289, 664, 830–831
relative dates, filtering data by, 403–404
relative references in formulas, 361–363
relinking OneNote to other content, 561
Remember For Later tags, 523
reminders, 773, 774–775, 777
remote access to notebooks, 561
removing

add-ins, 825
all permissions, 846
animation, 621
attachments to e-mail, 749, 799
audio or video notes, 570
background images, 519
changes for SharePoint files, 866
color in notebook pages, 518
conditional formatting rules, 449
connections to external data, 418
contacts with links in OneNote, 551
data series from charts, 441
data validation circles, 478
data validation rules, 478

e-mail messages, 766
file permissions and, 845
files in SkyDrive, 848
files on SharePoint sites, 870
fonts, 128
headings in Word, 204
highlighting in Word, 218
hyperlinks, 120
keyboard shortcuts for, 113
lines from Word tables, 256
links in OneNote, 532–533, 560, 561
OneNote Quick Launcher, 573
OneNote Recycle Bin, 515–516
OneNote Web App features for, 858
Outlook items, 799
page breaks in Excel, 472
page titles in notebooks, 517
pages in notebook, 513
Permanently Delete during Outlook archiving, 802
Permanently Delete It rules action, 766
personal and confidential information in files, 821–822
previous versions of notebook pages, 572
profile information, 691
redundant Outlook messages, 16
restoring deleted notebooks and pages, 546
ribbon commands, 59
ribbon groups within tabs, 59
rows and columns from Excel tables, 394
slide backgrounds, 613
split bars, 456
table columns in Word, 266
table formatting in Excel, 391
table rows in Word, 266
tables in Word, 268
tabs, 199
tagline advertising, 557
tags, 525, 526
tasks, 556
text, 108–109
themes from Word documents, 229
view icons, 703
words from spelling check dictionaries, 143

renaming
files in SkyDrive, 848
graphic objects, 153
notebook pages, 513
notebook sections, 511
notebooks, 492
ribbon commands, 60
ribbon groups within tabs, 59
ribbon tabs, 59
SharePoint libraries, 872

reordering. See rearranging
repairing

broken OneNote links, 561
Outlook data files, 813
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repeating
animation, 627, 629
changes while editing text, 115–116
row and column headers on printed worksheets, 473

replacing data, 465
Reply action, e-mail, 761
reports, 390, 414
research notes, 557
Research task pane, 144–145
resizing

Excel tables, 394–395
graphic objects, 157–159
note containers, 495
notebook pages, 514
pictures, 157–159, 502
presentations, 609–610
printed worksheets, 470
Quick Access Toolbar, 63
Search Results pane, 539
shapes, 176

resolution, 635
resolving

changes to SkyDrive files, 852
duplicate contacts, 722

restoring settings and data. See also backing up settings 
and data

AutoRecover feature, 103–104
from discarded documents, 105
new features, 11
OneNote data, 543–546
OneNote pages and sections, 516, 546

Restrict Editing option, 298
Restrict Permission By People option, 298
returning to recently viewed cells, 481
Reuse Slides pane, 654–655
reusing slides and themes, 654–656
Reveal Formatting option (Word), 231–232
review comments (presentations), 661
review comments (Word documents). See also change 

tracking
browsing, 282–283
color coding by reviewer, 281
comment area size, 284
comments within comments, 282
handwritten, 280–281
identifying by reviewer, 282
inserting, 194, 280–282, 336, 827
making changes to documents, 280
merging from multiple documents, 288
navigating, 282–283
numbering, 280
printing, 283–285
reviewer name and initials, changing, 282
reviewing, 282–283
suppressing printing, 284

Review ribbon tab, 53

Reviewing pane (Word), 828
revisions. See change tracking; comparing; editing
Revisions pane, PowerPoint, 663–664
rewinding animation, 627
the ribbon

add-in management, 53
arranging commands, groups, and tabs, 58–59, 60
change tracking tools, 53
chart tools, 53, 54
Clipboard function, 53
context-sensitive tabs, 51
customizing groups and tabs, 57–58, 59, 62
default tabs, 53
deleting commands or groups, 59
dialog box launchers, 4–5
dictionary tools, 53
disabled features in Protected View, 818–820
drawing tools, 54
editing tools, 53
equation tools, 54
exporting settings to other programs, 65
file comparison tools, 53
find and replace functions, 53
form tools, 53
formatting tools, 53
galleries, 54–57
grammar tools, 53
gridline tools, 53
hiding, 54, 452
hiding tabs, 59
hyperlink tools, 53
icons, 60–61
ink tools, 54
language tools, 53
macro tools, 53
minimizing/restoring, 54
new features, 4–5
OneNote customizations, 520–522
Outlook-specific Home tabs, 53
overview, 51–54
picture tools, 53, 54
proofing tools, 53
reference tools, 53
renaming commands, groups, or tabs, 59, 60
resetting to defaults, 61
Ribbon Hero tutoring add-in, 826
ruler tools, 53
saving custom settings, 65–66
shape tools, 53
SharePoint website tools, 868
SmartArt tools, 54
spelling check and, 53, 68
sticky-note comments, 53
structure, 51–54
symbol tools, 53
table tools, 53, 54
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text box tools, 53, 54
thesaurus tools, 53
view tools, 53
Visual Basic tools, 53
window tools, 53
zoom tools, 53

ribbon galleries, 54–57
Ribbon Hero tutoring add-in, 826
Rich Text Content Control (forms), 302
Rich Text format, 731
RIGHT function, 468
RIGHT range in Word table formulas, 261
right-mouse menus, 857–858
risks. See security
rolling back changes, 11
Roman numerals, 374
ROMAN worksheet function, 374
rotating

3-D picture effects, 167–168
3-D shape effects, 178
Excel cell text, 459
graphic objects, 157–159
pictures, 157–159, 167–168
shapes, 176, 178
text, 125
text in tables, 262

ROUND worksheet function, 374
ROUNDDOWN worksheet function, 374
rounding numbers, 371–372, 374
ROUNDUP worksheet function, 374
rows

OneNote tables, 501
Word tables, 255, 266
worksheets. See rows (Excel)

rows (Excel)
adding to tables, 389, 394, 442
banded, 393
copying only visible data, 483
formatting, 393
header rows, 392
hiding, 453–454, 829
hiding by filtering data, 401–404
hiding names, 452
hiding on printouts, 473
locking for visibility, 457
maximum number of, 344
PivotTables, 406–410
selecting, 349
splitting view of, 456–457
Subtotal rows, 405
switching in charts, 431
switching in PivotTables, 411
total rows, 392, 395–396

.rqy file extension, 80
RSS feeds, 803–807, 872, 882–883
.rtf file extension, 78, 83, 84

rulers, 53, 191, 452
rules

conditional formatting in Excel, 445, 446–449
conflicting, 449
e-mail, 49, 758, 762–767
notebook pages, 518–519

Rules And Alerts dialog box, 767
Rules Wizard, 765
Run All From My Computer option, 27
Run From My Computer option, 27

S
Safari, 567, 838, 853
sample data, 484–485
Save & Backup options, 69, 543
Save & Send options, 48–49, 566, 850–851
Save As dialog box, 93. See also saving

author info, 94
compressing pictures, 94
general options, 94
mapping networked drives, 94
opening files after publishing, 96
optimizing files for web, 96
options, 94, 96
tags, 94
thumbnails, 94
titles, 94
Tools menu, 94
web options, 94

Save As options, 45, 49
Save My Settings wizard, 40
Save options, 45, 69
Save Options command, 94
Save Thumbnail option, 94
saving

automatic save frequency, 69
autosave, 103–105
changes to galleries, 56
changes to shared documents, 835
changes to SharePoint files, 866
changes to SkyDrive files, 851–852
copies of Web Apps files, 840
custom ribbon settings, 65–66
default formats for, 69
default locations for, 69
documents before inspecting, 296
documents with linked notes, 558
e-mail messages, 729
file formats for, 69
file settings, 824
files, 69
files automatically, 103–105
files in shared locations, 299–300
files to cloud-based storage, 837
files to Windows Live SkyDrive, 850–851
lists as Web Query files, 874
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saving, continued
locations for, 69
notebook pages as files, 566
notebook sections as files, 566
notebooks, 49, 491–492, 494
notebooks as files, 567–568
notebooks to older file formats, 493
Outlook data in OneNote, 547–548
Outlook viewing options, 753–757
pages as templates, 575
as PDF, 95–97
presentations, 595, 654
recorded audio or video, 570
Web App files, 844
Word templates, 236–237
as XPS, 95–97

scaling printed worksheets, 470, 471
Scanpst.exe, 813
scatter (XY) charts, 437, 440, 441
Scatter With Smooth Lines charts, 437
Schedule view in calendar, 725
scheduling

e-mail send and receive sessions, 790
managing schedules. See calendars

Scheduling Assistant, 696, 780
scientific notation cell format, 384
scope of search in OneNote, 537, 538
scope of search in Outlook, 742–743
Screen Clipping tool, 496
screen shots. See also graphics

adding to presentations, 601–602
capturing, 174–175
cropping, 174
definition, 150
documenting OneNote customizations, 530
inserting, 174–175
Screen Clipping tool, 496
sending to OneNote, 504

screens. See monitors
ScreenTips, 120, 332
scripts, preventing execution, 820
scroll bars and scrolling

hiding scroll bars, 452
moving scroll bars in OneNote, 522
notebook pages, 514
using a stylus, 207
viewing windows side-by-side, 74, 208, 289

search box (Excel), 401–402
search box (Open dialog box), 91
Search folders (Outlook), 751–753
SEARCH function, 468
Search Results pane (OneNote), 537–538
searching. See finding and searching; Windows Search
SECOND worksheet function, 369
seconds, 369, 462
section breaks, 854

Section feature in PowerPoint, 600–601
section groups, 491, 511–513, 532
Section Header slide layout, 583
sections (OneNote)

creating and modifying, 511–513
deleting, 515–516
groups, 491, 511–513, 532
linking to documents, 557
linking to other pages or notebooks, 532
navigating in, 510–516
OneNote Web App features, 858
as part of notebooks, 490–495
passwording, 565
saving as files, 566, 568
searching, 536–539
section tabs, 511
unfiled notes, 542–543

sections (PowerPoint), 600–601
sections (Word)

balancing columns, 252
column layout, changing, 250
copying formatting, 250
definition, 248–250
margins, 250
orientation, 250
paper size, 250
section breaks, 248, 249, 854
starting on new pages, 249

secure connections (IMAP), 712
securities, charting performance, 438
security

add-ins, 825
adjusting settings, 823–826
broadcasting presentations and, 651
collaborating on documents and, 817
e-mail attachments and, 820–821
notebook passwords, 565
Office 2010 features, 818–826
Outlook password protection, 794
password encryption, 298
personal and confidential information, 821–822
presentation file protection, 663
Protected View disabled features, 818–820
SkyDrive folder permissions, 844–846
warnings about external references, 480

Select Location In OneNote dialog box, 497
Select Source Data dialog box, 440
selecting

chart data ranges, 441
multiple graphic objects, 153
multiple worksheets, 466–467
notebook pages, 513
objects to animate, 620
pictures, 151–153
placeholders, 608
presentation graphics, 603
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single graphic objects, 151–153
text. See selecting text
zooming to selections, 453

selecting text
extending selections, 215
keyboard shortcuts, 108
multiple selections, 215
notebook text, 508
precision, 108
reducing selections, 215
text boxes, 151–152
transferring text to OneNote pages, 559
vertical selections, 215
WordArt, 151–152

Selection And Visibility pane, 152–153
sending

contacts and calendar events via e-mail, 782
e-mail to contacts, 716
e-mail to notebooks, 548–550
items to notebooks, 496
items to Unfiled Notes section, 542–543
links to SkyDrive files, 847–848
notebook pages as e-mail, 557
notebook pages to others, 566–568
Outlook items to notebook pages, 506–507
tasks to notebook pages, 556
web clippings to notebooks, 502–504

Send/Receive tab, Outlook, 788–791
separator lines (Quick Access Toolbar), 63
servers

connection problems, 851
e-mail, 710
Microsoft Exchange Server, 713, 780
synchronizing Outlook data with, 788–792

Set Up Show dialog box, 633–634
settings, backing up. See backing up settings and data
shading, 218, 263, 391–394
shadows, 167–168, 178, 183, 307–309
Shape commands, 604
shapes, 53, 54, 150, 175–178, 604. See also graphics
Shapes gallery, 676
Share options (Backstage view), 51
Share tab (OneNote), 51
Share Workbook dialog box, 833–834
shared files. See collaborating on Office files; sharing
Shared Notebook Synchronization dialog box, 564, 565
Shared With field (SkyDrive), 849
SharePoint 2010

announcements, 873
calendars, 873
collaboration and, 817
connecting pages to Outlook data, 877–880
creating and editing pages, 875–877
customizing websites, 868–877
file management, 870–871
groups, 861–863

hosted sites, 860
installing, 860
libraries, 869–872
link lists, 873
list features, 873–875
notifications and feeds, 880–883
offline work, 867
overview, 859
permissions, 861–863, 871–872
sharing notebooks on, 493, 562
slide libraries, 655
synchronizing files, 867
task lists, 873
users, 861
Web Parts, 876

SharePoint Designer tool, 877
SharePoint Foundation release, 860
SharePoint Online, 860
SharePoint Workspace, 20
SharePoint Workspace 2010, 867
sharing. See also collaborating on Office files

accessibility issues and, 295
appointments, 782, 784, 785
AutoCorrect settings, 118
calendars, 777, 782, 784–788
cloud-based storage, 299, 837
coauthoring documents, 291–293
Common Feed List, 804–806
contacts, 782–785
digital signatures and, 299, 822
disabling for notebooks, 564
Document Inspector and, 294–295
editing files simultaneously, 832–835
encryption and passwords, 298
files in PDF format, 95–97
files in SkyDrive folders, 299–300
files in XPS format, 95–97
files on SharePoint sites, 864–868
files one person at a time, 826–831
files over network connections, 299
IRM (Information Rights Management), 298
limiting changes to files, 298
marking files as final, 297
new Office features, 17
notebooks, 51, 507, 561–566
Office 2010 security features, 818–826
Office Web Apps and, 837
Outlook Calendar Sharing Service, 786
permissions, 298, 844–846
preparing files for distribution, 293–296
presentations, 595–597, 649–654
preventing unauthorized changes, 296–299
protecting sensitive information, 294
Public Documents folder and, 299, 564
read-only mode, 297
restricting access, 298
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sharing, continued
RSS feeds, 804–807
saving files before inspecting, 296
saving files in shared locations, 299–300
security and, 817
simultaneous editing, 291–293, 833
SkyDrive files and folders, 844–846, 847–848
workbooks, 829, 833

sharpness, pictures, 166–167
sheet tabs (worksheets), 452
shortcuts. See also keyboard shortcuts

copying links from OneNote, 553
Quick Step actions, 758
right-mouse menus, 857–858
SharePoint servers, 864

shortening URLs, 652
Show All tool, 336
Show Previous Versions option, 93
shrinking Excel tables, 394–395
side-by-side viewing

calendars, 778
Side Notes and notetaking, 574
synchronous scrolling, 74, 208, 289
Word document windows, 208

signatures, digital, 299, 822
signatures, e-mail, 557, 731
significant digits, 461
signing in with Windows Live ID, 847
Silverlight plug-in, 853
Simple Mail Transfer Protocol (SMTP) outgoing mail server, 

710, 735
Simple Message Service (SMS), 784
simultaneous editing, 832–835, 851–852, 866–867
SIN worksheet function, 373
Single-File Web Page format, 567, 568
64-bit editions, 22–23, 39
skipping columns in Excel imports, 417
SkyDrive. See Windows Live SkyDrive
Slide Library, 655
Slide Master view, 585, 591–592, 665–668
Slide pane, 580, 586
Slide Show view, PowerPoint Web App, 856
slide shows. See also presentations; slides, presentation

annotations on slides, 637
broadcasting, 650–652
creating custom, 657–661
Help feature, 640
hiding nonplaying video during, 606
hiding slides in, 657
laser pointer mouse option, 638
navigating in, 636–637
overview, 586, 592–593
Picture libraries (SharePoint), 869
PowerPoint Web App, 856
Presenter view, 638–641, 653

recording, 632–633
Rehearse Timings option, 631–632
transitions, 629
viewing restrictions on broadcast type, 654

Slide Sorter view, 585, 588–589
slides, presentation. See also animation; presentations; slide 

shows
adding from Word outlines, 599
agendas, 675
aligning objects on, 603
annotations, 637
bullets, 684–685
composition guidelines, 594
copying and moving, 582, 588, 655–656
decks of, 581
as document backgrounds, 226
duplicating, 582, 588, 655–656
editing text, 593–595
elements of, 580
formatting text, 587, 608, 679–680
graphics on, 602
headers and footers, 610–611
hiding, 658, 856
hot spots on, 678–679
layouts, 581–584
navigation buttons, 677
orientation of, 608–609
overlaying text on video, 626
overview, 579
placeholders, 581, 593, 608
printing, 612, 659
reordering, 856
reusing, 654–656
sections of, 600–601
sizing, 609
sorting, 585, 588–589
templates, 599
text size, 594
titles, 660
transitions between, 588–589, 629–631
video clips on, 605–607, 625–626

Slides Sized For list, 609
.slk file extension, 80
slowing animation, 627
small caps, 217
smart guides, PowerPoint, 604
SmartArt. See also graphics

adding text to, 180–181
animating in presentations, 619
creating lists, 242
definition, 150
inserting, 180–182
keyboard shortcuts, 181
PowerPoint Web App features, 857
tools for, 54
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SMS ( Simple Message Service), 784
SMTP outgoing mail servers, 710, 712, 735
snapshots

downloading from Excel Web App, 856
notebook pages, 572

snippets, sending to OneNote, 502–504
snurl.com, 652
Social Connector, 769, 807, 808
social networking. See also blogs

Outlook connection to, 769, 807, 808
permissions for files and, 845

Social Security numbers, 385
soft edges on shapes, 178
Some Friends permission, 845
Sort & Filter menu, 398
Sort dialog box, 399
sorting

contact display names, 718–719
contacts, 718
custom series of data, 483–484
Excel data, 398–400
Excel data alphabetically, 398
Excel tables, 389, 398–400
Excel Web App features, 855
OneNote search results, 538
PivotTable data, 410
problems with PivotTables, 412
SharePoint library views, 872
slides, 585, 588–589
Word table data, 259–260

sound. See audio
soundtracks for presentations, 680–681
source data. See data sources
space, adding to notebook pages, 514
spam filters, 820
sparklines, 12, 450
Speak command, 337–338
speaker icon in presentations, 633
speaker notes

creating, 642
PowerPoint Web App features, 856
printing, 643, 670
viewing options, 580, 585–586, 590–591, 592, 669

special characters
AutoCorrect and, 117
bookmarks and, 269
custom number formats, 461
entering data, 385
entering symbols, 53, 110
entering with AutoCorrect, 112–113, 200–201
entering with Insert Symbol, 110–112
in Excel cells, 448
file names, 347
functions in Excel, 462–463
ignoring in searches, 211

OneNote tags, 528
searching for, 212
sorting in Excel, 400
special purposes in Excel, 461
symbols in names, 59
tag names, 528
wildcard characters, 211

special effects
pictures, 166–167
PowerPoint Web App features, 857
shapes, 178
sound effects, 628
themes, 186
Word text, 307–309
Word Web App display, 854

speech input, 109
speech recognition, 109
spelling check dictionaries, 140–143
spelling check. See also grammar checking

AutoCorrect, 140
correcting entire documents, 141
correcting single words, 139–140
customizing, 68, 141–142
ignoring suggestions, 140
interactive, 140
invoking, 53
languages, 140, 145–146
limiting scope, 140
online references, 140
overview, 139
regional options, 145–146
squiggly red underlines, 139
Word documents, 242–243

spinning arrows icon, 564
split bars, 456–457
Split Table tool, 268
splitting

note containers, 495
notebook sections, 511
text into multiple cells, 467–468
Word document windows, 208, 209
Word table cells, 266
Word tables, 268
worksheet panes, 456–457

spreadsheets. See workbooks and worksheets (Excel)
squiggly green underlines, 242
squiggly red underlines, 139
stacked area charts, 436
stacked column charts, 429, 431–432
stacked objects, rearranging, 156–157
Standard edition, 8
Start Date for follow-up flags, 773
Starter edition, 8, 30–32
starting animations, 622
statistical worksheet functions, 373
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statistics for documents, 66
status bar, 66, 67, 335–336
Sticky Notes gadget, 699
sticky-note comments, 53
Stinson, Craig, 423
stock charts, 438, 441
Stop option (data validation), 477
stopping

animations, 622
audio or video recording, 569
bulleted or numbered lists, 500

strikethough text, 508
structured references in Excel tables, 389, 397
stssync protocol, 880
Style Inspector, 232
styles. See also text formatting

applying, 226–228, 335
automatic update, enabling, 235
basing on existing styles, 234
character styles, 224
copying between documents or templates, 233
creating, 233–235
defaults, setting, 232
displaying, 232
editing, 232
Excel cell styles, 463–464
Excel PivotTables, 414
Excel tables, 388, 391–394
Excel Web App missing support, 855
following paragraphs, 234
font color, 235
fonts, 235
formatting options, 235
making global changes, 229
names, 229
Normal, 237
OneNote text, 509
OneNote Web App, 858
paragraph styles, 224
pictures, 167–168
Quick Access Toolbar, 335
Quick Style gallery, 226–228, 233
recommended, 233
replacing, 231
restricting format changes, 230, 232
Reveal Formatting option, 231–232
shapes, 177–178
SharePoint pages, 876
storing. See templates
Style Inspector, 232
Word keyboard shortcuts, 228
Word tables, 263–264
Word Web App features, 854

stylistic sets, 311–312
stylus input, 506

subfolders
archiving, 800
limiting search to, 743
permissions, 844
section groups as, 513
SharePoint sites, 870–871
Windows Live SkyDrive, 842

subject searches, 748
submenus, Quick Access Toolbar, 63
subpages (OneNote), 491, 493, 515
subscribing to feeds, 804, 882
substitute fonts, 216
subtasks, 554
Subtle slide transitions option, 630
SUBTOTAL function, 396, 404–405
Subtotal rows (Excel), 405, 413
subtracting shapes, 604
Suggested Contacts folder, 813
=SUM worksheet formula, 359
summarizing data in Excel, 404–405
summary alerts, 882
Summary pages in OneNote searches, 541–542
summary.aspx page, 849
summing numbers, 359
support options, 70–71. See also Help
surface charts, 439
swapping axes, 431
Switch Windows tool, 335
switching

notebook pages, 513
profiles, 692
views, 53
windows, 53, 73–74, 209, 335
Word views, 196–197

Symbol dialog box, 111–112, 200
symbols. See special characters
sync intervals, 562
sync status, notebooks, 49, 564
synchronization markers (OneNote), 570
synchronizing

audio or video with notes, 569
files with SkyDrive, 851–852
intervals for, 562
notebook markers, 570
notebook sync status, 49, 564
notebooks, 530, 561–566
Outlook data, 788–792
Outlook data with SharePoint sites, 877–880
SharePoint notifications and feeds, 880–883
tag formats, 528
Windows Live Hotmail, 792
working offline and syncing later, 564–565

synchronous scrolling, 74, 208, 289
system environment information, returning, 375
system requirements, 21–23
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T
tab characters. See tabs (text)
tab interface. See tabs (interface)
table of contents features. See tables of contents
table styles (Excel), 393, 855
Table Styles gallery (Excel), 391–394
tables

Access tables, 416
Excel tables. See tables (Excel)
inserting, 53
notebooks, 500–502
PowerPoint, 857
tools for, 54
Word tables. See tables (Word)

tables (Access), 416
tables (Excel)

adding rows or columns to chart data, 442
converting lists to, 387–388
creating and formatting, 387–389
features of, 389
filtering, 389, 401–404
formatting with table styles, 391–394
importing into SharePoint lists, 874
resizing, expanding, or shrinking, 394–395
sorting, 389, 398–400
styles, 388
total rows, 392, 395–396
using as PivotTables, 395

tables (OneNote), 500–502
tables (PowerPoint), 857
tables (Word)

aligning text, 262
AutoFitting, 255
borders, 263
captions, 270–271
cells, 258, 259, 266
columns, 255, 264–266
converting text to, 253, 256–257
copying formatting, 250
creating, 253, 254–255
deleting, 266, 268
drawing, 253, 256
empty grids, 253, 254–255
erasing lines, 256
fixed-width columns, 255
form layout, 302
formulas, 260–261
galleries, 254, 258
height, 264–266
inserting, 266
inserting Excel worksheets, 261
keyboard shortcuts, 258
layouts, 264–267
line formatting and color, 256
merging or splitting cells, 266

navigating, 258
numeric calculations, 260–261
overview, 253, 261–262
page breaks and, 267
positioning, 267
Quick Tables, 254, 258
rotating text, 262
rows, 255, 264–266
selecting cells, 259
selecting entire table, 259
selecting multiple cells, 259
selecting text within cells, 259
shading, 263
sorting data, 259–260
splitting tables in two, 268
styles, 263–264
tab characters in, 259
text wrapping options, 267
Word Web App missing support, 855

tables of contents (notebooks), 493
tables of contents (Word documents), 273–275
Tablet PCs, 506
tabs (interface)

arranging commands, groups, and tabs, 58–59, 60
hiding, 838
ribbon tabs, 59

tabs (notebooks), 522
tabs (text)

indenting text, 200
removing, 199
setting, 198–200
tab characters, 259
tab delimiters, 417

tabs (worksheets)
color coding, 347
finding quickly, 456
viewing side-by-side, 455

Tabular Form PivotTables, 414, 415
tabular numbers, 311
tags

applying or removing, 525–526
check box symbols, 525
customizing, 526–528
document metadata, 94
elements of, 528
finding tagged notes, 540–542
limitations, 525
notebook pages, 517, 523–530
OneNote Web App, 858
rearranging, 526

Tags Summary pane, 524, 540–542
taking notes, 558, 560, 574
TAN worksheet function, 373
TANH worksheet function, 373
target frames for hyperlinks, 120
Task dialog box, 555
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Task Manager, 455
tasks (OneNote), 548, 553–557
tasks (Outlook)

connecting OneNote and Outlook data, 506–507, 548, 
553–557

connecting Outlook to SharePoint pages, 873, 877–880
flagging items for list, 774–776
importing and exporting, 792
overview, 698
search keywords, 751
SharePoint alerts for updates, 880–882
To-Do Bar display, 705

team calendars, 878
telephone numbers, 385, 463, 750
templates

applying, 235–236
blogs, 318
calendars, 47
copying styles between, 233
creating documents from, 47, 97–98
downloading, 98
modifying, 236–237
Normal.dotm, 224
notebook pages, 575
overview, 224
presentations, 594, 599, 600, 667, 669
saving, 236–237
SharePoint files, 863, 869, 872, 875
specifying locations for, 99
Word documents, 224–225
Word forms, 301
Word Web App missing support, 854
workbooks, 479

temporary folders for imported Outlook data, 796
Temporary Internet Files folder, 819
tentative meeting acceptance, 727, 781
testing conditions in Excel, 444
text

in documents. See text (documents)
effects, 11, 182–183
e-mail, 731
entering. See text entry
finding and replacing, 136–138
formatting. See text formatting
importing, 416–418
labels on Quick Access Toolbar, 63
in notebooks. See text (notebooks)
in presentations. See text (presentations)
selecting, 108
snippets, 502–504
styles. See styles
text boxes, 53, 54, 150, 151–152, 175–178
text files. See text files
text recognition, 574–575
web pages, 503, 853
in workbooks. See text (workbooks)

text (documents)
converting to WordArt, 182–183
copying with the keyboard, 130
deleting, 108–109
formatting. See text formatting
formatting in Word Web App, 854
handwritten, converting to typed characters, 184
indenting with tabs in Word documents, 200
keyboard shortcuts, 109
text-to-speech conversion, 337–338
wrapping style, graphic objects, 154

text (e-mail), 731
text (notebooks)

adding to pages, 497–498
date and time stamps for, 498
formatting notebook text, 508–509
notebook text, 509
OneNote Web App features, 858
snippets, copying to OneNote, 502–504
styles in notebooks, 509
tagging in OneNote, 523–530

text (presentations)
animating, 626
character formatting, 587, 608, 679–680
editing, 593–595
formatting, 587, 608, 679–680
overlaying on video, 626
placeholders in slides, 581, 593, 608
recommended sizes, 594

text (web pages)
Silverlight plug-in and, 853
web page text display, 503

text (workbooks)
converting to numbers, 372
customizing formats in Excel, 460, 462–463
filtering Excel tables by, 403
limiting comments in Excel cells, 476
manipulating and splitting in Excel, 467–468
text worksheet functions, 370–372
values in data series, 441
worksheet cell formats, 384

Text Box option for presentation slides, 593
text boxes, 53, 54, 150, 151–152, 175–178. See also graphics
text effects, 11, 182–183
text entry

ASCII character codes, 114–115
AutoCorrect, 112–113
boilerplate, 116–118
hyperlinks, 119–120
keyboard shortcuts, 112, 114
mathematical equations, 120–123
often-used blocks, 116–118
overview, 107
special characters, 110–112
speech input, 109
Unicode character codes, 114–115



	 times	 929

text files
.csv file format, 80, 257, 418, 425, 793
in Excel, 80
importing, 416
in Outlook, 84
in PowerPoint, 83
in Word, 78

text formatting. See also fonts; styles
alignment, 125, 126
all caps, 217
borders, 307
bulleted lists, 125
character formatting, 124–125, 215–218, 587, 608, 679–680
colors, 308
copying, 128–129
drop caps, 313
Excel cells, 124
filler text, generating, 338–339
fills, 308, 309
finding and replacing, 136–138
font substitutes, 216
fonts, 312
formatting marks, 221, 336
glow effects, 308
gradients, 308
hidden text, 217–218
highlighting, 218
keyboard shortcuts, 124, 126
ligatures, 310, 312
line color, 307
line spacing, 125, 220
line style, 307
line weight, 307
lining up numbers, 310–312
with linked styles, 313–314
notebook styles, 509
notebook text, 508–509
number alignment, 311
number forms, 310–311
number spacing, 311
numbered lists, 125
old-style numbers, 310–312
paragraph formats, 125–126, 219–221
paragraph marks, 221, 336
paragraph spacing, 220, 221
Plain Text format, 731
presentation outline text, 587
presentation slides, 587, 608, 679–680
proportional numbers, 311
reflections, 307–309
ribbon tools for, 53
rotating text, 125
shadows, 307–309
small caps, 217
special effects, 11, 182–183, 309
stylistic sets, 311–312

tabular numbers, 311
textures, 309
Word keyboard shortcuts, 217, 220
Word outlines, 307
in Word Web App, 854
WordArt, 309

Text Highlight tool, 218
Text Import Wizard, 416–418
text messages, 784
text recognition, 574–575
text styles, 509
TEXT worksheet function, 372
text worksheet functions, 370–372
text wrapping, 154, 163, 195, 237–240
text-to-speech conversion, 337–338
textures

shapes, 177
text, 182–183, 309

theme (.thmx) file format, 656
themes

displaying names, 66
e-mail messages, 809–810
Excel tables, 391
fonts, 127–128, 186
galleries of, 55
overriding, 185
presentations, 611–612, 654, 656–657, 667
removing, 229
reusing, 656
Word documents, 185, 186

thesaurus tools, 53, 144–145
32-bit edition vs. 64-bit, 22–23, 39
.thmx file extension, 82, 656
threaded discussions

connecting Outlook to SharePoint pages, 877–880
on SharePoint sites, 864
viewing e-mail messages as, 755–756

3-D graphic rotation, 167–168, 178
thumbnail views

displaying, 46
navigating, 204
Picture libraries (SharePoint), 869

.tif file extension, 83
tiled windows, 455
time zone coordination, 810–812
timelines, 553–557
times. See also dates

appointments and meetings, 726
audio or video recording time stamps, 570
converting text to time values, 370
as data types, 476
date serial numbers, 368
Excel formats for, 381–382, 460, 461–463
filtering Excel tables by, 402–403
inserting in Word documents, 202–203
notebook date and time stamps, 498, 517, 566
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times, continued
on OneNote screen captures, 504
Outlook calendars, 727
recording elapsed time, 461
returning current time in Excel, 369–370
selecting in Word forms, 303, 306
sorting in Excel, 400
time serial numbers, 369
timeline management, 553–557
today’s date in Excel, 352, 369
worksheet functions for, 368–370

timesheets for elapsed time, 461
TIMEVALUE worksheet function, 370
timing

rehearsing slide shows, 631–632
slide animations, 622–624, 627
transition effects for slides, 631

tinting pictures, 166–167
tinyurl.com, 849
Title And Content slide layout, 583
Title Only slide layout, 583
Title slide layout, 583
titles

charts, 424
contacts, 718
documents, 94
notebook pages, 517–518
presentation slides, 660

To Do tags, 523
To-Do Bar, 701, 705–706, 771–772, 775
Tools menu, 94
Tools ribbon tab, 54
top, moving to, 514
Top Ten conditional formatting, 446–447
Top Ten filtering, 403
total rows (Excel), 392, 395–396
totaling numbers

PivotTables, 390, 413
SUBTOTAL function, 404–405
total rows, 392, 395–396

touch-enabled PCs, 506
tracking changes. See change tracking
transitions between slides, 588–589, 629–631, 856
Transitions gallery, 629
transposing data in Excel, 466
trial edition, upgrading from, 32
triggering

animations in slides, 625–626
conditional formatting, 449
e-mail rules, 764

trigonometry worksheet functions, 373–374
Trim Video option, PowerPoint, 606
TRIM worksheet function, 371
troubleshooting

clipping text or graphics, 221
cropping graphics, 238
CSV files, converting to tables, 257

Excel conditional formatting, 449
Excel data series values, 441
Excel date arithmetic format problems, 370
Excel dates are off by four years, 368
Excel History worksheet, 830
Excel invalid data, 478
Excel invalid functions, 365
Excel PivotTable sorting, 412
Excel table fonts and colors are odd, 394
Excel tracked changes, 829
Exchange server sync restrictions in Outlook, 791
Flag option restrictions for IMAP accounts, 772
grouped objects won’t ungroup, 162
IMAP folders missing from Navigation pane, 740
links to deleted OneNote pages, 551
Microsoft Office Compatibility Pack, 88
OneNote searches, 536
OneNote shared notebooks, 564, 834
OneNote web page display, 503
opening files in Protected View, 819
Outlook broken e-mail conversations, 757, 758
Outlook data file damaged, 813
Outlook linked tasks, 556
Outlook RSS feeds, 806
picture edits disappeared, 171
PowerPoint animation, 621
PowerPoint broadcast presentations, 653
PowerPoint slide comments disappeared, 662
product keys, 37
Q drive errors, 28
Quick Steps disappearance, 759
ruler issues, 452
SkyDrive folder type is wrong, 850
uploading multiple files, 843
Windows Live Hotmail, 738
Word blogging, 316, 317
Word text-to-table conversions, 257
Word Web App display, 854

TRUE results in data validation, 476
TrueType fonts, 679
Trust Center dialog box, 823–826
Tufte, Edward, 423
Two Content slide layout, 583
.txt file extension, 78, 80, 83, 84

U
unavailable servers, 851
UNC shares, 562
unchecked items in OneNote, 540
underlined text, 508, 828
underscore character (_), 463
undocking OneNote window, 559
undoing changes

AutoCorrect, 118
editing text, 115–116
pictures, 170–171
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Unfiled Notes feature, 542–543, 574
unfreezing worksheet panes, 457
ungrouping

clip art for animation, 624
PivotTable data, 412–413

unhiding rows and columns, 454
Unicode characters, 114–115, 400
uninstalling Office, 33
uniting shapes, 604
units of measure

converting with worksheet functions, 374
for graphic objects, 160

unlinking. See breaking
UnMHT add-on, 567
Unread Mail search folder, 763
unsafe locations, 819
updating. See also upgrading Office

checking for Office updates, 38–39
external data sources (Excel Web App), 856
notifications and feeds, 880–883
read-only file copies with changes, 833
SharePoint file notifications, 867
update settings, 39
worksheets with collaborative edits, 834
worksheets with external references, 480

upgrading Office, 19, 30–34. See also installing Office
Upload Manager, 851–852
Upload Pending message, 851
uploading

changes to SkyDrive files, 851–852
files instead of e-mailing, 821
files to SharePoint libraries, 870–871
files to SkyDrive, 843
multiple files, 843
pictures to SharePoint libraries, 869

UPPER worksheet function, 371
URLs (uniform resource locators)

capturing screens and URLs from web pages, 504
paths for Office Web Apps, 839
SharePoint files, 864
shortening service for, 652, 849
SkyDrive files and folders, 849
understanding Windows Live SkyDrive, 849

user information, 27
user names, 826
user profiles, 529
users accounts on SharePoint, 861

V
validating

data in Excel, 474–478
Office installations, 35–37

validation rules, 474–478
Value Field Settings dialog box, 408–409

VALUE worksheet function, 372
values (cells)

color representations, 447
copying, 465
data bars, 445
data validation, 475
testing conditions, 444
top or bottom ten percent, 446–447
VALUE worksheet function, 372

.vbs files, 820–821
vCard format for sharing contacts, 782, 784
.vcf file extension, 84, 782
.vcs file extension, 84
version control (files)

checking files in or out from SharePoint, 865–867
documents, 46
notebooks, 572–573
SharePoint libraries, 869, 872
SharePoint pages, 876

versions of Office files, Protected View and, 819
video clips

converting presentations to, 595, 650, 673–674
exporting from OneNote, 570
hiding after playing, 625
OneNote Web App missing features, 858
PowerPoint Web App features, 857
as presentation broadcast method, 650
in presentations, 605–607, 625–626
recording in OneNote files, 569–572
Windows DVD Maker, 673

View button, 91
View ribbon tab, 53
Viewers group, 863
viewing. See also specific views

document properties, 100–101
full pages in OneNote, 521
magnifying view in Excel, 453
Outlook options, 700–707, 753–757
side by side, 74, 455
switching between views, 53
synchronous scrolling, 74, 208, 289

virtual OneNote printouts, 507–508
virtual printers, 48
viruses, 818, 820
visibility of graphic objects, 153
Visual Basic, 53
visualizing data with charts, 421–423

W
warnings

customizing, 478
Excel data validation, 477
external Excel references, 480

watermarks, 222
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the web
calendar sharing via, 786
cloud-based storage, 837
installing Office from, 24, 27–30, 35, 38
Internet-standard mail servers, 710
Protected View and, 819
saving files to, 48
SharePoint, 859
sharing calendars on, 785
sharing notebooks on, 561
synchronizing notebooks over, 562

web addresses (URLs). See URLs (uniform resource locators)
Web Apps. See Office Web Apps
web-based calendars, 786
web-based e-mail services, 714–715, 757, 786. See also 

Windows Live Hotmail
web-based files in Protected View, 819
web-based storage. See Windows Live SkyDrive
web browsers. See browsers; specific browsers
Web Layout view (Word), 195
web options for saving files, 94
web pages. See also wiki pages

copying to OneNote, 502–504
creating with SharePoint, 875–877
creating with wiki links, 869
hyperlinks to, 119–120
linking to OneNote, 531, 557
SharePoint Designer tool, 877
SharePoint site design, 864
Silverlight plug-in and, 853
text display in OneNote, 503
URLs on screen captures, 504
wiki pages, 869

Web Parts, 876
Web Query File format, 874
webmail, 714–715, 757, 786. See also Windows Live Hotmail
websites. See also blogs; wiki pages

child sites, 863
creating SharePoint sites, 863–864
customizing, 868–877
document libraries, 869
exploring SharePoint sites, 861–863
file management, 870–871
form libraries, 869
picture libraries, 869
SharePoint libraries, 869–872
SharePoint overview, 859
templates, 863
wiki libraries, 869

Week view in calendar, 725
weekly alerts, 882
weeks

searching by, 747
Week view in calendar, 725
weekly alerts, 882

widescreen format, 609–610, 706

wiki pages
creating new pages with links, 869
notebook page links, 533
Wiki Page libraries (SharePoint), 864, 869

wildcard characters, 211
window management

arranging windows, 73–74, 208
comparing window contents, 73–74
Excel worksheets, 454–456
keyboard shortcuts, 209
opening new windows, 208
restoring window positions, 208
side-by-side viewing, 74, 208
split windows, restoring, 209
splitting current window, 208, 209
splitting, freezing, or locking panes, 456–457
switching windows, 73–74, 209, 335
synchronous scrolling, 74, 208
Word Web App features, 854–855
zooming, 196–197

Windows 7, 546, 641, 673, 699, 741
Windows DVD Maker, 673
Windows Explorer, 848
Windows Live Folders. See Windows Live SkyDrive
Windows Live Hotmail

calendar sharing via, 786
connecting to Outlook, 714–715, 736
meeting request features, 781
synchronizing e-mail, 792
troubleshooting availability, 738

Windows Live ID
disabling for file viewing, 847
sharing calendars, 786
sharing files on SkyDrive, 850
SkyDrive permissions and, 845
URL display and, 849
viewing broadcast presentations, 649
viewing SkyDrive files, 846

Windows Live SkyDrive
accounts, 842, 843
attached files in OneNote and, 507
copying notebooks to, 566
editing files with Office Web Apps, 837
folder types, 842–843
managing files and folders, 848–850
Office Web Apps and, 841
permissions, 844–846
private folders, 846
saving files to, 850–851
sharing folders and files, 299–300, 847–848
sharing notebooks on, 493, 562
synchronizing files with, 851–852
understanding URLs, 849
uploading files, 821, 843

Windows Live Sync, 530
Windows Media Audio Voice, 571
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Windows Media Video, 571, 605
Windows registry, caution against editing, 692
Windows Search, 103, 491, 534, 741, 747
Windows Server 2008, 860
Windows SharePoint Services, 860
Windows Vista, 546, 641, 673, 741, 793
Windows XP, 103, 534, 741, 793
wizards

Import And Export Wizard, 792–793
Mail Merge Wizard, 320–322
Office Settings Backup Wizard, 41
Rules Wizard, 765
Save My Settings wizard, 40
Text Import Wizard, 416–418

.wmf file extension, 83

.wmv file extension, 83
Word. See also documents (Word); forms (Word)

blogging with. See blogs
building blocks. See building blocks (Word documents)
converting outlines into PowerPoint presentations, 597–599
desktop publishing, 10–11
document recovery, 11
documents. See documents (Word)
editing PowerPoint handouts in, 646
file formats supported, 77–78
mass mailings. See mail merge
MHTML support, 567
Navigation pane, 10
opening from Office Web Apps, 840
resetting to default options, 337
restoring draft versions, 11
rolling back changes, 11
search capabilities, 10
SharePoint site file sharing, 864–868
text effects, 11
Word Web App, 838, 840, 854–855

word count, 66
Word Viewer, 567
Word Web App, 838–839, 853, 854–855
WordArt, 150, 151–152, 182–183, 309. See also graphics
word-wheel search in Outlook, 742
Work Week view in calendar, 724–725
Workbook Connections dialog box, 418
workbooks and worksheets (Excel)

arranging windows for, 454–456
Backstage view of SkyDrive folders, 850
borders, 458–459
cells. See cells (Excel)
charts, 423
commenting in, 827
constants, naming, 349
copying and moving data, 465
copying cell contents or formats, 355
copying worksheets, 347
creating in SkyDrive folders, 844
creating workbooks, 47

creating worksheets, 346
current sheet name, 346
customizing views of, 451–457
data validation, 474–478
default formatting, 478–479
default number of worksheets, 345, 479
deleting worksheets, 346
Document libraries (SharePoint), 869
dragging fill handles, 354–355
editing conflicts in, 834
editing in browsers, 840–841
editing with Office Web Apps, 838
End Mode, 351–352
entering today’s date, 352
Excel Web App features, 855–856
extending cell ranges, 353–354
filling cell ranges, 352–356
finding and editing data, 465
font defaults, setting, 67
formatting, 458–464
grouping worksheets, 467
hiding rows and columns, 453–454
hiding worksheets, 347
History worksheet, 830
importing into SharePoint lists, 873–875
inserting in Word documents, 260–261
jumping to specific cells, 349
linking with external references, 480
moving worksheets, 347
multiple worksheets, advantages of, 344
navigation keyboard shortcuts, 350–351
opening from Office Web Apps, 840
opening from SkyDrive folders, 851
pasting data into multiple worksheets, 466–467
PivotTables, 406
printing, 468–473
problems sharing on SharePoint sites, 835
Protected View disabled features, 818–820
regions, definition, 348
removing personal information, 821–822
saving to SkyDrive, 850–851
selecting data, 349, 351
shared workbooks, 829
SharePoint alerts for updates, 880–882
sharing in SharePoint sites, 864–868
simultaneous editing, 832–835
splitting, freezing, or locking panes, 456–457
synchronizing with SkyDrive, 851–852
tables, 344
tracking changes, 828–831
updating with collaborative edits, 834
worksheets defined, 344
zooming view of, 453

WORKDAY worksheet function, 370
workgroup collaboration. See collaborating on Office files
working offline, 564
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.wpd file extension, 78, 83

.wps file extension, 78, 83
wrap points, 239
wrapping text around graphics, 154, 163, 195, 237–240
wrapping text in tables, 267
writing, 54, 504–506

X
{XE} field code, 275–276
.xla file extension, 79
.xlam file extension, 79
.xlm file extension, 79
.xls file extension, 79, 820
.xlsb file extension, 79
.xlsm file extension, 79
XLStart folder, 479
.xlsx file extension, 79
.xlt file extension, 79
.xltm file extension, 79
.xltx file extension, 79
.xlw file extension, 79
XML editors, 869
.xml file extension, 78, 80, 83
XML Paper Specification (XPS), 48, 568
XPS (XML Paper Specification), 48, 568
XPS Document Writer, 48
.xps file extension, 78, 80, 81, 83
XY (scatter) charts, 437, 440, 441

Y
Yahoo Mail, 715
YEAR worksheet function, 369
years

custom Excel formats, 462
filtering Excel tables by, 402–403
searching by, 747
YEAR worksheet function, 369

yellow Protected View messages, 819

Z
zero values, 460
ZIP archive files, 821
ZIP codes, 385
Zoom dialog box, 453
Zoom entrance slide animation effect, 619
Zoom slider, 453
zooming views

in Excel, 453
in OneNote, 510
from the ribbon, 53
in Word, 196–197

Z-order of stacked objects, 156–157
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